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Welcome to Bizagi Modeler

Please refer to the topics on the left or search, to find what you are looking for.

Overview

About Bizagi Modeler
Bizagi Modeler  is  a  business  process  modeling and documentation tool.  The Modeler  enables  you to

visually  diagram,  model  and  document  business  processes  in  industry-standard  BPMN  (Business

Process Model Notation). BPMN is a worldwide accepted format for process modeling.

You are able to publish high quality documentation in Word, PDF, SharePoint or  Wiki.  Processes  can be

easily imported from and exported to Visio or  XML, and other  tools.  The Modeler’s  IntelliSense (smart

code  completion)  coupled  with  its  unique  look  and  feel  allows  you  to  quickly  and  easily  map  and

document, without the delay of validation routines.

Each file is referred to as a model and may contain one or more diagrams.

A model  can  refer  to  a  whole  organization,  a  department  or  a  specific  process  depending  on  your

needs. Multiple diagrams are positioned as individual sheets  (tabs) within your  model.  You are able to

navigate between diagrams in your model by selecting the associated sheet tab located at the bottom

of the model.

You can choose between storing your models On-premise or in the Cloud.

Models  stored On-premise are saved in your  own desktop  or  a  file  server  in  your  Company,  as  a

.bpm file extension. 

 

Models stored in the Cloud are hosted by Bizagi,  giving the freedom to collaboratively design your

processes online and manage them at your convenience.
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About Process Modeling
Process  modeling is  a  method to analyze, design and diagram a business  process  flow.   Modeling  a

process  in  an  iterative,  clear,  transparent  and  straightforward  way  will  enable  you  to  understand,

analyze and make a positive change to the business process.  

Standards support

Support for BPMN 2.0
Business  Process  Model and Notation, or  BPMN, is  a  graphical notation  created  to  provide  a  unified

language  of  worldwide  acceptance.  It  is  used  to  specify  business  processes,  defined  by  the  Object

Management Group (OMG). 

Since joining the group in 2007, Bizagi continues to be an active member of the group within the OMG 

that is in charge of defining the BPMN standard.

Bizagi Modeler supports the current version, BPMN 2.0. 

For more information, see http://www.omg.org/spec/BPMN/2.0 

Support for XPDL 2.2
The XML Process  Definition Language, or  XPDL, is  a  standard format to interchange business  process

definitions between different workflow products. 

XPDL  provides  a  file  format  that  supports  every  aspect  of  the  BPMN  process  definition  notation,

including graphical descriptions of the diagram, as well as executable properties  used at run time. This

format is standardized by the Workflow Management Coalition (WfMC).

Bizagi Modeler supports the current version, XPDL 2.2. 

http://www.omg.org/spec/BPMN/2.0
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For more information, see www.wfmc.org/standards/xpdl 

Multilanguage support

Overview
Bizagi Modeler is multilingual, and the user interface supports the following languages:

English

Spanish

German

French

Portuguese

Russian

Chinese (simplified)

Dutch

Italian

Japanese

Install Bizagi Modeler in your preferred language
At  the  start  of  the  Bizagi  Modeler  installation,  you  will  be  prompted  to  select  the  language  of  your

preference.  Once selected, all text will be displayed in the chosen language throughout installation and

use of the product. 

You can change the language at any time
Once Bizagi Modeler  is  installed you are able to change the displayed language at any time.  Select  a

language from the Language drop-down list,  located inside the gear  in the upper  right  corner  of  the

Modeler.  For the change to take effect, please restart Bizagi Modeler.

http://www.wfmc.org/standards/xpdl
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Training and support
Bizagi Modeler offers several types of support to help you with process  modeling and documentation.

These are located on the Help tab.

Video Tutorials  
Learn  how to  use   Bizagi  Modeler  through  short  and  explanatory  videos

and discover new features.

Please refer to our Video Tutorials site

Online training and support
Discover how to capture and transform a process  to benefit your  business.

 We offer self-paced training courses online free of charge.

Please refer to our e-learning web site

http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://www.bizagi.com/container/video_tutorial_modeler_en.html
http://elearning.bizagi.com/
http://elearning.bizagi.com/
http://elearning.bizagi.com/
http://elearning.bizagi.com/
http://elearning.bizagi.com/
http://elearning.bizagi.com/
http://elearning.bizagi.com/
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Support Forums  
We offer free support forms where your  questions  are answered promptly.

 

Also, opinions and ideas can be shared with our  community that is  growing

by the day.

To access our support forums you will need to register.

Please refer to our Forums site

Free Process Xchange 
Access, download and use our  collection of  templates  containing  the  best

practices of many common processes used within organizations. 

Bizagi process  templates  are  ready  to  use  and  executable  processes  that

you can use to boost 

performance  in  your  organization.  Feel  free  to  customize  them  to  your

particular needs.

Again, we welcome your opinion and suggestions, which can be made, once

registered. 

Please refer to our Process Xchange

Help
Online  help  contains  the  knowledge  you  will  need  to  diagram,  document

and  produce  your  processes.  Feel  free  to  browse  through  all  the

documentation.  We  welcome  any  of  your  comments  via  the  Feedback

option.

The user  guide  can  also  be  downloaded,  for  offline  use,  by  selecting  the

Download Help option which saves the file as a PDF document.

Related Products
Bizagi BPM Suite is composed by three products: Bizagi Modeler, Bizagi Studio and Bizagi Engine

Once you are finished modeling your  processes  with Bizagi Modeler,  Bizagi  Studio  and  Bizagi  Engine

will provide you  the  necessary  to   automate  your  processes  and  transform  them  into  an  executable

system.

Bizagi Studio allows you to enter  all  the  necessary  information  for  process  execution:  standard  time,

costs, user interfaces, business rules, etc. This information is stored as a model in a  database and used

at runtime by Bizagi Engine for process execution through a work portal for end users.

With the Bizagi Modeler,  Bizagi  Studio  and  Bizagi  Engine,  you  have  complementary  products  that

make up the Bizagi BPM Suite Solution:

http://feedback.bizagi.com/en/
http://feedback.bizagi.com/en/
http://feedback.bizagi.com/en/
http://feedback.bizagi.com/en/
http://feedback.bizagi.com/en/
http://feedback.bizagi.com/en/
http://www.bizagi.com/en/community/model-xchange
http://www.bizagi.com/en/community/model-xchange
http://www.bizagi.com/en/community/model-xchange
http://www.bizagi.com/en/community/model-xchange
http://www.bizagi.com/en/community/model-xchange
http://www.bizagi.com/en/community/model-xchange
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Please click for more information about our BPM Suite

http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
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Getting Started

The following chapters will get you started with your Model.

System Requirements
The following are the minimum requirements to install Bizagi Modeler

Operating systems
Windows 10

Windows 8.1 / Windows 8

Windows 7 

Windows Vista

Windows Server 2012

Windows Server 2008 R2 / 2008 

In Modeler versions 2.10 or above, the following Operating systems will not be supported

Windows Server 2003

Windows XP

Software
Microsoft .NET Framework 4.5.2. Download the .NET Framework 

Internet Explorer 9 or higher

In Modeler versions 2.10 or above, the following browsers will not be supported

Internet Explorer 8

 

Hardware
Processor: 1 gigahertz (GHz). 32-bit (x86) or 64-bit (x64) 

Memory: 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit) 

Hard drive: 50 MB available hard disk space

Display: 800 x 600 or higher resolution

To view documentation and work in the Cloud
Internet Explorer (9, 10, 11), Chrome or Mozilla Firefox.

Microsoft Word 2013, 2010, 2007

Microsoft Visio 2010, 2007, 2003

Microsoft Office SharePoint Server 2010/2007 and SharePoint Services 3.0

MediaWiki 1.14 to 1.22 Please see further Wiki requirements

https://www.microsoft.com/en-us/download/details.aspx?id=42642
https://www.microsoft.com/en-us/download/details.aspx?id=42642
https://www.microsoft.com/en-us/download/details.aspx?id=42642
https://www.microsoft.com/en-us/download/details.aspx?id=42642
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In Modeler versions 2.10 or above, the following browsers will not be supported

Internet Explorer 8

Install Bizagi Modeler

Overview
Bizagi  Modeler  is  a  freeware  application  that  you  can  download  from  the  internet  and  use  in  a

desktop or portable computer. 

To install Bizagi Modeler run the installer, located on our  web portal in Downloads  under  the Products

menu.  

Once loaded, select the language for installation from the drop-down list.

Click the Next button to allow the installation wizard to guide you through the process.
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To continue, you will need to read the terms of the license agreement.

If you accept the terms, select the I accept the term of the license agreement option and click the Next

button to continue the installation.

Otherwise, select the I do not accept the terms of the agreement option and click the Next button, and

the tool will not install.
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Select the folder where Bizagi Modeler will be installed.

The default folder shown can be changed by clicking the Browse icon, selecting a new folder,  and then

clicking the Next button.
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Click the Install button to start the installation process.
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When the installation process is finished, click the Finish button.

A shortcut will be created on your desktop to allow easy access to the application.
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Silent installation

Overview
Bizagi  Modeler  is  a  freeware  application  that  you  can  download  from  the  internet  and  use  in  a

desktop or portable computer. 

When  deploying  Bizagi  Modeler  to  several  terminals  or  workstations  (i.e,  an  unattended/silent

installation done by a system administrator),  you may follow either  of  the  2  alternatives  presented  in

this section.

The  first  alternative  considers  creating  an  .msi  file,  compliant  to  be  run  with  msiexec  or  system

management software such as Microsoft's SCCM.

The  second  alternative  considers  recording  an  installation  to  create  an  .iss  file,  so  that  a  massive

deployment considers such pre-configuration.

Before you start
Note that Bizagi Modeler is available as a .exe installer, presented as BizagiModelerSetup_x64.exe, or

BizagiModelerSetup_x86.exe for either a 64-bit or 32-bit architecture respectively.

Before  running  a  silent  installation  over  a  network,  ensure  that  you  have  considered  the  adequate

architecture of the workstations involved.

Alternative #1
In most modern Windows operating  systems,  you  may  also  rely  on  Windows  Installer  command  line

tools such as msiexec or use system management software such as SCCM to deploy the installation.
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Bizagi Modeler installer relies on InstallShield, and so through its  options, you would create an .msi file

which  is  compatible  with  msiexec  as  described  in  its  official  documentation  at  https://

technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx.

For this alternative, you would use an administrative Installation and carry out the following:

1. Use a command prompt to create Bizagi Modeler.msi
Use the following options to create the msi file:

[Bizagi_Installer] /v"/a 

Consider:

[Bizagi_Installer]: Should be replaced by the location of Bizagi Modeler's  .exe installer,  including the

full path to this file.

The name of the installer should be BizagiModelerSetup_x64.exe or  BizagiModelerSetup_x86.exe according

to your scenario.

For further information on these options, refer to http://helpnet.flexerasoftware.com/

installshield22helplib/installshield22helplib.htm.

This command starts an assisted procedure to unpacks  the installer's  content into an .msi,  and so you

should specify a network location while carrying out the assisted steps:

https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx
https://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx
http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
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When done, you will be able to locate Bizagi Modeler.msi at the  network  path  as  specified  during  the

assisted steps:

2. Deploy the installation by relying on the MSI file
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Use msiexec and its switches to run Bizagi Modeler.msi from the network path, while using

ISSETUPDRIVEN=1 in order to avoid popups, as follows:

MsiExec.exe /i "[Network_location]\Bizagi Process Modeler.msi" ISSETUPDRIVEN=1 /qb

Consider:

[Network_location]:  Should be replaced by the network path  as  specified  during  the  assisted  steps

(where Bizagi Modeler.msi is at).

For further information on these options, refer to http://helpnet.flexerasoftware.com/

installshield22helplib/installshield22helplib.htm.

After a successful installation, Bizagi Modeler will be presented as  an installed program and display its

shortcut:

In addition to the above, you may verify a  successful procedure by locating the appropriate logs  at

the event viewer, or rely on the verbose log to troubleshoot.

http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
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Similarly and for uninstall options as provided by msiexec switches, you may use -x instead of -i.

Note  that  you  do  not  need  to  uninstall  Bizagi  Modeler  when  upgrading  to  a  newer  release.  By

running  the  installer  of  the  newer  version  (with  appropriate  configuration),  Bizagi  Modeler  will

uninstall existing versions.

Alternative #2
Bizagi Modeler installer relies on InstallShield and so, through command line options you may create an

.iss file to make use of a pre-configured installation.

To do so, carry out the following:

1. Use a command prompt to record the installation (creates an ISS file)
Use InstallShield's switches such as /r, /f1 and optionally /verbose (most useful to troubleshoot), to record

the configuration for a Bizagi Modeler installation as follows:

[Bizagi_Installer] /r /f1"[Output_ISS]" /verbose"[Output_Log]"
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Consider:

[Bizagi_Installer]: Should be replaced by the location of Bizagi Modeler's  .exe installer,  including the

full path to this file (ideally a shared drive).

The name of the installer should be BizagiModelerSetup_x64.exe or  BizagiModelerSetup_x86.exe according

to your scenario.

[Output_ISS]: Should be replaced by the location where you want to create the ISS configuration file,

including how you want to name this file. 

Usually when this option is left unspecified, the ISS file will be created as C:\Windows\setup.iss.

[Output_Log]:  Should be replaced by the location where you want to store a verbose log,  including

how you want to name this file. 

Consider:

A full path for all options above is recommended (not using relative paths).

You may also use quotes for such paths, in order to avoid issues when these have blank spaces.

No blank spaces should be left between the option and its path value.

For further information on these options, refer to http://helpnet.flexerasoftware.com/

installshield22helplib/installshield22helplib.htm.

Once  the  command  is  entered,  follow regular  steps  of  an  assisted  installation  as  presented  by  the

wizard and instructed at Install Bizagi Modeler:

http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
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When finished,  you  may  leave  the  Launch  Bizagi  Process  Modeler  checkbox  unmarked  so  that  Bizagi

Modeler is not started right away:

After a successful procedure, Bizagi Modeler will be presented as  an installed program and display its

shortcut:
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In addition to the above, you may verify a  successful procedure by locating the appropriate logs  at

the event viewer, or rely on the verbose log to troubleshoot.

2. Deploy the installation by relying on the ISS file
Use InstallShield's switches such as /s, /f1 and optionally /verbose, to run a silent installation of Bizagi

Modeler as follows:
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[Bizagi_Installer] /s /f1"[ISS_file]" /verbose"[Output_Log]"

Consider:

[Bizagi_Installer]: Should be replaced by the location of Bizagi Modeler's  .exe installer,  including the

full path to this file (ideally a shared drive).

The name of the installer should be BizagiModelerSetup_x64.exe or  BizagiModelerSetup_x86.exe according

to your scenario.

[ISS_file]:  Should  be  replaced  by  the  location  where  you  created  the  ISS  configuration  file  as  in  a

previous step.

[Output_Log]:  Should be replaced by the location where you want to store a verbose log,  including

how you want to name this file. 

Consider:

A full path for all options above is recommended (not using relative paths).

You may also use quotes for such paths, in order to avoid issues when these have blank spaces.

No blank spaces should be left between the option and its path value.

For further information on these options, refer to http://helpnet.flexerasoftware.com/

installshield22helplib/installshield22helplib.htm.

Note that this silent installation will create a setup.log file at the local path. 

After a successful silent installation, the process exits with a 0 (zero) error status code. Alternatively,  you

may rely on the verbose log to troubleshoot:

http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
http://helpnet.flexerasoftware.com/installshield22helplib/installshield22helplib.htm#CSHID=helplibrary%2FIHelpSetup_EXECmdLine.htm|StartTopic=helplibrary%2FIHelpSetup_EXECmdLine.htm
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You may also verify a successful installation by locating the appropriate logs at the event viewer:
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Similarly and for uninstall options as provided by InstallShield switches, you may use the following.

To record the uninstall:

[Bizagi_Installer] /uninst /r /f1"[Output_ISS]" /verbose"[Output_Log]"

To run it in an unattended manner:

[Bizagi_Installer] /uninst /s /f1"[ISS_file]" /verbose"[Output_Log]"

Note  that  you  do  not  need  to  uninstall  Bizagi  Modeler  when  upgrading  to  a  newer  release.  By

running  the  installer  of  the  newer  version  (with  appropriate  configuration),  Bizagi  Modeler  will

uninstall existing versions.

Register to join the community

Overview
Bizagi Modeler will prompt you a window to allow you to join our  community and be able to access  all

our free online resources and help you in your BPM journey.

Although optional, we highly recommend you register in order to obtain the following benefits:

Free Online support

Expert advice

Free documentation

Video tutorials

New members
If you are not a member, click the Join today button. 



33Copyright © 2002-2016 Bizagi. All rights reserved.

The registration form will display in a new browser. There, you can enter some basic information.



34Copyright © 2002-2016 Bizagi. All rights reserved.

Enter your email address.  Once you have entered it,  you will receive a verification code in order  to let

you complete the Personal and additional information.

Once you have complete the information, click on I AGREE, REGISTER in order to create your  account; By

registering, you agree to Bizagi's Terms of Use.

Already a member
If you are already a member, enter your email and password to log in. 

Once your  credentials  are  verified,  the  window will  no  longer  be  displayed,  and  you  will  be  able  to

enjoy all our resources.

We respect your privacy. Please review our Privacy policy.

http://www.bizagi.com/index.php?option=com_content&view=article&id=18&Itemid=118
http://www.bizagi.com/index.php?option=com_content&view=article&id=18&Itemid=118
http://www.bizagi.com/index.php?option=com_content&view=article&id=18&Itemid=118
http://www.bizagi.com/index.php?option=com_content&view=article&id=18&Itemid=118
http://www.bizagi.com/index.php?option=com_content&view=article&id=18&Itemid=118
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Saving Models

Overview
Models  created  in  Bizagi  Modeler  can  be  saved  locally  or  in  our  Cloud  service  (paid  for).  Bizagi

Modeler  in the  Cloud  is  a  subscription-based  cloud  service  that  offers  visibility  and  management  of

business  processes. Storing your  models  in the Cloud give you Global access:  Your  models  –  and  all

associated documentation – is  stored in a  secure cloud based central repository, enabling access  and

editing rights using Bizagi Modeler with all its power. For more information refer to Bizagi Cloud.

Local Models
Bizagi Modeler has two main file types, differentiated by the file extension:

.bpm, the file format used to save a Bizagi Modeler file On-premise or in the Cloud.

.bpmc,  the  file  format  used  to  save  diagrams  for  Team  Collaboration  Mode,  when  working  On-

Premise.

Team  Collaboration  allows  collaborative  process  improvement  and  execution.  Teams  can  participate

simultaneously in the definition of a process, thereby enhancing business performance.

Click On-premise Team Collaboration for further information. 

To save a model click Save  or  Save As on the File  tab in the upper  left corner  or  click the disk image

on the Toolbar.
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User Interface explained
Bizagi Modeler has a very simple, easy and intuitive interface. 

It has five main elements; namely, Toolbar, Ribbon, Palette, Element Properties and View.
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Toolbar

Overview
The Toolbar contains quick access commands to a subset of any menu within Bizagi Modeler. 

The default commands can be customized at anytime.

To  adjust  the  Toolbar  click  on  the  drop-down list  on  the  right  and  select  Customize  Quick  Access

Toolbar which will allow you to add or remove any item.

Select a menu option from the drop-down menu and click the Add  or  Remove  buttons  to alter  to your

preference.
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Ribbon

Overview
The  Ribbon  contains  the  main  controls  to  manage  each  Process  Model.  These  are  organized  into

different tabs, and are described below.

Home tab
The following is the Home tab displayed when a user  first opens  Modeler,  and when working on local-

stored models.

MENU

OPTION
SUB OPTION DESCRIPTION

  Clipboard

Paste
Insert  the  current  contents  of  the  clipboard  into  the

diagram.

Cut
Remove the selection from the diagram and put it on the

clipboard.

Copy Copy  the  selection  from  the  diagram  and  put  it  on  the
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MENU

OPTION
SUB OPTION DESCRIPTION

clipboard.

  Model

Diagrams Open the diagram browser.

Run Workflow
Turn  your  Process  into  a  running  applications.  Visit

www.bizagi.com  

Simulation View

Bizagi  Modeler  allows  simulation  your  business

processes under the BPSim (Business  Process  Simulation)

to  support  decision  making  and  boost  theit  continuous

improvement.

Resources
Add,  edit  or  remove  resources.  These  are  the  roles,

systems or people that execute activities.

Validate Check for modeling errors on the active diagram.

Info Show the diagram information.

  Bizagi Cloud

Save as
Allows to save the Model in Cloud or locally.

Learn more about storing in Bizagi Cloud.

Share

Allows  to  share  your  model  using  the  Bizagi  Cloud

services.  When  the  user  is  NOT  logged  in  to  Cloud  or

working on a  model  not  owned  by  him/her,  this  option

will display a pop-up windows allowing the user  to Start

a  free  trial  or  learn  more  about  Cloud  Collaboration

Services.

  Formatting

  

Font Change the font face.

Font Size Change the font size.

Grow Font Increase the font size.

Shrink Font Decrease the font size.

Bold Make the selected text bold.

Italic Italicize the selected text.

Underline Underline the selected text.

Strikethrough Draw a line through the middle of the selected text.

Font Color Change the color of the text.

Shading Color the background behind the selected text.

Text alignment Change the color of the text.

Clear Formatting Remove custom formatting, leaving only the plain text.

Editing Find Find text in the model.

http://www.bizagi.com
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MENU

OPTION
SUB OPTION DESCRIPTION

Select Select elements in the diagram. 

Clear
Clear  formatting  from  selected  elements  or  delete

selected elements

Review Spelling
Open the spell-check feature to proof text entered in the

process and documentation.

View more information about the Spelling review option.

  Discover
Bizagi Suite Learn more about Bizagi’s BPM Suite

Online Courses Provide access to E-Learning sites.

Home tab changes slightly when a user works on Model stored in Bizagi Cloud. 

A new menu and a new set of options under Bizagi Cloud menu are displayed. Options  will be enabled

or disabled depending on whether the user is the owner of the model or not.

MENU

OPTION
SUB OPTION DESCRIPTION

  Bizagi Cloud

Share
Allows  to  share  your  model  using  the  Bizagi  Cloud

services.  This  option  is  available  when  the  user  is  the

owner of the current model.

Properties Opens the Cloud model properties

Work Offline
Opens a window to chose diagrams of the current model

to be available to work offline.

Work Online
Enables  an offline model  to  be  back  online,  after  being

offline, to synchronize all changes.

bizagi.com
Opens a new browser  taking the user  to Bizagi.com and

display all models stored in Bizagi Cloud.

Diagram

Check Out
Locks  the  diagram  in  other  to  avoid  other  Editors  to

perform  changes.  This  option  is  available  when  the

diagram is Read Only.

Check In
Releases  the  diagram  in  other  to  let  other  Editors  to

perform  changes.  This  option  is  available  when  the

http://www.bizagi.com/
http://www.bizagi.com/
http://www.bizagi.com/
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MENU

OPTION
SUB OPTION DESCRIPTION

diagram is being editing by you.

Comments

Opens the Comments  panel in order  to  let  the  users  to

make  comments,  This  option  is  not  available  when  the

user  is  the  owner  of  the  current  model  and  has  a

Personal Plan.

Format tab

MENU

OPTION

SUB OPTION SUB OPTION

Layout

Align
Align  selected  elements.  It  is  possible  to  align  them  to

the top, bottom, left and right of the diagram.

Align Horizontal Align the selected items horizontally. 

Align Vertical Align the selected items vertically.

Distribute horizontally
Distributes selected elements with even horizontal spaces

between them.

Distribute vertically
Distributes  selected  elements  with  even  vertical  spaces

between them.

 Formatting

Font Change the font face.

Font Size Change the font size.

Grow Font Increase the font size.

Shrink Font Decrease the font size.

Bold Make the selected text bold.

Italic Italicize the selected text.

Underline Underline the selected text.
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Strikethrough Draw a line through the middle of the selected text.

Font Color Change the color of the text.

Shading Color the background behind the selected text.

Text alignment Align text: center, left and right. 

Clear Formatting Remove custom formatting, leaving only the plain text.

View Tab

MENU OPTION SUB OPTION DESCRIPTION

View Lock Locks/ unlocks the diagram for editing (read-only). 

Zoom

Zoom In Enlarge the view of the model.

Zoom Out Reduce the view of the model.

Scale
Apply  a  preset  zoom  level  for  quick  enlargement  or

reduction of the diagram (100% default).

100% Apply a 100% zoom to the normal diagram size.

Fit to Diagram
Scale the page so that the entire diagram fills the viewing

area.

Zoom to selection
Scale the page so that only the selected elements of the

diagram fill the viewing area.

Pan
Display a view of the page at a smaller magnification in

order to browse through the diagram.

Show

Grid
Display grid lines for visual reference to aid alignment of

a diagram's elements.

Black and white
Change  the  color  mode  of  the  diagram  to  black  and

white. 
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Presentation actions
Highlight  the  diagram  elements  that  contain  actions  in

presentation mode.

Gradient fill

Fill elements with a background color that gradually

changes from one color to another across the surface of

the element.

Shadows
Attach  a  drop  shadow  to  the  element.  Shadows  are

attached to the bottom-right corner of the element.  

Spelling mistakes Highlight the spelling mistakes found in text.

Alignment

Align to grid
Automatically  aligns  an  element  to  the  nearest

intersection of lines in the grid.

Smart align
Automatically  aligns  diagram  elements  to  the  grid  in

relation to one another.

Publish Tab

MENU OPTION SUB OPTION DESCRIPTION

Process

documentation

Word
Generate  a  Word  file  of  the  model  and  all  its

documentation. 

PDF
Generate  a  PDF  file  of  the  model  and  all  its

documentation.

Excel
Generate  an  Excel  file  of  the  model  and  all  its

documentation. 

Web
Generate  a  Web  file  of  the  model  and  all  its

documentation for web browsing.

SharePoint Export and publishes the model to SharePoint.

Wiki Export and publishes the model to Wiki. 

Export / Import Tab
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MENU

OPTION

SUB OPTION DESCRIPTION

Export

Image Export the active diagrams as an image. 

Visio Export the model as a Visio file. 

XPDL Export the model as a XPDL file.

Attributes Save the extended attributes as a XML file. 

BPMN Export the model as a BPMN file. 

Import

Visio Create a new diagram based on a Visio file.

XPDL Create a new diagram based on a XPDL file.

Attributes Import extended attributes from a XML file.

BPMN Create a new diagram based on a BPMN file. 

Tools tab

MENU OPTION SUB OPTION DESCRIPTION

Tools

Cloud Attachments
Shows a list of all attachments  uploaded  to  the  opened

Cloud model.  This  option is  only available when a Cloud

model is opened.

Attachments
Shows all the  attachments  in  the  model:  the  element  to

which the attachment relates  and  the  corresponding  file
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name.

Element Count
Shows the count of diagram elements  by type. The table

displays a list of Processes  by name, and the number  of

Events, Gateways, Sub-processes and Tasks.

Custom artifacts
Shows  the  Custom  Artifacts  Types  Manager  to  create,

edit, delete, export and import custom artifacts.

Team

collaboration

Categories
Lists  all  the  categories  available  in  the  local  Team

collaboration to be managed. 

Delete comments
Enables the possibility to delete all comments in the local

Team collaboration.

Help tab

MENU

OPTION

SUB OPTION DESCRIPTION

Help

Help Displays this User Guide. 

Video tutorials Guides you to Bizagi's video tutorials.

Support forums Access to the online support forums.

Process XChange
Access  to  the  Bizagi’s  Process  XChange  process

templates and discussion forums. 

Community

Register Bizagi Modeler community registration.

Tell a Friend
A  link  that  enables  you  to  share  Bizagi  Modeler  with

clients, colleagues and friends.

About

Take a tour
Takes  you to a short  tour  through  the  main  features  of

Bizagi.

Release notes Information on the current release.

About Information about Bizagi Modeler. 
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File - New

MENU

OPTION

SUB OPTION DESCRIPTION

New Blank Model Creates a new blank model.

File - Open

MENU

OPTION

SUB OPTION DESCRIPTION

Open

Recent Models
Lists  all Models,  stored locally or  in  Bizagi  Cloud,  to  be

opened.

Bizagi Cloud Enables  the  option  to  open  an  existing  Bizagi  Cloud
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Model.

Local Models Enables the option to open an existing Local Model.

File - Print

MENU OPTION SUB OPTION DESCRIPTION

Print

Print
Selects  a  printer,  number  of  copies  and  other  printing

options in order to print your diagram.

Quick Print
Immediately  prints  the  active  diagram  to  the  default

printer.

Print Preview
Onscreen preview of  the  diagram  in  print  layout  mode,

allowing layout modifications prior to printing.

File - Save & Publish
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MENU OPTION SUB OPTION DESCRIPTION

Send Using E-

Mail

Send as

Attachment

Send a  copy  of  the  model  as  an  attachment  in  an  e-mail

message

Send as Image Send the model as images in an e-mail message. 

Send as XPDL Send the model as an XPDL file in an e-mail message.  

Publish

Documentation

Word
Generate  a  Word  file  of  the  model  and  all  its

documentation. 

PDF
Generate  a  PDF  file  of  the  model  and  all  its

documentation. 

Web
Generate a Web file of the model and all its  documentation

for web browsing. 

SharePoint Export and publish the model to SharePoint.

Wiki Export and publish the model to Wiki. 

Export to Others

Formats

Image Export the active diagrams as an image. 

Visio Export the model as a Visio file. 

XPDL Export the model as an XPDL file.

Attributes Save the extended attributes as an XML file. 

Other

Versions (Model v

1.6)

Export  the  model  to  the  1.6  version  of  Bizagi  Modeler

(.bpm).

File - Options
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MENU OPTION SUB OPTION DESCRIPTION

User Interface

Options

Style
Customizes  the  background  color  of  Bizagi

Modeler. 

Mode
Hide  or  show  elements  on  the  drawing  palette.

Core  will  enable  only  the  most  common  BPMN

elements. Extended will enable all BPMN elements.

Language Change the Bizagi Modeler language.

BPMN element

options

Font Define the default font for all diagram elements.

Configure default sizes
Launch  the  wizard  that  sets  the  element's  default

sizes

Custom Artifacts Custom Artifacts Opens the Custom artifacts management window

Alerts
Warn element type

changes

Displays  a  warning  message  when  an  element

changes  type.  Unintentional  change  of  type  may

result in data loss.
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Warn when too many

tabs are opened

Displays  a  warning  message  when  the  model  (the

.bpm  file)  has  more  than  10  diagrams  (tabs)

opened.  When  there  are  more  than  10  diagrams

opened the performance of the Modeler  might get

affected.

MENU

OPTION

SUB OPTION DESCRIPTION

General

Settings
Logo

Allow  customization  of  a  user-defined  logo,  once  the

model's documentation is ready for generation.

Extended

attributes

Import Import the extended attributes from XML file.

Export Export the extended attributes from XML file.

Word

Templates
Word Templates

Select  a  Word  template  (.dot  file)  to  generate  Word

documentation. 
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Maximizing the workspace

Overview
Bizagi allows the Ribbon to be shown or hidden from view.

If  you  need  more  room  to  work,  collapse  the  Ribbon  to  maximize  your  workspace  and  allow  the

diagram to fill a larger area of canvas.

For diagrams having a large vertical size (i.e., diagrams containing more than one Pool or  many Lanes),

you may choose to rather  dock the properties  window to the right of the  screen  (as  opposed  to  the

default location at the bottom of the screen).

To relocate and dock the Element properties  window, drag and drop it to  the  desired  position.   The

location icon highlights to indicate that the window may be dropped in the target position:
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To improve the performance of the Modeler keep less than 10 diagrams (tabs) opened in a Model. The

diagrams opened are displayed on the bottom, and can be accessed through the small arrows on the

right.

To close opened diagrams, right-click on any of them and select Close, or  Close All.  This  will not erase

them from the file, this will close them.

You can delete a diagram by selecting Remove.
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Palette
The Palette contains the BPMN graphical elements used to define a process model. 

These BPMN graphical elements are described in the following sections:

Activities

Events

Gateways

Data

Artifacts

Swimlanes

Connectors

Activities

Overview
Activities represent work or tasks  carried out by members  of the organization.  They stand for  manual

or  automatic tasks  performed by an external system or  user.   Activities  can  be  atomic  or  non-atomic

(compound) and they are classified into tasks and sub-processes.

Tasks

ELEMENT DESCRIPTION NOTATION

  Task

Is an atomic Activity within a Process  flow. It is  used when

the work in the Process cannot be broken down to a finer

level of detail.

  User Task
Is  a  typical  workflow Task  where  a  person  performs  the

Task with the assistance of a software application. 

  Service Task
Is  a  Task that uses  some sort of  service  that  could  be  a

Web service or an automated application.

  Receive Task
Is  a  Task designed to wait for  a  message  to  arrive  from

an external participant (relative to the Process).

  Send Task
Is  a  Task  designed  to  send  a  message  to  an  external

participant (relative to the Process).
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  Script Task

Is  a  Task that is  executed  by  a  Business  Process  Engine.

The  Modeler  defines  a  script  in  a  language  that  the

engine can interpret. 

  Manual Task
Is a Task that is expected to be performed without the aid

of any business process execution or any application.

  Business Rule

Task

Offers a mechanism for the Process  to provide input to a

Business  Rule  Engine  and  get  the  output  of  calculations

that the engine might provide. 

 Multi-Instance

Loop

Tasks  may  be  repeated  sequentially,   behaving  like  a

loop.  The  Multi-instance  Loop  iterates  a  predetermined

number  of times.  The iterations  occur  sequentially  or  in

parallel (simultaneously).

 Standard Loop

Tasks may be repeated sequentially, behaving like a loop.

This  feature   defines  a  looping  behavior  based  on  a

boolean  condition.  The  Activity  will  loop  as  long  as  the

boolean condition is true.

Sub-process
A sub-process is a compound Activity that is included within a Process. Compound means that it can be

broken down into lower levels, that is, it includes shapes and elements within it.

ELEMENT DESCRIPTION NOTATION

  Sub-process

Is  an  Activity  which  internal  details  have  been

modeled  using  activities,  gateways,  Events,  and

sequence flows. The elements has a thin border.

  Reusable Sub-

process

Identifies  a  point  in  the  Process  where  a  predefined

Process  is  used.  A  reusable  Sub-process  is  called  a

Call Activity in BPMN.  The element has a thick border.

  Event Sub-process

A  Sub-process  is  defined  as  an  Event  Sub-process

when  it  is  triggered  by  an  Event.  An  Event  Sub-

Process  is  not  part  of  the  normal  flow of  its  parent

Process  -  there  are  no  incoming  or  outgoing

Sequence Flows.
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  Transaction

Is  a  Sub-process  whose  behavior  is  controlled

through  a  transaction  protocol.  It  includes  the  three

basic  outcomes  of  a  transaction:  Successful

Completion,  Failed  Completion  and  Cancel

Intermediate Event.

  Ad-Hoc Sub-

process

Is   a  group  of  activities  that  has  no  REQUIRED

sequence  relationships.  A  set  of  activities  can  be

defined,  but  the  sequence  and  number  of

performances  for  the  activities  is  determined  by  the

resources of the activities.

  Standard loop

Sub-processes  may  be  repeated  sequentially,

behaving like a loop. 

This  feature  defines  a  looping  behavior  based  on  a

boolean  condition.  The  activity  will  loop  as  long  as

the boolean condition is true.

  Multi-Instance

loop

Sub-processes  may  be  repeated  sequentially,

behaving like a loop. 

The  Multi-instance  Loop  iterates  a  predetermined

number of times.  The iterations  occur  sequentially or

in parallel (simultaneously).

Events

Overview
An Event is  something that happens  during the course of the Process,  affecting  the  Process  flow and

normally has a trigger or result. 

To make an event a throw or a  catch event,  right click on it and select Is Throw.  This  option will enable

or disable its behavior (applies for certain events described below) .

Start Events

ELEMENT DESCRIPTION NOTATION

Start Event
Indicates  where  a  particular  Process  starts.  It  does

not have any particular behavior. 

Message Start Event

Is  used  when  a  message  arrives  from  a  participant

and triggers the start of the Process.
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Timer Start Event 
Is  used  when  the  start  of  a  Process  occurs  on  a

specific date or cycle time (e.g., every Friday)

Conditional Start

Event 

This  type  of  Event  triggers  the  start  of  a  Process

when a condition becomes true.

Signal Start Event 

The start of the Process  is  triggered by the arrival of

a  signal  that  has  been  broadcast  from  another

Process. 

Note that the signal is not a message; messages have

specific targets, signals do not.

Parallel Multiple

Start Event 

Indicates  that there are multiple  triggers  required  to

start  the  Process.  ALL  triggers  must  be  triggered

before the Process is instantiated.

Multiple Start Event
This means that there are multiple ways  of triggering

the Process. Only one of them is required.

Intermediate events

ELEMENT DESCRIPTION NOTATION

Intermediate Event

Indicates  where  something  happens  somewhere

between the start and end of a  Process.  It will affect

the flow of the Process, but will not start or  (directly)

terminate the Process.

Message Event

Indicates that a message can be sent or received. 

If a Process is waiting for a message and it is  caught

the Process will continue its flow. 

A catch Message Event waits for a message to arrive

and  once  the  message  has  been  received,  the

Process  will  continue.  The  Event  marker  in  this

instance will be filled.

A  throw  Message  Event  sends  a  message  to  an

external  participant.  The  unfilled  Event  marker  is

allocated to the throw message.
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Timer Event

Indicates  a  delay  within  the  Process.  This  type  of

Event  can  be  used  within  the  sequential  flow

indicating a waiting time between activities.

Escalation Event
The  Event  indicates  an  escalation  through  the

Process.

Compensation Event

Enables  the handling of  compensations.  When  used

within the sequential flow of a  Process  they  indicate

that compensation is necessary. 

Conditional Event
This  Event  is  triggered  when  a  condition  becomes

true. 

Link Event

This  Event  is  used  to  connect  two  sections  of  the

Process. 

Link Events  can be used to create looping situations

or to avoid long Sequence Flow lines.

If there are two link events  on a  process  (one  catch

and one throw) the Modeler will understand they are

linked together.  If there is  one catch and two  throw,

the  Modeler  will  understand  both  throws  are

received by the catch. If there are several  catch  and

throw events the name of the 'pairs' must match for

the Modeler  to  understand  which  throw belongs  to

which catch.

Signal Event

These  Events  are  used  to  send  or  receive  signals

within or  across  the Process.  A signal is  similar  to  a

signal flare that is  shot into the sky  for  anyone  who

might be interested to notice and then react. 

If  the  Event  is  used  to  catch  the  signal,  the  signal

Event marker  will be filled.  Alternatively,  the  unfilled

Event marker is allocated to the throw message.

Multiple Event

This means  that there are multiple triggers  assigned

to the Event. 

When  used  to  catch  the  trigger,  only  one  of  the

assigned triggers  is  required  and  the  Event  marker

will be unfilled.
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Parallel multiple

Event

This means  that there are multiple triggers  assigned

to the Event. Unlike the normal Multiple Intermediate

Event,  ALL of the assigned triggers  are  required  for

the Event to be triggered.

Intermediate Events Attached to an Activity Boundary 

ELEMENT DESCRIPTION NOTATION

Message Event

If a message Event is attached to the boundary of an

activity,  it  will  change  the  normal  flow  into  an

exception flow when a message is received.

If  the  Event  interrupts  the  activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.
 

Timer Event

If  a  Timer  Event  is  attached  to  the  boundary  of  an

activity,  it  will  change  the  normal  flow  into  an

exception flow when a cycle  time  is  completed  or  a

specific time-date is reached.

 

If  the  Event  interrupts  the  Activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.

Escalation Event

If  attached  to  the  boundary  of  an  Activity,  the

Intermediate Event catches an Escalation. 

If  the  Event  interrupts  the  Activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.

Error Event

A  catch  Intermediate  Error  Event  can  only  be

attached to the boundary of an Activity. 

It reacts to (catches) a named Error, or to any Error if

a name is not specified. 

An Error  Event always  interrupts  the Activity to which

it  is  attached,  i.e.,  there  is  not  a  non-interrupting

version of this Event. Thus  the boundary of the Event

is always solid.
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Cancel Event

This  Event  is  used  within  a  Transaction  Sub-Process

and must be attached to the boundary of one.

It shall be triggered if a  Cancel End Event is  reached

within  the  Transaction  Sub-Process.  It  also  shall  be

triggered if  a  Transaction  Protocol  Cancel  Message

has  been  received  while  the  transaction  is  being

performed.

A Cancel Event always  interrupts  the Activity to which

it  is  attached,  i.e.,  there  is  not  a  non-interrupting

version of this Event. Thus  the boundary of the Event

is always solid.

Compensation Event

When attached  to  the  boundary  of  an  Activity,  this

Event is used to catch the Compensation Event. When

it  occurs,  the  compensation  activity  will  be

performed. 

Interrupting  a  non-interrupting  aspect  of  other

Events does not apply in the case of a  Compensation

Event, thus the boundary of the Event is always solid.

Conditional Event

If a Conditional Event is  attached to the boundary of

an  Activity,  it  will  change  the  normal  flow  into  an

exception flow when a business condition is fulfilled. 

If  the  Event  interrupts  the  Activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.

Signal Event

If  a  Signal  Event  is  attached  to  the  boundary  of  an

Activity,  it  will  change  the  normal  flow  into  an

exception flow when a signal is received.

 

If  the  Event  interrupts  the  Activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.

Multiple Event

When attached to the boundary of an  Activity,  it  will

change the normal flow into an exception flow when

one of the assigned triggers is caught. 

If  the  Event  interrupts  the  Activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.
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Parallel multiple

Event

Unlike  the  Multiple  Event,  when  attached  to  the

boundary of an Activity, it will change the normal flow

into  an  exception  flow  when  ALL  of  the  assigned

triggers are caught. 

If  the  Event  interrupts  the  Activity  to  which  it  is

attached, the boundary of the Event is  solid, if not it

is dashed.

End Events

ELEMENT DESCRIPTION NOTATION

End Event Indicates when the Process ends.  

Message End 
Indicates  that  a  message  is  sent  when  the  flow  has

ended. 

Escalation End 
Indicates  that  an  Escalation  is  necessary  when  the

flow ends. 

Error End 

Indicates  that  a  named  Error  should  be  generated.

All  currently  active  threads  of  the  Process  are

terminated. The Error will be caught by a Catch Error

Intermediate Event.

Cancel End
Is  used within a Transaction Sub-Process.  It indicates

that  the  Transaction  should  be  canceled  and  an

alternative flow can be performed. 

Compensation End

Handles  compensations.  If  an  activity  is  identified,

and it was  successfully completed, the activity will be

compensated. 

Signal End
Indicates  that  a  signal  is  sent  when  the  flow  has

ended.

Multiple End
This  means  that  there  are  multiple  consequences  of

ending the flow. All of them will occur.

Terminate End Ends the Process and all its activities immediately.  
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Gateways

Overview
Gateways  are  used  to  control  the  divergence  and  convergence  of  sequence  flows.   They  determine

ramifications, bifurcations, combinations  and merges  in  the  Process.  The  term  “Gateway”  implies  that

there is a gating mechanism that either allows or disallows passage through the Gateway.

ELEMENT DESCRIPTION NOTATION

Exclusive Gateway

As Divergence: It is  used  to  create  alternative  paths

within the Process, but only one is chosen. 

As  Convergence:  It  is  used  to  merge  alternative

paths.

Event Based Gateway

Represents  a  branching  point  in  the  Process  where

the  alternative  paths  that  follow  the  Gateway  are

based on Events that occur. 

When  the  first  Event  is  triggered,  the  path  that

follows  that  Event  will   be  used.  All  the  remaining

paths will no longer be valid. 

Exclusive Event

Based Gateway

Is  a  variation  of  the  Event  based  gateway  and  it  is

only used to instantiate Processes. One of the Events

of  the  Gateway  configuration  must  be  triggered  in

order  to create a Process  instance. It must have  NO

incoming transitions.

Parallel Event Based

Gateway

Unlike the the exclusive Event based Gateway, ALL the

Events  of  the  Gateway  configuration  must  be

triggered  in  order  to  create  a  Process  instance.  It

must have NO incoming transitions.

Parallel Gateway

As  Divergence:  is  used  to  create  alternative  paths

without checking any conditions.

 

As  Convergence: is  used to merge alternative  paths,

the  gateways  waits  for  all  incoming  flows  before  it

continues.

Complex Gateway

As  Divergence:  is  used  to  control  complex  decision

points  in  the  Process.  It  creates  alternative  paths

within the Process using expressions.

As  Convergence:  Allow continuing  to  the  next  point

of  the  Process  when  a  business  condition  becomes

true. 
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Inclusive Gateway

As  Divergence:  represents  a  branching  point  where

alternatives  are  based  on  conditional  expressions.

The  TRUE  evaluation  of  one  condition  does  not

exclude  the  evaluation  of  the  other  conditions.  All

evaluations  of a  TRUE condition will be traversed by

a token.

As  Convergence: is  used to merge a combination of

alternative and parallel paths. 

Data

ELEMENT DESCRIPTION NOTATION

Data Objects
Provides  information  about  how  documents,  data

and other  objects  are used and updated during the

Process. 
 

Data Store
Provides  a  mechanism  for  activities  to  retrieve  or

update stored information that will exist beyond the

scope of the Process. 

Artifacts

Overview
Please click for further information about Artifacts

ELEMENT DESCRIPTION NOTATION

Group
Is  an  Artifact  that  provides  a  visual  mechanism  to

group elements of a diagram informally. 

Annotation
Is a  mechanism for  a  modeler  to provide additional

information for the reader of a BPMN Diagram.

Image
Enables  an  image  stored  on  your  computer  to  be

inserted into the diagram. 

Header

Displays  the  diagram  properties  (author,  version,

description), and it is  updated automatically with the

information contained in those properties. 

To edit its  information, it is  only needed to  edit  the

diagram's properties.

Formatted Text
This Artifact enables  rich text to be inserted into the

diagram to provide additional information.  

Custom Artifacts

Helps to define and use your  own Artifacts.  Artifacts

provide  the  capability  of  showing  additional

information  about  the  Process  that  is  not  directly
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related to the flow. 

Swimlanes

ELEMENT DESCRIPTION NOTATION

Pool

A  Pool  is  a  container  of  a  single  Process  (contains

the sequence flows between activities). 

A Process  is  fully contained within the Pool.  There is

always at least one Pool.

Lane

Is a  sub-partition within the Process.  Lanes  are used

to  differentiate  elements  as  internal  roles,  position,

department, etc. They represent functional areas  that

may be responsible for tasks.

Milestone
Is  a  sub-partition  within  the  Process.  It  can  indicate

different stages during the Process.

Connectors

ELEMENT DESCRIPTION NOTATION

Sequence Flow
A  Sequence  Flow  is  used  to  show  the  order  that

Activities will be performed in the Process. 

Association

Its  used  to  associate  information  and  Artifacts  with

Flow  Objects.  It  also  shows  the  activities  used  to

compensate for an activity.

Message Flow
Is  used to show the flow of messages  between  two

entities that are prepared to send and receive them. 

The  following  is  a  table  that  reflects  all  the  possible  connections  using  Message  flow.  The  arrow

pointing  upwards  shows  what  CAN  be  connected.  Anything  else  outside  the  table  should  not  be

connected using a Message flow.
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Element properties

Overview
Element  Properties  are  used  to  document  the  process.  Each  element  has  its  own  properties  and

depending on the type of element, tabs are displayed with additional information and functionality.

The four available tabs are:

Basic:  contains  the  basic  information  including  the  name,  description  and  important  BPMN

information.

Extended: creates as many elements  as  required to provide all necessary information to provide for

comprehensive documentation. For further information, refer to Extended Attributes

Advanced: applies specific BPMN attributes to each shape.

Presentation  Action:  defines  what  will  be  displayed  in  Presentation  Mode.  For  further  information

refer to Presentation Actions
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View options
On the bottom right corner of Bizagi Modeler are view options  that help you to navigate through your

process as is shown in the image below.

This menu can be also found on the View  tab of the Ribbon.
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Zoom 100%
Zooms the model to normal size (100%). 

Fit diagram
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Zooms the page so the entire diagram fits in the window.

Zoom to selection
Zooms the page so the selected elements fit the window
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Pan
Shows the pan window which can be used to navigate through the diagram. 

Presentation mode and Presentation actions

Overview
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Bizagi allows you to demonstrate your models through the Presentation Mode where a full display view,

in read-only mode is used, similar to the Full screen view in Microsoft products.

In Presentation Mode you can access the main characteristics  of your  processes, all the documentation

you have included and also add Presentation Actions.

Presentation actions  are on-click behaviors  that  can  be  defined  for  each  diagram  element.  Behaviors

are additional information that you can add to each element in order to make the process  presentation

more complete, for example you can open a URL, a file, an image or display text.

Presentation Mode and Presentation Actions example
To  illustrate  the  Presentation  mode  and  actions,  our  example  presumes  that  we  have  finished  our

Purchase Request Process and now have to present it to the Purchase Department Manager. 

Apart from showing him the process  flow and its  content we also wish to show the following items  in

the presentation:

An associated image of a Purchase Request creation

The Policies for requesting and evaluating quotations

The text contained in the Rejection notification by clicking on the Notify Rejection element.

The  following  steps  illustrate  how  we  created  of  Presentation  actions  and  the  Presentation  Actions

Mode.

Include Presentation Actions
1.  We need to activate  the  presentation  actions  in  order  to  have  them  displayed  in  the  Presentation

Mode.

On the View tab, in the Show group,we select the Presentation actions checkbox.
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2. To include Presentation actions, we need to select the required diagram element.

We right-click on the Create Purchase Request activity and select Properties from the dislay menu.
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3. On the Presentation Action tab we select Open an image from On Click drop-down list.
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4. We click the icon located on the right hand side of the Image field and upload the Create Purchase

Request image.
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5. Thereafter we follow the same steps to add the Policies file on the Quotations  diagram element.  But

instead of selecting Open image, we select Open a file.

6.  Finally,  we add a Show text  action for  the last item. For  this  action  we  type  the  text  needed  to  be

displayed.
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Use Presentation Mode
1. We then click the Presentation Mode button located in the bottom right hand corner of the screen.

Presentation Mode opens a new window, where all processes  are read-only.   We can browse through

all the documentation including the presentation actions.
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2. The presentation actions included are displayed as small icons on the side of the element. 

Click on an element to display the associated action.
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The Pie Menu

Overview
Bizagi Modeler has a drag-and-drop feature that allows you to easily diagram your processes.

The Pie Menu will display as soon as you click on a diagram element that is already in the Process.

Click on the element and drag it to the desired position.

You can drag a shape from the Pie Menu and drop it to another figure already included in the diagram,

to create a connection between the two. You can choose any figure from the Pie Menu and drag it,  not

necessarily the one you are going to connect to; they are just an aid. 

If the figure with which you want to connect is  highlighted, then it means  that you can connect both of

them. If it doesn't highlight it is because the BPMN standard does not allow the connection between the

two selected shapes (i.e. between two signals).

For further information refer to  Creating a process
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PartIII
Modeling a Process
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Modeling a Process

Modeling a Process  is  an iterative and straightforward task to represent business  conditions  in a  flow

diagram, using symbols and shapes. 

Creating a process.

Video Example: Creating a process.

Editing a process.

Sub-processes.

Improving look and feel.

Colors, sizes and shading.

Printing large diagrams.

Creating a process

You can find the contents of this article in the video: Creating a Process

To explain how you can easily diagram your processes, we will use a Purchase Request Process. 

The following are the steps to be carried out in the Process:

A Purchase Request is created

The employee's Immediate Supervisor (Boss) approves, rejects or changes the request

Quotations are obtained in order to select a Supplier

A Purchase Order is created

The Administrative Manager approves, rejects or modifies the Order

The Purchase Order is sent to the Supplier

The Purchase Order is created in the ERP

As soon as you open the Modeler a Pool will be ready for you to start diagramming.

1. Name your pool. It is usually the name of the process you are about to diagram.

To change the name of the Pool double-click on it, press F2, or right-click on it, and then select Edit text

from the display menu.
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2. Add a Lane to include participants in your process.

Drag and drop a lane, for each participant, from the Palette.

In  our  example,  we  will  select  three  lanes:  One  for  the  Immediate  Supervisor  (Boss),  one  for  the

Requester and one for the Purchase Department.
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3. Include a start point in your process. 

Drag and drop a Start event from the Palette 
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4. Continue diagramming your process using the Pie Menu. Select the next element and drag and drop

where you wish to locate it.
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5.  In order  to connect two diagram elements  in a  sequence flow, select an object  from  the  Pie  Menu

and drag it to the second diagram element. They will be automatically connected.
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6. Continue selecting the required shapes until your diagram is complete.

7. To resize the pool, select and drag the appropriate corner of the border.

The following image displays the basic diagram of the Purchase Request process.

This  first  exercise  is  designed  to  show  you  how  to  diagram  with  the  drag-and-drop  functionality.

However,  to  better  describe  the  process  and  meet  the  required  standard,  some  diagram  elements

need to be changed. Please refer to the section Editing a process to continue with this exercise. 
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Video example: Creating a process

This video shows how to create a process in Bizagi Modeler 

Editing a process

Overview
Once you have diagrammed your process, you may need to change diagram elements,  add additional

connections or add more elements to improve and complete it.

We will continue using the Purchase Request  Process  example,  mentioned  in  the  previous  section,  to

show you how to make these changes easily.

Moving elements
If you need to move a diagram element from one place to another  click on it and drag it  to  the  new

position.

Deleting elements
If you need to delete a diagram element click on it and press the Delete button.

Change/ Transform elements
The following image  shows  the  initial  Purchase  Request  process  we  designed.  However,  we  need  to

make some adjustments.

https://www.youtube.com/watch?v=wzynW2roggc
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Change the Notification Tasks  to Script Tasks,  since  they  are  emails  automatically  sent  based  on  a

decision by the Immediate Supervisor (Boss).

The Quotation Task is actually a Sub-process where several activities take place in order to be able to

select a supplier.

The Purchase order Task is also a Sub-process where the Purchase Order  is  sent to the Supplier  and

created in the ERP system.

Bizagi Modeler allows you to change elements within the same category. You do not need to introduce

another element to the Process, but merely change the existing element.

1. To change the Notification Task to a Script Task, right-click on the diagram element and select Task

Type from the display menu.

Choose the appropriate Task type from the drop-down list,  note that  once  you  change  the  task  type

you will  lose any information,  entered into extended attributes,  that has not been  shared.   You

will only receive a warning message if you select the Warn element  type changes  checkbox (located in

the Show/ Hide group under the View tab). 
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2.  Follow the same procedure for  the other  two Notifications  Tasks.  The  following  image  shows  your

progress up to this point.

3.  To transform the Quotations  Task to a Sub-process, right-click on the Task and select Transform  to

sub process from the display menu. Do the same for the Purchase Order Task.
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When you change an element type, any extended attributes information entered will be lost if it hasn't

been shared.

To avoid this, select the Warn element  type changes  to be alerted before changing an element to a

different type, this option is located within Bizagi Modeler Options as shown in the image below.

Please click for further information about sharing extended attributes 
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Adding elements 
If you need to include a new element, keep in mind you may at anytime use: either  the pie menu, or  the

Palette elements found at the left hand.
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In case you want to include a new element in between of 2 existing ones  (which are already connected),

Bizagi will provide an option for  modeling agility so  that  just  include  the  new element  and  avoid  the

need to add further connectors or to delete existing ones.

1.  To include a new element between 2 existing ones, drag it from the Palette and into the  connector

itself.

Note that the connector will highlight to indicate where the new element can be dropped for  Bizagi to

attach it automatically.
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2. Finally, name your element.

Notice that  it  will  be  automatically  connected,  and  it  will  also  create  the  additional  connector  to  the

other element.
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Adding Milestones
Milestones are Sub-partitions of a Process used as reference points.  They help the readers  understand

the different stages that make up the Process.

We will include three Milestones to determine the state of each activity within the Process.

1. To include a Milestone drag it from the Palette and place it in the Process.  Drag and drop two more

Milestones.
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2. Drag and drop the diagram elements that belong to the Milestone.

3. Finally rename each Milestone by clicking on it, pressing the F2 key, and entering a name.
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Sub-processes

Overview
A sub-process is a compound activity that is included within a process. Compound means that it can be

broken down into lower levels, that is each level includes shapes and elements within it.  

In the previous  section we defined a task called “Quotations”,  if you  have  not  already  created  it  as  a

sub-process  (as  we  now  realize  that  this  task  contains  many  activities)  we  need  to  transform  the

diagram element and define the sub-process flow. 

1.  To  transform  the  Task,  (in  this  case  Quotations),  to  a  sub-process  element,  right-click  on  it  and

select Transform to sub-process from the display menu.
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2. Once the Task has been converted to a sub-process it is necessary to define its related diagram. 

Right-click on the sub process element and select the Edit subprocess from the display menu. 

3. This will automatically open a new diagram page to include the sub process information. 

On  this  page  you  can  diagram  the  associated  sub-process,  just  the  way  we  diagrammed  the  first

process. Just drag and drop the elements as needed and place them where appropriate.



96Copyright © 2002-2016 Bizagi. All rights reserved.

Change the sub-process type
BPMN defines several types of sub-process  that respond to particular  business  needs. By default sub-

processes are created as embedded but you can change the sub-process type anytime.

Once you have created a sub-process element in the diagram right-click on the element and select one

of the following options:

Is transaction

Is ad-hoc

Is Event sub-process

Sub process type -> Reusable sub process
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Additionally you can define the Loop Type of your process from these three options:

None

Multi-instance, the multi-instance attribute of sub processes  allows the creation of a  desired number

of activity instances.

Standard, this feature defines a looping behavior based on a boolean condition. The sub-process will

loop as long as the boolean condition is true.

For each loop type there are specific advanced options to configure the process's behavior.

Advanced properties are located in the Advanced tab from the shapes Properties.

By default sub-processes  are created  as  embedded.  In  BPMN  this  type  of  sub-processes  have  no

pools  or  lanes.  Embedded  sub-processes  do  not  allow you  to  add  any  pools  or  lanes  to  ensure

conformity with the BPMN standard. 

If you need to include pools  and lanes  you can use Reusable  sub-processes  that  according  to  the

BPMN standard can include pools  and lanes. These type of sub-processes  are predefined activities.
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That is, they are independent and thus are created individually. Then, they can be related to the sub-

process shape. In BPMN this type of sub-process  is  called a "Call Activity",  in Bizagi Modeler  we call

them Reusable.

Converting to reusable sub-process

Overview
You can convert a default sub-process to a Reusable Sub-process, or Call Activity (in BPMN).

1.  Right-click  on  the  Sub-process  to  convert,  choose  the  Sub-process  type  option  and  then  click  on
Reusable process.

The diagram element's border will change to indicate it is now a reusable Sub-process.

If you have already diagrammed the Sub-process  you will receive a message alerting to this  fact.  Click

the Yes button to convert it and keep all the lower level diagram elements.
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It is important to clarify that a reusable Sub-process calls a separately modeled process.

There are two different ways of creating a call to a reusable sub-process. The Edit Sub-process option

opens an empty diagram workspace and relates it to the shape.  Alternatively, you can manually relate

the shape to a predefined diagram.

Let us assume that the Quotations Sub-process is reusable and has not yet been diagrammed .

To create a call for the Sub-process not yet model (i.e., create the detail in a new diagram), use the Edit

Sub-process option by right-clicking the shape:
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2.  To  reference  an  existing  diagram  (assuming  Quotations  detail  was  created  in  the  previous  step),

relate the diagram in the Sub-process properties.

To do this,  right-click on the Request  Quotations  reusable Sub-process  element  and  select  Properties

from the display menu.
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3. The Element Properties add-on window will display. On the Basic tab, in the Process  drop-down list,

select the predefined created Diagram.

Sub-process types

ELEMENT DESCRIPTION NOTATION
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  Sub-process

Is  an  activity  whose  internal  details  have  been

modeled  using  activities,  gateways,  events  and

sequence flows. The element has a thin border.

  Reusable Sub-

process

Identifies  a  point  in  the  process  where  a  pre-

defined process is used. A reusable sub process  is

called a Call Activity in BPMN.   The  element  has  a

thick border.

  Event Sub-

process

A Sub-process  is  defined as  an Event Sub-process

when  it  is  triggered  by  an  event.  An  Event  Sub-

Process is not part of the normal flow of its  parent

Process—there  are  no  incoming  or  outgoing

Sequence Flows.

  Transaction

Is  a  Sub-process  whose  behavior  is  controlled

through a transaction protocol. It includes the three

basic  outcomes  of  a  transaction:  Successful

Completion,  Failed  Completion  and  Cancel

Intermediate Event.

  Ad-Hoc sub-

process

Is  a  group  of  activities  that  has  no  REQUIRED

sequence  relationships.  A  set  of  activities  can  be

defined,  but  the  sequence  and  number  of

performances  for  the  activities  is  determined  by

the resources of the activities.

  Standard loop

Sub-processes  may  be  repeated  sequentially,

behaving like a loop. This feature defines a looping

behavior  based  on  a  boolean  condition.  The

activity will loop as  long  as  the  boolean  condition

is true.

  Multi-Instance

loop

Sub-processes  may  be  repeated  sequentially,

behaving  like  a  loop.   The  Multi-instance  Loop

iterates  a  predetermined  number  of  times.  The

iterations  occur  sequentially  or  in  parallel

(simultaneously).

Improving look and feel

Overview
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This article presents tips and tricks that will aid in improving the look and feel of your diagrams.

Diagramming and naming recommendations 
It is important that Processes are uniformly described, for the sake of being more easily understood by

users. 

Therefore, special care must be taken in the naming and layout of all diagram elements.

The  following  are  best  practice  recommendations  that  will  make  processes  more  readable  and

organized.

All words should be capitalized to aid readability.

Always name Tasks using an infinitive verb, to denote an action being executed e.g.:  Create request,

Authorize request, Deliver package.

Name Processes and Sub-processes indicating their main purpose.  

Always  attempt to lay out the Process  model  in  a  left  to  right  direction,  as  it  is  an  intuitive  design

choice for left-to-right readers.

Name  Sequence  Flows  that  follow  after  a  decision  Gateway.  For  example,  if  a  gateway  is  called

"Request authorized?" then the sequence flows are named "Yes" and  "No" respectively.  

Name non-decision Gateways  as  well.  For  example, a  Process  that contains  three  parallel  Gateways

can be named "Parallel1",  "Parallel2",  "Parallel3" respectively.  This  will allow you to easily distinguish

one from another in generated documents.

Move and resize text 
You can move and resize text  in  the  following  elements:  Sequence  Flows,  Events,  Sub-processes  and

Gateways. 

To move any of the mentioned text, select and drag-and-drop it where you desire.

To resize the text, select the text and drag the border of the frame.

 



104Copyright © 2002-2016 Bizagi. All rights reserved.

Reset text position
When the text of an element has  been repositioned, you can revert it  back  to  its  original  position  by

selecting the Reset text position option on either the element, or the text itself.

In the following image the Changes required caption was moved too far away from the Sequence Flow it

references. 

To revert to its original position, right-click the Sequence Flow and select Reset text position.

Note that this option is available at the text (caption) as well:

Fit to text 
In the course of modeling your diagrams, you may come across  a  situation where the element is  much

bigger  than the text within it and you need to make it fit the text.   A similar  situation may arise where

the horizontal space of the element is smaller than the text within it,  causing the text outside the object
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boundary to be cut off.  You can manually drag one of  the  element's  corners  to  size  or  make  use  of

Bizagi's Fit to text design shortcut.

To automatically resize the object to fit the text, use the Fit to text option.

Reset to original size
When the size of an element has  been changed (either  enlarged  or  shrunk),  it  can  be  reverted  to  its

original size by selecting the Reset size option on the element.

In the following image, the Notify Rejection element was enlarged. 

To revert to its original size, right-click the element and select Reset size.

Using the grid
We recommend always showing the grid to facilitate the alignment of elements.

If you select the Align to Grid option, the Modeler  will auto-align elements  to the grid. Essentially,  once

the element is dropped, it snaps to the nearest intersection of lines in the grid.

To  utilize  this  option,  in  the  Show  group  of  the  View  tab,  check  both  the  Grid  and  in  the  in  the
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Alignment group, Align to grid boxes.

Aligning elements
Align all elements both vertically and horizontally, to present a structured layout of your Process.

Bizagi offers a functionality called Smart align whereby the sequence flows will be automatically aligned

to each other. To utilize this functionality select Smart align in the Alignment group on the View tab.

The following image shows the process without Smart Align selected.
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The following image shows the process with Smart Align selected.
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Rather  than align all Sequence Flows of a  diagram,  you  can  also  align  selected  diagram  elements  to

each other.

Click each elements for alignment while holding down the Shift  key. In the Layout  group of the Format

tab, click Align Horizontal, Align Vertical, Distribute horizontally or Distribute vertically  according to your

design requirement.
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Connecting sequence flows
To  connect  a  Sequence  Flow,  drag  the  red  circle  (which  coincidentally  is  the  arrow  head)  onto  the

diagram element you want to connect to. 

Hover the pointer over the element until the green circle appears indicating that it will connect correctly.

Colors, sizes and shading

Overview
Bizagi allows you to customize the appearance of your diagrams. 

You  can  modify  the  text  formatting  of  elements  such  as  size,  color  and  type  of  fonts.   In  addition

shading can be added to elements including Pools.

You may choose to predefine default settings  for  the font style,  font size and shape colors,  or  directly

customize these visual options in each diagram.

The maximum space to model processes with Bizagi Modeler is calculated as follows:
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Width by Height must not be over 36.000 pixels.

The maximum width size is 10.000 pixels.

Set default settings
To define the font and color  options  you want to  use  by  default  (for  new elements),  go  to  the  Main

Options found in the File Tab.

Set default Font and Font size
In the File Tab, select Options.

In the BPMN element options section of the new window,  select the default font face and size from the

drop-down lists.
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Click Ok to save the settings and return to the diagram.

Element captions created from this point onwards will use the default font and size.
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Note that you may also restore this  setting to Bizagi's  default text style and size (Segoe UI,  size 8) by

clicking on the Restore option. 

Set default size for elements
In the File Tab, select Options.

In the new window, click Configure button in the Default sizes property.
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To alter the size of an element, you can either do so with the mouse (drag one of the element's  corners

to size), or directly enter the pixels  dimensions  in the Width and Height  fields  at the bottom left of the

screen. 
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Click Ok to return to the diagram.

Elements, from this point onwards, will be created with the default size

The default setting will apply to both the Palette and Pie Menu components. 
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Restore to defaults
To restore the altered font size (revert to Bizagi Modeler's  default,  namely  Segoe  UI,  size  8),  use  the

Restore button in the Options window.
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Similarly,  to  restore  the  element's  size  to  Bizagi  Modeler's  default,  use  Restore  all  to  default  values

option.
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Customize existing diagrams
To customize a diagram, select the desired format in the Formatting group of the Home or Format tab. 

Text formatting
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Select the diagram element, then choose the desired format from the Formatting group.  The examples

below show how to change the font style, italicize text and make the text bold.

To change the font  face,  click  the  arrow next  to  the  Font  combo  box,  then  select  the  style  from  the

drop-down list.  Click the Italic or Underline icon to italicize and bold text respectively.

   

To change the font color,  expand the Font Color  drop-down list and select the color  of  your  choice.  

For alignment, expand the Align drop-down list and select from Left, Center or Right align.
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Shading of elements
It is possible to change the background color of your diagram, as well as  for  all elements  (this  includes

shapes, connectors, Pools, Lanes, or Milestones).

 

To do this, select the element you wish to customize.  

Click the arrow next to Shading to select the Change option.  Expand the Change drop-down and select

the appropriate color from the background color palette.

 

Bizagi uses gradient fill by default for these background colors, however you may alter this setting.  

For more information about disabling the gradient fill, refer to the sections below.

Restore to default settings
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To clear all formatting and revert to the default style,  select the diagram you want to restore and click

on the Clear Formatting icon.

Click on the arrow next to Shading and select the Restore option to revert to the original color. 

Disabling Gradient-fill 
To disable gradient fill in element colors, go to the View tab and locate the Show group.

In this  group, you  may  disable  or  enable  the  Gradient  option  so  that  the  color  of  the  elements  (i.e,

Gateways, Tasks, Events and Sub-processes) are not shown/published/printed with a gradient fill.
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Disabling Shadows
To disable shadows-styled elements, go to the View tab and locate the Show group.

Under this group, you may disable or  enable the Shadows  option so that elements  such as  Gateways,

Tasks, Events and Sub-processes do not show/publish/print the drop shadows.
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Printing large diagrams

Overview
You can print large diagrams by customizing the print settings  of the diagram.  You can set the paper

size, scales, margins, number of pages, among other things.  

To illustrate how to print large diagrams we will use the Personal Loans  Request process  that you can

find  in  our  free  Process  XChange.  This  is  a  complex  process  where  the  length  makes  it  a  perfect

example for using customized print settings.

It is necessary to change the Printing default settings by following the steps described below.

 

1. On the File tab, in the Print option, select Print Preview.

Alternatively you can use the Ctrl+p shortcut.
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The diagram is  displayed over  several pages. Thus  the default settings  are not suitable for  immediate

printing. 
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2. In the Page Setup group, click the arrow below Size and select the desired size option. Choose the

paper size, which you will use to print the diagram on, from the list of available sizes.
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3.  In  the  Page  Setup  group,  click  the  arrow below Orientation  and  select  either  Portrait  (vertical)  or

Landscape (horizontal). 

In this case, since the diagram is long but not too wide we opt for the landscape orientation.

4. On the Page Setup tab, click the arrow below Margins and select the desired Margin from the drop-

down list. We select Narrow margins, in this  case, to give the process  as  much space in each sheet as

possible. You may choose your own customized margins.
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5. On the Page Setup tab, click the arrow below Scale and change the diagram scale.   The top option

sets  a  percentage  of  the  normal  size  of  the  diagram.  Choose  the  percentage  that  best  fits  your

diagram. At the bottom, select the number of pages to fit your diagram on.

As you change the print settings, the diagram will be adjusted and the print preview displayed.
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PartIV
Documenting a process



130Copyright © 2002-2016 Bizagi. All rights reserved.

Documenting a process

Bizagi  Modeler  allows  you  to  document  in  addition  to  modeling  your  processes.  You  can  include

information  at  process  level  as  well  as  detailed  information  at  an  element  (element)  level  in  your

diagram. We recommend the inclusion of all relevant information to make the document readable and

easily understood. 

Once  your  process  diagram  and  documentation  is  complete,  you  can  publish  the  documentation  in

your preferred format.

For further information please refer to Publish or Export process documentation. 

Documenting each element
Document at process level
The information included at process level describes the overall process.

By default you can include the following information: Name of the process,  description, the version and

the author.

Right-click outside of the boundaries of the pool and select Diagram Properties.

This  will  enable  the  Diagram  properties  add-on  window at  the  bottom  of  the  screen,  where  you  can

include the relevant information.
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We recommend to  include  extended  information  such  as  the  scope,  goal,  process  owner,  important

definitions  and  any  annex.  To  learn  how to  include  additional  information  please  refer  to  Extending

your documentation.

Such information may be included with rich-text formatting.  

To learn more about this option, refer to Using rich-text formatting.

Document activities and elements
The information included in each element gives  you the possibility to enter  detailed information about

each step of your flow.

By default you can include the Name of the element and a complete description.  In  Activities  you  can

also include Resources.

1. Right-click on the element you wish to document and select Properties from the display menu.

2.  This  will enable the Element  properties  add-on window at the bottom of the screen, where you can

include the relevant information.
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Insert all relevant information focusing on being as  clear,  thorough and informative as  possible.  This  is

essential  to  ensure  the  document  is  readable  and  the  process  easily  understood  for  successful

execution. 

We also advise to include the supplementary information for Activities and Intermediate Events,  such as

duration,  business  rules  that  resources  must  comply  with  and  any  documentation  or  forms  that  are

used. 

If  you  are  automating  your  process  we  recommend  to  include  the  forms  that  will  be  displayed  to

performers.

To learn how to include additional information please refer to Extending your documentation.

To learn more about process automation please refer to Process Execution.

Using Rich Text Format

Overview
While documenting your  processes, you may use rich format for  the entered text in both descriptions

and extended documentation.

This  is,  the possibility of having your  texts  use different font colors,  color  shading, and styles  such as:

bold, italic, underlined, as well as  other  formatting possibilities  such as:  indentation and bullets,  use of

tables, links and images, amongst others.

This  applies  for  the information  contained  in  descriptions  and  extended  attributes  such  as  Textareas

and Textboxes.

Rich format in descriptions
To define rich text formatting for  your  elements  descriptions, use the Expand icon located at the right

hand.
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This  option will open an edition-mode window, in which you may make full use  of  the  rich  formatting

options:
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Rich format in extended documentation
To  define  rich  text  formatting  for  your  detail  in  extended  attributes  (Textareas,  Textboxes),  use  the

Expand icon.

This icon appears right above the information, when hovering over the extended attribute name.
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When clicking on this option, Bizagi will show an edition-mode window, in which you may make full use

of the rich formatting options:
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Rich formatting
You may include rich text format to your documentation using the following options:

TAB / GROUP DESCRIPTION

Home / Clipboard Handle content by using standard clipboard possibilities: Copy, Cut, Paste

and Paste special

Home / Font Modify: fonts, font size, emphasis (bold, italic,underlined, strikethrough, etc)

and other formatting options such as upper or lower case, and shading

color.

Home / Paragraph Define: alignment, indentation, bullets and numbering, spacing and color fill

options.

Home / Editing Use: Find and replace options to quickly locate your texts.

Insert / Illustrations Include pictures.

Insert / Links Include hyperlinks to Web pages, or to other places in the content.

Insert / Symbol Include symbols from the standard set of characters.

Layout / Table Allows: creating a table with the desired number of rows and columns, giving
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quick format, borders and shading to the table, and its rows and columns.

Layout / Rows and

columns

Handle table modifications by inserting or deleting rows and columns.

Layout / Merge Quickly use powerful options to merge or split cells, or split a table into two

of them.

Layout / Cell size Define the cell size and property for specific cells.

Layout / Alignment Define alignment and margins involved in cells.

Information with rich text format is published in the generated PDF or Word document:

Information with rich text format published in Web:
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Information with rich text format shown in Presentation mode: 

For more information about the generated Web, PDF or Word, and Web documentation, refer to 

Generating Documentation. 

Spelling review

Overview
Bizagi offers a proofing option to check for spelling mistakes while documenting the processes.
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To use this feature, ensure that the checkbox Spelling mistakes  at the View tab is  enabled, then locate

the Spelling option in the ribbon, at the Home tab.

You may choose a predefined language to be used as  the default spelling dictionary directly from  its

drop-down options:

Available language dictionaries are: 

German (Germany)

English (UK)

English (USA)

Spanish (Spain)

French (France)

Italian (Italy)

Dutch (Nederlands).

Portuguese (Brazil)

Russian (Russia)

To launch the spelling review, click directly on the Spelling option
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Proofing options are described in the table below.

SPELLING REVIEW OPTION DESCRIPTION

Ignore Ignores the current word and continues proofing the rest of the

information.

Add to Dictionary Adds the current word as a valid word to the given Dictionary.

In this way, the spelling review will not prompt again to correct

these entries.

Reset Dictionary Resets the Dictionary (deletes added entries).

Change Changes the current word for the chosen suggestion.

Change All Changes all occurrences of the current word for the chosen

suggestion.

Defining Gateway conditions

Overview
Gateways represent a branching point in the Process, from which more than one path will be possible

(divergence).

When alternative paths are available from a Gateways (especially for Exclusive or Inclusive types),
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documentation is included as conditional expressions for each decision branch representing a path.

In Bizagi, you may define the condition for the path either in the Gateway itself, or in each of its  decision

branches (or sequence flow).

Defining conditions in the gateway
To define the conditions  to  be  met  for  the  given  path,  open  the  Gateway  properties  and  locate  the

Advanced tab.

For  each  of  the  outbound  paths  at  the  Gateway  (i.e,  .each  decision  branch),  you  will  find  a

corresponding row in the Gates table, identified by the branch name (caption).

You  may  either  define  a  conditional  expression  for  the  selected  path,  or  designate  it  as  the  Default

path.

Note the visual representation of a default path is a small oblique line crossing the decision branch. 

Defining conditions for each sequence flow
To define the conditions which must be met for each path in a Gateway, right-click on the sequence flow

representing the path.
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In the options displayed you may easily set that this sequence flow is to be taken as the default path by

clicking on Is Default (marking this property) 

The Edit condition option provides  quick access  to the expression editor  to create a condition for  this

path. 

Defining Resources

Overview
A Resource is a Business Entity (e.g. a company, company division, a  customer) or  a  Business  Role (e.g.

a buyer, a seller, a credit analyst), which controls or is responsible for a business process  or  a  business
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activity. 

Resources  are  part  of  the  basic  Element  properties  provided  by  default.   In  each  shape  they  are

identified as Performers, since they are the ones taht actually perform the task. They can be defined for

the whole Pool and for each Activity (Task or Sub-process). 

To define, edit or remove Process Performers click on the Performers icon located on the Home tab.

This will display the Performers pop-up window.
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Click the Add button to create a new Resource.

Click the Edit button to edit.

Click the Delete button to delete.
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Enter the name, description and type (Role or Entity) of the Resource.

Once a Resource has been created, you will be able to select it on any activity.
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Extending your documentation

Overview
With Bizagi Modeler  you can extend your  documentation to  include  any  type  of  information  that  you

find relevant for your processes, through extended attributes.

Extended attributes are used to customize your  documentation by adding to the basic attributes  which

is the default option.

You can include extended attributes in each element of the process.

Once you have created an extended attribute, it will be available for all elements of the same type.

Include Extended Attributes
In  order  to  better  explain  how  you  can  easily  include  extended  attributes,  we  will  add  a  Duration

attribute to all Tasks in our Purchase Request process. 

As Duration is an integer numeric data type, we will use a Number attribute. 

1.  Select  and  right-click  on  the  Task  where  you  want  to  create  the  extended  attribute,  then  select

Properties from the display menu.

Select the Extended Attributes tab on the Element properties in the newly displayed add-on window.
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2. Click the Add New Extended Attribute link. Provide a name and description, then select Number as  the

attribute's Type. 

3. Some types have special information that you can add. For Number-type extended attributes you can

add a valid range. In this case we define a duration range of 0 to 500 minutes.
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Notice this is the creation of the Extended Attribute only. We have defined a name, its description and a

range. Now, we are able to enter the Duration for each Task.

Use Extended Attributes
Once you have created one Extended Attribute it will be available for  all the elements  of the same type

in the Model.

On the Extended tab of the Element properties add-on window, enter the information for  each element

of the same type as shown in the image below.

Extended Attributes type
Bizagi  offers  a  wide  variety  of  Extended  Attribute  types.  Select  and  create  as  many  attributes  as

required from the following list:

Text Area: stores approximately 32,000 characters, and is used to display long texts with line breaks.

Text Box:   stores  approximately 32,000  characters,  and  is  used  to  display  short  texts,  without  line

breaks.

Number: stores numbers. 



149Copyright © 2002-2016 Bizagi. All rights reserved.

You must define a minimum and maximum range. 

Date: stores dates.

Image: stores images with the following extensions: JPG, bmp, PNG and GIF

Single Selection Options (Combo):  allows you to define several options  to  choose  from,  but  only

allows selection of one entry from the drop-down list.

You must define the desired options for selection.

Single Selection Options (Radio): allows you to define several options  to choose from, but you can

only check one radio button at any one time.

You must define the desired options for selection.

Multiple  Selection  Options:  allows  you  to  define  several  options  to  choose  from,  and  allows

selection of one or more of the check boxes displayed.

You must define the desired options for selection.

Embedded  File:  allows  the  modeler  to  attach  a  file  to  be  available  within  the  Model.  The  file  is

copied to the model's folder.

When published  this file type and the Linked file will be displayed in the same way.

Linked File: allows you to include a link or  path to a file.  The model stores  a  link to the file,  not the

file itself.

When including this  extended  attribute  the  user  must  select  check/uncheck  for  the  option  Relative

path.

Relative path option allows you to include your link either as a relative or absolute path.

Relative paths change depending upon what page the links are located on. 

For example, if the file is  stored in your  computer  you would share: C:\MyDesktop\PurchaseRequest

\FileUplodadedInThisExample

If  you  check  on  Relative  path,  then  the  url  will  be  stored  as:  PurchaseRequest

\FileUplodadedInThisExample. 

This way you can share your folder and the file can be opened anywhere.

An  absolute  path  refers  to  a  fixed  location  including  the  domain  name.  You  typically  use  absolute

paths to linked to elements that have a fixed reference location no matter by which means you access

them. 

We recommend absolute paths (Relative Path not checked) when the files are on your network. 

For example: \\Mynetwork\SharedModels\PurchaseRequest\FileUplodadedInThisExample 

URL: stores a URL to link an internet resource.

Table:  allows you to build a table, including any of the attributes mentioned above.

Click here for an example of a Table Extended Attribute

Example: Add a Table Extended Attribute
We are going to include an Extended Attribute where we can document  the  Performers  of  each  task,

subject to certain conditions. 
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The  performers  of  the  Purchase  Request  Process  are  allocated  according  to  purchase  amount.  This

means that given a certain amount, the purchase will have to be approved and managed differently. 

For  example  the  process  is  different  when  buying  50  computers  to  that  of  purchasing  some  office

supplies like paper, pens and pencils.

To document this  we will use a  Table  extended  attribute  where  we  can  define  the  description  of  the

performer (name) and a column that will define the amount.

1.  Right-click on any Task, select Properties  from the display menu and select the Extended  Attributes

tab. 

Click on the Add New Extended Attribute link.

2. Enter a name and description and select Table as the type

3. Include the columns of the table for the extended attribute. 

For this example we will need two columns: the position of the performer and a description.

To add a column use the  button. 

On the right side of the window enter  the name of the column, give a description and select the type.

Since the first  column of  the  table  is  the  name  of  the  performer,  we  have  to  define  the  type  of  the

attribute as a text box. 
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4. The second column is the condition to be evaluated, which is the amount of the purchase. 

We are going to consider only three options:

Under 1,000 dollars

Between 1,001 and 5,000 dollars

Above 5,001 dollars

Thus this  attribute can be defined as  a  Single Selection Option (combo),  this  way the Modeler  will allow

you to choose from one of the above options. 

Create the new attribute  by  clicking   on  the  Add   button  and  select  the  Single  Option  (Combo)

type. 
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5. Add the multiple conditions for the modeler to choose from, then click the OK button.

Once you have created this attribute it will  be available for all  the elements of the same type in

the Model.

Click the Add button located on the bottom of the Element  properties  window to  add  records  to  the

task.
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Managing Extended Attributes
You can edit, remove or change the position of your Extended Attributes. 

To manage Extended Attributes, select it in the Performers list. A menu will be displayed on the right.
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The Edit button allows you to change the type, name and description of your attribute. 

The Remove button deletes the attribute. Note, once deleted you can not undo the action.

The Up and Down buttons  change the position of the attribute. This  defines  the order  in which  they

are generated in your documentation. 

The Share button allows you to share the attributes with elements that have different shapes. 

Sharing Extended Attributes between elements
Once you have created an Extended Attribute it will be available for all the elements of the same type in

the Model.

It is very common to need an Extended Attribute on several elements of different types. 

You can share Attributes following the instructions below.
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1.  Select  the  diagram  element,  where  the  Extended  Attribute  was  previously  created,  to  open  its

properties, and select the Extended tab. 

Click on the name of the Attribute that you want to share, and click on the share button  . 

2. Select the structures, among which, you wish to share the Extended Attribute with. In this  case we will

share the Performers attribute with the Lane, Manual Task and User  Task.  After  selection, click the OK

button.
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Exporting and Importing Attributes between Models

Overview
It is  possible to share  the  Extended  Attributes  that  you  created  in  one  model  and  use  then  in  other

models.  This  allows  you  to  maintain  a  uniform  standard  in  your  documented  processes  by  always

utilizing the information in the same manner.

To do this  you will need to export a  file from Bizagi Modeler  to a chosen folder,  where the extended

attributes will be saved. Then import the file to the model where you want those attributes to be used.

Export Extended Attributes
In the Model where you have defined and created the Extended Attributes  you  want  to  reuse,  on  the

Export/Import tab, in the Export group, select Export Attributes.

Specify the folder where the file will be saved. This folder must have have read and write permissions. 

Give your file a valid name and click the Save button.
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Import Extended Attributes
Once you have saved the Extended Attributes in a file, you can import it to any Model. 

On the Export/Import tab, in the Import group, select Export Attributes.

Select the newly created Extended Attributes file. A message will display that you need to read carefully.

If  you  have  some  Extended  Attributes  in  the  Model  into  where  you  are  importing,  and  YOU  DON'T

WANT TO OVERWRITE THEM, then click the YES button. Doing so will append the imported Extended

Attributes  to  the  existing  Extended  Attributes.  If  you  click  the  NO  button,  ALL  YOUR  PREVIOUS

EXTENDED ATTRIBUTES WILL BE REPLACED.
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Video example: Documenting your process

This video shows how to document your processes with Bizagi Modeler 

Using Artifacts
Artifacts provide modelers with the capability of showing additional information about the process  that

is not directly related to the flow. 

Artifacts are found in the Palette.  There are five types  provided by default,  and a user-defined Custom

Artifact.

https://www.youtube.com/watch?v=KyQlO-YeZPs
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ELEMENT DESCRIPTION NOTATION

Group
An artifact that provides a visual mechanism to group elements  of a

diagram informally.  The Group  can  be  used  for  documentation  or

analysis purposes, without impacting process flow. 

Annotation
Is a mechanism for a modeler  to provide additional information for

the reader of a BPMN Diagram.

To include line breaks in the text use CTRL+ENTER

Image
Enables  images  stored  on  your  computer  to  be  inserted  in  the

diagram.  

Header Shows the diagram’s properties. 

Formatted Text
This  artifact enables  you to insert a  rich text area into the  diagram

to provide additional information. 
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Custom Artifact
A user  defined  artifact.  Artifacts  provide  the  capability  of  showing

additional information about the process  that is  not directly related

to the flow. 

To include an Artifact select it from the Palette and drag and drop it onto the diagram. 

To connect an artifact with an element use the Association Connector. 

Some artifacts can be placed on the diagrams using the Pie Menu as shown in the image below. 

Click on the element, select the Artifact and then drag and drop it appropriately. 
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Custom Artifacts

You can create your own Artifacts using the Custom Artifact  button found in the Palette.

You can attached any stored image onto a Custom Artifact.  Browse and select the desired image and

name it.  Click the OK button .  

  

Your newly created Custom Artifact will now display in the Custom Artifact group on the Palette.

To include your new Artifact in the diagram, drag and drop the Custom Artifact from the Palette.
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Manage Custom Artifacts
To add, edit or delete Custom Artifacts select Custom Artifacts, located in the Tools group on the Tools

tab. 

A new window containing all Custom Artifacts will display for the current Model.

The command buttons located at the bottom of the screen will allow you to manage your Artifacts.   The

command buttons are New, Edit, Delete, Export and Import.
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Exporting and Importing Artifacts between Models

You can share the Custom Artifacts  you have created to use them in  other  models.  First  you  need  to

export a  file (.bca  file  extension)  to  a  folder  of  your  choice.  Thereafter  import  the  file  to  the  model

where you wish to use the artifacts. 

Export Custom Artifacts
In the Model where you have created the Custom Artifact,  select Custom Artifacts,  located in the Tools

group on the Tools tab.

Select the Artifact that you wish to share and click the Export button  .

Choose the a folder  where the file is  to reside, name your  file and click the Save button.   Ensure  the

export folder has read and write permissions. 
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Import Custom Artifacts
Once you have saved the artifact in a file, you can import it to any Model. 

Open the Model where you wish to import the Artifact and select Custom Artifacts,  located in the Tools

group on the Tools tab.

Click the Import button. 
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Select the exported file name and click the Open button.

Now your attribute is available to use in the diagram. 
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Company logo
Based on feedback from the Bizagi user  community there is  now an option to remove the Bizagi logo

from the documentation and use your own company logo.

Bizagi Modeler,  with its  full functionality,  is  and will stay freeware.  If you must remove our  Bizagi logo

and thus, remove our marketing mechanism, you will be asked for a small contribution that will be used

to further improve this freeware and benefit the whole community.

To remove the Bizagi logo from your documentation please follow these simple steps:

1.  Download  the  latest  Bizagi  Modeler  version  (http://www.bizagi.com/index.php?

option=com_content&view=article&id=95&Itemid=107)

2. On the File Tab, select Options and then choose the Documentation option.

3. Click the Configure logo used for documentation link.

4.  Click the Buy Now link to purchase the activation KEY. This  will take you to the secure Bizagi Online

Shop.  

http://www.bizagi.com/index.php?option=com_content&view=article&id=95&Itemid=107
http://www.bizagi.com/index.php?option=com_content&view=article&id=95&Itemid=107
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5. You will receive a confirmation email with the activation KEY, once your purchase is finalized.

6. Enter the key in the same link window and click the Activate  button.

7. A message will display informing of successful validation. Click the OK button.
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8. In the last window you will be able to determine the logo you wish to use:

No logo

Keep the Bizagi Modeler logo 

Use a customized logo

For  the customized logo, select Custom Logo and  open  the  folder  image  to  browse  and  select  your

user-defined logo.

9. Click the Close button to finish your configuration.

Important information

You need to buy an Activation Key for each installation (computer) of Bizagi Modeler.

For  example, if you  have  Bizagi  Modeler  installed  in  5  PCs,  and  you  need  to  activate  the  logo

configuration option in all PCs, then you need to buy 5 Activation Keys. 

Just modify the  quantity  in  the  shopping  cart.  You  will  receive  a  single  Activation  Key,  which  is

valid for the 5 PCs.

The contribution is a one-off payment. The Activation Key will not expire and the logo

configuration option will remain enabled, even if you make updates or upgrades to a new version

of Bizagi Modeler.

You will pay on a secure online platform and will receive your Activation Key via email. 
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PartV
Generating Documentation
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Generating Documentation

You  can  publish  your  complete  documentation  in  any  of  the  following  formats  and  share  with  your

organization.

Microsoft Word

PDF

Microsoft Excel

Mediawiki

Web (format to be opened with a browser)

This format can be generated from the command prompt.

Microsoft SharePoint

You can export your  process  diagrams to other  Modeling tools  or  export your  customized  attributes

and reuse them in other Bizagi Process Models.

Microsoft Visio: export your diagrams to Visio 2003, 2007 and 2010 

Image files: export  your diagrams to png, bpm, svg or jpg format

XPDL: export your diagram to XPDL 2.1

BPMN: export your diagram to BPMN 2.0 xml format

Attributes: export your customized Extended Attributes and use them in other  Bizagi Process  Models,

to maintain a standard in your documented processes.

Publish or Export

Publish your complete documentation
You  can  publish  your  complete  documentation  in  any  of  the  following  formats  and  share  with  your

organization.

Microsoft Word

PDF

Mediawiki

Web file (opened through a browser)

Microsoft SharePoint

Publish All Model and Quick publish
For Word and PDF publishing you can publish all your documentation with just one click.

Publish  All  Model   publishes  all  the  elements  in  your  Model  (including  all  diagrams)  with  all  the

documentation you have defined for each one.

Quick Publish remembers  the last time you published and will generate your  documentation  without

going through the publish wizard. If you have not published before, you will need to go through all

the steps of the publish wizard.
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Export your diagrams
Use this option to export your process diagrams to other Modeling tools or to export your  customized

attributes and reuse them in other Bizagi Process Models.

 

Microsoft Visio: export your diagrams to Visio 2003, 2007 and 2010 

Image files: export  your diagrams to png, bpm, svg or jpg format

XPDL: export your diagram to XPDL 2.1

Attributes: export your customized Extended Attributes and use them in other  Bizagi Process  Models,

to maintain a standard in your documented processes.

Click here for more information about Exporting Extended Attributes

Publish in Word
You can publish your completed documentation and share it with your organization in Word format. 

Customize the  output  information  for  inclusion  in  your  document  by  selecting  the  diagrams  and  the

elements to be included.

Bizagi provides an intuitive wizard to help you through the steps to generate your documentation.

1. On the Publish tab, in the Publish group, click Word.
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2. Select the diagrams that you wish to publish. 

Select individually by using the   button or by double clicking them.

Select all by using the   button. 

When all the diagrams you wish to publish are selected, click the Next button.
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3. Choose the order in which you wish to publish your diagrams by using the buttons  on the right hand

side. Once finished, click the Next button.
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4. For each diagram select the elements that you wish to publish in the documentation.

You can select all elements across all diagrams using the  button. 
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You can individually select elements  from each diagram using the   button or  by double clicking

them.
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5. For each diagram select the order in which you wish the elements to be exported. 

By default elements are organized according to the sequence of the process flow . 

To move an element from its  default position, select the element and click the  button  until  you

find the desired position.
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Click the  button to order the elements automatically.

When you are satisfied with the order of the elements for each diagram, click the Next button.

6. Select the template you wish to use for your export documentation. 

By default the Modeler  offers  two templates:  Bizagi Template with Bizagi's  format (fonts,  water  marks)

and the Modeler Template with a standard format.  

You can create your  own user-defined template as  well.  Please  refer  to  Document  Template  to  learn

how  to  customize  and  use  your  user-defined  template.  After  selecting  the  template  click  the  Next

button.
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7.  Specify the appropriate folder  in which to publish your  process.  This  folder  should  have  Read  and

Write permissions.

By default, the Diagram's model will be published in a Landscape orientation (only this page).

You may change this setting in this step as well. 

Click the Finish button to generate your documentation.
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8.  The Word  document  will  be  opened  as  soon  as  the  documentation  is  generated  with  the  default

program installed locally to handle .doc files (MS Word, Apache Open Office Writer, etc).
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Document Template
Bizagi  Modeler  has  two  predefined  templates  for  the  user  to  choose  from  to  generate  Word

documentation.

BizagiTemplate: this template contains Bizagi's logo, water marks and styles.

ModelerTemplate: this template has no water marks and uses standard fonts.

You can design and define your own template in Microsoft Office Word  to be used when you generate

your Word documentation. 

To customize your own template, take the following steps:

1.  Use one of the default Templates  and amend it as  you  wish  to  establish  your  own documentation

template.

2. Modify your own template.

You may include water marks, new images or modify the styles.

Make sure keep the following styles (you may re-define them): 

bizTitle: Used for the document's title.

bizSubtitle: Used for the document's subtitle.

Normal / ModelerNormal: Used for  general text (i.e,  in descriptions).  It is  used as  the default/normal

style.

bizHeading1: Used by the documentation's title (taken from the file name). Seen in items numbered as

"n".

bizHeading2: Used by the Processes or Sub-Processes chapters. Seen in items numbered as "n.m".

bizHeading3: Used by the Process Elements section. Seen in items numbered as "n.m.o".

bizHeading4: Used by each of the elements. Seen in items numbered as "n.m.o.p".

To modify default styles of the table of contents, modify the TOC1, TOC2, and TOC3 styles.

3. Save the Microsoft Word Document as a Word Template (.dot)  in the path where the Modeler  was

installed. By default this path is:
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C:\Program Files\Bizagi\Bizagi Modeler\Templates

4.  When  you  generate  your  documentation  in  Microsoft  Office  Word,  the  wizard  will  allow  you  to

choose your template from the list.



183Copyright © 2002-2016 Bizagi. All rights reserved.

Publish in PDF
You can publish your completed documentation and share it with your organization in PDF format. 

Customize the  output  information  for  inclusion  in  your  document  by  selecting  the  diagrams  and  the

elements to be included.

Bizagi provides an intuitive wizard to help you through the steps to generate your documentation.

1. On the Publish tab, in the Publish group, click PDF.
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2. Select the Diagrams that you wish to publish. 

Select individually by using the   button or by double clicking them.

Select all by using the   button. 

When all the diagrams you wish to publish are selected, click the Next button.
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3.  Choose the order  in which you wish to publish your  diagrams using the buttons  on  the  right  hand

side. Once finished, click the Next button.
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4. For each diagram select the elements that you wish to publish in the documentation.

You can select all elements across all diagrams using the  button. 
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You  can  also  individually  select  elements  from  each  diagram  using  the    button  or  by  double

clicking them.
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5. For each diagram select the order in which the elements should be exported. 

By default elements are organized according to the sequence of the process flow . 

To move an element from its  default position, select the element and click the  button  until  you

find the desired position.
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Click the  button to order the elements automatically..

When you are satisfied with the order of the elements for each diagram, click the Next button.

6.  Specify the appropriate folder  in which to publish your  process.  This  folder  should  have  Read  and

Write permissions.

By default, the Diagram's model will be published in a Landscape orientation (only this page).

You may change this setting in this step as well. 

Click the Finish button to generate your documentation.



190Copyright © 2002-2016 Bizagi. All rights reserved.

7. The PDF document will be opened as soon as the documentation is generated.

You may customize your PDF output's styles (i.e, font color and sizes, include watermarks, etc).

To  do  so,  edit  the  ModelerTemplate.dot  file  located  at  the  ./Templates/  folder  of  your  Modeler

installation.

For more information about editing styles in this template, refer to Document template.

Publish in Excel
You can publish your completed documentation and share it with your organization in Excel format. 

Customize  the  output  information  to  include  in  your  document  by  selecting  the  diagrams  and  the

elements desired.

Bizagi provides an intuitive wizard to help you through the steps to generate your documentation.

1. On the Publish tab, in the Publish group, click Excel.
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2. Select the diagrams that you wish to publish. 

Select individually by using the   button or by double clicking them.

Select all by using the   button. 

When all the diagrams you wish to publish are selected, click the Next button.
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3. Choose the order in which you wish to publish your diagrams by using the buttons  on the right hand

side. Once finished, click the Next button.
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4. For each diagram select the elements that you wish to include in the documentation.

You can select all elements across all diagrams using the  button. 
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You can individually select elements  from each diagram using the   button or  by double clicking

them.



195Copyright © 2002-2016 Bizagi. All rights reserved.

5. For each diagram select the order in which you wish the elements to be exported. 

By default elements are organized according to the sequence of the process flow . 

To move an element from its  default position, select the element and click the  button  until  you

find the desired position.
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Click the  button to order the elements automatically.

When you are satisfied with the order of the elements for each diagram, click the Next button.

6.  Specify the appropriate folder  in which to publish your  process.  This  folder  should  have  Read  and

Write permissions.

Click the Finish button to generate your documentation.
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7.  The Excel file will be opened as  soon as  the documentation is  generated with the  default  program

installed locally to handle .xlsx files (MS Excel, Apache OpenOffice Calc, etc).
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Excel Output distribution
Each sheet corresponds to a Diagram in the model.

If  within  your  Extended  Attributes  you  have  tables,  each  filled-in  table  will  generate  an  additional

sheet.

The last sheet will display the resources defined in the Model.

The columns within each sheet are as follows;

Process  Sheets:  First  three  columns  correspond  to  the  ID,  Name  and  Description  of  the  selected

elements in Step 4 of the Publishing wizard.

The other columns are the Basic and Extended properties  of each element. When an element does  not

have such property related, the cell will be blank. Values for each cell are:

o When  the  column  is  an  extended  attribute  with  types  Image  or  File  Embedded,  a  link  will  be

displayed with the name of the file.  These files  also published and stored in a  folder  created with

the output within the path selected in step 6: [ModelName]_files\files\attachments.

o When  the  column  is  an  extended  attribute  with  type  File  link,  the  corresponding  link  will  be

displayed with the name of the file. Keep in mind that the file will NOT be part of the publication; it

is located in the path defined in the documentation. 

o When the column is  an extended attribute with type Multiple Selection Options,  the value displayed

will be the selected options separated by a semicolon (;). i.e. USA; France; Germany

o When the  column is  an  extended  attribute  with  type  Table,  a  link  will  be  displayed  referencing

another sheet within the Excel file.

o When the column is  an extended attribute with type URL,  a  link  will  be  displayed  referencing  the

address entered.

o For the other extended property types, the cell will be displayed in General format.

Tables Sheets: This sheets will have the values entered in a determinate extended property with type

Table. When an attribute is  duplicated in many elements,  all the values  will be displayed in the same

sheet.  

o The first column will display the Element ID of the extended property.

o All the table's columns follow the same behavior specified above.
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Resources  Sheet:  First  four  columns  correspond  to  the  ID,  Name,  Description  and  Type  (Role  or

Entity) of the resources defined in the Model. The cell values will be displayed in General format.

Publish to Web
You can publish your completed documentation and share it with your organization in Web format. 

Customize the  output  information  for  inclusion  in  your  document  by  selecting  the  diagrams  and  the

elements to be included.

You may view the Web documentation from a browser.  To review the supported browsers,  refer  to

the system requirements.

Bizagi provides an intuitive wizard to help you through the steps to generate your documentation.

1. On the Publish tab, in the Publish group, click Web.

2. Select the Diagrams that you wish to publish. 

Select individually by using the   button or by double clicking them.

Select all by using the   button. 
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When all the diagrams you wish to publish are selected, click the Next button.

3. Choose the order in which you wish to publish your diagrams by using the buttons on the right hand

side. Once finished, click the Next button.
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4. For each diagram select the elements that you wish to publish in the documentation.

You can select all elements across all diagrams by using the  button. 
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You  can  also  individually  select  elements  from  each  diagram  using  the    button  or  by  double

clicking them.
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5. For each diagram select the order in which you wish the elements to be exported. 

By default elements are organized according to the sequence of the process flow . 

To move an element from its  default position, select the element and click the  button  until  you

find the desired position.
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Click the  button to order the elements automatically.

When you are satisfied with the order of the elements for each diagram, click the Next button.

6.  Specify the appropriate folder  in which to publish your  process.  This  folder  should  have  Read  and

Write permissions.
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Once  the  process  has  been  published  on  the  Web,  you  will  be  able  to  view  your  diagram

documentation.

Web Output
Generated documentation will show your selected processes in an initial Home page.

The description is displayed when the mouse is hovered over each process.
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At any time, you may go into the Full screen mode (specially useful to present or  view wide diagrams)

by clicking on the Full screen icon located at the top right corner:

Exit full screen mode by pressing the Escape key (ESC) or clicking on the Full screen icon again.

Further documentation included will be displayed when clicking over each element.

Click on your process to see the detailed information.

You will be able to see the documentation of any diagram element by clicking on it. 

To exit from the details popup, close it or click anywhere else in the diagram.
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If  you  want  to  access  a  specific  Diagram  form  an  external  location  using  a  Hyperlink  to  open  a

process directly, instead of opening the Home page, open the desired process  and copy the entire

URL. This URL can be used as hyperlink and the process will be opened directly.
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To perform quick searches on the Process Elements, you may use the search field.

Notice  that  while  searching  on  the  Home  page,  you  will  be  by  default  searching  over  all  of  your

processes:
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To search only in a given process, you may quickly first click on that process:

In addition to this, at any time as well, you may use the pan option for  quick navigation in the diagram,
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or use zoom options which appear at the bottom part of the diagram when hovering the mouse in that

zone:
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To go into detail of a Sub-process diagram o to display any of the presentation actions, you may click

on the small icons which appear at the top right corner  of shapes, whenever  the mouse is  hovered on

them:

Presentation actions configured for an element are those same which are set for the presentation

mode:
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If you want to have the process  documentation available to be downloaded and printed from inside

the  Web  documentation,  we  recommend  publishing  first  to  Word  or  PDF  and  then  saving  the

documents in a file server. 

Finally, link the URL path to that Word of PDF document as  an Extended attribute so that it is  shown

in the Web documentation.

Customize styles in Web

Overview
You can customize your Web output styles to adjust to your corporate standard.

Bizagi provides  two ways  to customize the  web  output  colors:  a  basic  customization  where  the  main

colors can be changed, and the advanced css customization.

Basic customization
Once  the  Model  has  been  published  access  the  folder  where  the  output  is  located  and  find  the
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key.json.js file.

Ope the file with a text editor.

Change the useTheme value to true, to enable the customization.

On the bottom of the file you will find the list of styles that can be changed.

Change the style color of the header, the navigation bar and the content panel. Save the file to view the
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changes in your site

The  first  option  of  each  section  is  the  background  color.  The  second  option  is  the  border  of  the

section. The third option (link) refers to the font color.

Advanced css customization
For advanced css users, a .css file is available to customize the styles as you desire.

Once  the  Model  has  been  published  access  the  folder  where  the  output  is  located  and  find  the

key.json.js file.

Ope the file with a text editor.
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Change the useTheme value to true, to enable the customization.

Open the .css file located in libs/css/theme.css and perform the desired changes.
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Publish from the command prompt

Overview
When generating documentation in Web format, you may choose to use  the  command  prompt  (DOS

console) instead of using the graphic wizard to guide you.

Generating documentation from the command prompt is specially useful to:

Reuse the recent settings when last publishing that .bpm file's diagrams.

This  way  you  don't  need  to  reconfigure  which  diagrams  or  shapes  to  include  in  the  documentation,

since Bizagi will use the previous configuration.

Generate documentation in bulk, in an unassisted manner (batch mode).  

This way you can run or schedule the generation of Web documentation outputs for any number of files

with a continue-on-error approach (if one file throws an error, others will be handled separately).

Command line arguments
To publish from the command prompt, use:

"[MODELER_INSTALLATION_PATH]"\BizagiModeler.exe "[BPM_FILE]" /webPublish /
publishPath:"[OUTPUT_PATH]"

Consider:

[MODELER_INSTALLATION_PATH]:  The full path  where  your  Bizagi  Modeler  is  installed.  In  such  path

you will find the BizagiModeler.exe executable file.

Example: C:\Program Files\Bizagi\Bizagi Modeler\Modeler\.

[BPM_FILE]: The name of the .bpm file containing the diagrams to publish. Make sure you include the

full path to that .bpm file and that Bizagi Modeler has access rights to this file.

Example: C:\My Downloads\PurchaseRequest.bpm

[OUTPUT_PATH]: The full path to the directory where you want the output files to be stored (needs  to

be already created).

In this path, Bizagi will additionally leave a PublishLog.txt file with details of the Web publish execution.

Ensure that the user running the console has write access to this directory.
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Example: C:\My Documents\

Notice it is  recommended to set all paths  above inside  of  quotes,  mainly  because  it  is  likely  to  have

your Modeler installed unto a path containing blank spaces.

After  publishing  to  Web  from  the  command  prompt,  details  are  logged  at  [OUTPUT_PATH]

\PublishLog.txt: 

Of  course  you  may  alternatively  choose  to  execute  the  Web  publish  from  the  command  prompt,

while already being inside of the Modeler's installation path:

cd [MODELER_INSTALLATION_PATH]
BizagiModeler.exe "[BPM_FILE]" /webPublish /publishPath:"[OUTPUT_PATH]"

Batch publishing example
Notice  you  may  rely  on  the  command  prompt  options  to  create  a  .bat  that  publishes  Web

documentation for any number of .bpm files.

This is  specially useful when working with a large number  of .bpm files,  so that this  procedure can be

scheduled  and  run  in  an  unassisted  manner  (Bizagi  will  automatically  use  a  continue-on-error

approach).

The following example illustrates this possibility.

Notice that for this example, the Modeler is installed at the default path which is  C:\Program Files\Bizagi

\Bizagi Modeler\Modeler\:
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Web documentation will be generated for  these 4 .bpm files  stored at C:\Downloads\ (as  downloaded

from the Process Xchange):

The .bat file specifies the following command-line options:

"C:\Program Files\Bizagi\Bizagi Modeler\Modeler"\BizagiModeler.exe "Form 20F Management.bpm" /
webPublish /publishPath:"C:\My models"
"C:\Program Files\Bizagi\Bizagi Modeler\Modeler"\BizagiModeler.exe "Onboarding Process.bpm" /
webPublish /publishPath:"C:\My models"
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"C:\Program Files\Bizagi\Bizagi Modeler\Modeler"\BizagiModeler.exe "Recruitment and Selection.bpm" /
webPublish /publishPath:"C:\My models"
"C:\Program Files\Bizagi\Bizagi Modeler\Modeler"\BizagiModeler.exe "Change.bpm" /webPublish /
publishPath:"C:\My models"

Executing this file named as publish.bat results in a successful execution:
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For this specific example, since this .bat is run from E:\Downloads and the .bpm models  are stored in

E:\Downloads as well, the location to these .bpm files do not need to specify the full path.

The  output  path  will  contain  the  Web  documentation  generated  in  separate  folders  for  each  of  the

.bpm files (and a log file of the .bat execution):

Important notes
To publish from the command prompt, make sure you consider:

1. All command-line arguments are mandatory.

2. You will need to ensure that any .bat file you create is consistent.

For instance, for Models having Unicode or special characters  in its  name, you will need to ensure you

save that .bat file supporting those characters.

3.  When  a  model  does  not  have  a  previous  configuration  of  the  publishing  preferences,  Bizagi  will

include all diagrams and elements.

Publish to Wiki

Overview
Generate  your  complete  process  documentation  to  Wiki  format  and  share  it  throughout  your

organization. 

Customize the output information that you want to include in your  document by selecting the diagrams

and the elements that will be contained in it.

Make sure you have MediaWiki installed in your  server  and a user  with publishing rights,  when  you
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generate this documentation.

Please review the versions support

Bizagi provides an intuitive wizard to helps you through the steps to generate your documentation.

1. Go to the Publish tab and select Wiki.  

2. Select the Diagrams that you wish to publish. 

Select individually by using the   button or by double clicking them.

Select all by using the   button. 

When all the diagrams you wish to publish are selected, click the Next button.
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3. Choose the order in which you wish to publish your Diagrams by using the buttons on the right hand

side. When you are finished, click on Next.
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4. For each Diagram select the elements that you wish to publish in the documentation.

You can select all elements of all diagrams using the  button. 
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You can also choose specific elements from each diagram by using the   button or double clicking

them.
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5. For each diagram select the order in which you wish the elements to be exported. 

By default elements are organized according to the sequence of the process flow . 

To move an element from its default position, select the element and click on the  button until you

find the position you want.
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Click on the  button and they will be ordered automatically. 

When you are satisfied with the order of the elements for each diagram, click on Next.

6. The following Information about the Wiki Server will be requested:

Server: URL of your Wiki Server

User and Password: User credentials to access your server. The user must have writing permissions.

NameSpace: To help you differentiate thees  process  articles  from others  that are already published

in your wiki, Bizagi allows you to enter a word that will be set before all the created pages.

Category: To help you organize your  documentation we recommend that you include a category to

group the pages created in your wiki.

Click on Finish  to publish the documentation on the selected server.
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Wiki Output
Once the process  has  been  published  on  your  Wiki,  you  will  be  able  to  see  the  description  of  your

diagrams.
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Click on your process to see the detailed information and elements.

    

You will be able to see the documentation of any shape by clicking on it. 



229Copyright © 2002-2016 Bizagi. All rights reserved.

To perform quick searches on the elements of your  process,  use the contents  table. This  will allow you

to quickly see the information of the shapes including basic and extended attributes.

Wiki version support
We support the following MediaWiki combinations with PHP

Wiki 1.14.x with PHP 5.2.17

Wiki 1.15.x with PHP 5.2.17 and 5.3.10

Wiki 1.16.x with PHP 5.2.17 and 5.3.10 

Wiki 1.17.0 with PHP 5.2.17 and 5.3.10
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   Versions 1.17.1, 1.17.2 y 1.17.3 are not supported

Wiki 1.18 with PHP 5.2.17 and 5.3.10

Wiki 1.19 with PHP 5.3

Wiki 1.20 with PHP 5.3

Wiki 1.21 with PHP 5.3

Wiki 1.22 with PHP 5.3

Settings
To publish both content and images into your Wiki server, make sure:

1.  That the physical upload directory has  permissions  set to allow creation  and  edition  of  pages  and

files.

Similarly,  the images  directory set by  default  as  "C:\Web\[your_mediaWiki_folder]\images\"  should  be

granted with full rights.  

2. That the LocalSettings.php configuration file, contains the following settings: 

$wgGroupPermissions['user']['upload'] = true;
$wgFileExtensions = array('png','gif','jpg','jpeg','doc','xls','mpp','pdf','ppt','tiff','bmp','docx', 'xlsx',
'pptx','ps','odt','ods','odp','odg');
$wgEnableUploads = True;

For MediaWiki version 1.20, use:

$wgGroupPermissions['*']['upload'] = true;
$wgFileExtensions = array('png','gif','jpg','jpeg','doc','xls','mpp','pdf','ppt','tiff','bmp','docx', 'xlsx',
'pptx','ps','odt','ods','odp','odg');
$wgEnableUploads = True;

Publish to SharePoint

Overview
You can publish your  completed documentation and share it with your  organization  in  the  SharePoint

format.

Customize the  output  information  for  inclusion  in  your  document  by  selecting  the  diagrams  and  the

elements to be included.

Make  sure  you  have  SharePoint  installed  when  you  generate  this  documentation.  Bizagi  supports

SharePoint Services 3.0.

Bizagi provides an intuitive wizard to help you through the steps to generate your documentation.

1. On the Publish tab, in the Publish group, click SharePoint.
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2. Select the Diagrams that you wish to publish. 

Select individually by using the   button or by double clicking them.

Select all by using the   button. 

When all the diagrams you wish to publish are selected, click the Next button.
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3. Choose the order in which you wish to publish your diagrams by using the buttons  on the right hand

side. Once finished, click the Next button.
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4. For each diagram select the elements that you wish to publish in the documentation.

Select all elements across all diagrams by using the   button. 
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You can also individually select  elements  from  each  diagram  using  the     button  or  by  double

clicking them.
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5. For each diagram select the order in which you wish the elements to be exported. 

By default elements are organized according to the sequence of the process flow . 

To move an element from its  default position, select the element and click the  button  until  you

find the desired position.
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Click on the  button to order the elements automatically.

When you are satisfied with the order of the elements for each diagram, click the Next  button.

6. The SharePoint Server Information will be required. 

The SharePoint site must already be created.  You need to provide the location and user  credentials  to

access it. Then click the Next button.  
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7.  Specify the  appropriate  folder  in  which  to  publish  your  process.  This  folder  must  have  Read  and

Write permissions. Click the Finish button.
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Once  the  process  has  been  published  on  SharePoint,  you  will  be  able  to  view  your  diagram

documentation.

SharePoint Output

The  legend  displayed  when  the  mouse  is  hovered  over  each  process  is  defined  in  the  Diagram

properties.

All other documentation included will be displayed when clicking over each element.
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Click on your process to see the detailed information. 

You will be able to see the documentation of any diagram element by clicking on it. 

To perform quick searches on the Process Elements, use the search field.
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To go back to the general view, click the Bizagi Modeler Logo.
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Exporting to XPDL

Overview
The XML Process  Definition Language (XPDL) is  a  format standardized  by  the  Workflow management

Coalition (WfMC) to interchange business process definitions between different workflow products.  The

XPDL format can store all aspects  of a  BPMN  diagram,  such  as  attributes,  resources,  etc.  Also  some

graphical information is held, for example the coordinates of the elements positions.    

Bizagi offers the possibility to share your diagrams with others modeling tools that use BPMN notation.

You can export your diagrams to XPDL using the BPMN 2.0 notation shapes. 

For more information about the currently supported XPDL version, refer to Supported standards.

To export your diagrams, follow the steps below: 

1. On the Export/Import tab, in the Export group, click XPDL.

2. Specify the appropriate folder to save your XPDL file, this folder need Read and Write permissions. 
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3. After export to XPDL format, you will be able use it in any program that supports this format. 

4. You can also import a diagram in XPDL format into Bizagi Modeler. 

Click to learn more about importing a diagram from XPDL

Exporting diagrams as Image

Overview
Bizagi Modeler allows you to export your  diagrams as  images,  to be opened with any graphic editor,

in the following formats: PNG, bpm, SVG or JPG.

To export your diagrams as images follow these steps. 

1. On the Export/Import tab, in the Export group, click Image.
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2. Select one of the image formats;  namely, PNG, bpm, SVG or  JPG.  Specify the appropriate folder  to

save your image.  This folder need Read and Write permissions. 
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3.  Click  the  Save  button.  Once  the  diagram  has  been  exported,  you  will  be  able  to  see  it  in  any

graphical editor. 
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Exporting to Visio

Overview
Bizagi Modeler  allows you to export your  diagrams to Microsoft  Visio  using  the  BPMN  2.0  notation

shapes. 

Bizagi supports Visio 2003, 2007 and 2010.

Make sure you have Microsoft Visio installed when you export your diagrams.

To export your diagrams, follow the steps below:

 

1. On the Export/Import tab, in the Export group, click Visio.
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2. Specify the appropriate folder to save your Visio file, this folder need Read and Write permissions. 

Click the Save button.
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Once the process has been exported to Visio, you will be able to edit and manage  the diagram using

the Visio BPMN stencil.  
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Exporting to BPMN

Overview
Bizagi offers the possibility to share your diagrams with others modeling tools that use BPMN notation.

You can export your diagrams to the BPMN 2.0 xml format. 

To export your diagrams, follow the steps below:

 

1. On the Export/Import tab, in the Export group, click BPMN.
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2. Specify the appropriate folder to save your BPMN file, this folder need Read and Write permissions. 

Click the OK button.
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3.  A  message  will  confirm  the  export  and  a  folder  containing  the  diagrams  will  be  created  in  the

specified location.

4.  After  exporting  to  BPMN  2.0  xml,  you  will  be  able  use  the  file  in  any  program  that  supports  this

format. 

You  can  also  import  a  diagram  in  BPMN  format  into  Bizagi  Modeler.  Click  to  learn  more  about

importing a diagram from BPMN
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Documentation Portal

Overview
A Documentation  portal  is  a  shared  repository  where  people  within  an  organization  can  access  the

company's processes and related documentation. 

The following articles  will illustrate how to organize  your  company's  processes  using  Bizagi  Modeler.

With a simple click users can navigate between various  levels  of detail,  from a global view to the most

detailed information of the organization's processes. 

The Documentation Portal can be created in your intranet (a file server  as  a  shared folder) or  any Web

portal. Just click the Publish to Web feature.

It can also be published in SharePoint or Wiki. 

Your  portal must have an structure and hierarchy that aids  its  navigation. The images  bellow show an

example of this structure:

The highest level displays the functional areas and useful links. 

The next level shows the processes related to an specific area. 
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The lowest level shows the process diagrams and their documentation.

Click here to see an example of a Documentation Portal

How to create a documentation portal
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1. Define the structure of processes
A  defined  structure  establishes  the  hierarchy  of  organizational  areas  and  clarifies  how  different

processes  of  the  business  are  classified  and  interrelated.  In  addition  to  the  global  structure,  it  is

necessary to define the information to be published and the way in which it will be presented.

Classification and hierarchy of processes

Processes are classified into a hierarchy of categories.  Each category represents  a  company, area, sub-

area, process or any other grouping you define. 

For  example, in a  completely flat organizational structure, if you  classify  your  processes  according  to

areas it will result in 2 levels. The first will represent areas and the second the processes.

The  first  level  will  have  as  many  categories  as  areas  in  the  organization  (each  area  represents  a

category in level 1).  The  second  level  will  have  as  many  categories  as  processes  in  the  organization

(each process represents a category in level 2).

The  structure  and  number  of  levels  depends  on  the  layout  of  each  organization  and  its  particular

preferences.  As shown, some organizations  classify their  processes  according to areas  and sub-areas

(Human  resources,  Sales,  Marketing  etc).  Process-oriented  organizations  tend  to  follow  mapping

structure of the ISO 9000 standards  and so classify their  processes  according  to  operational  function

within the business (strategic processes, operative processes and support processes).

Defining  the  most  suitable  structure  is  essential  to  provide  users  an  intuitive  and  logical  navigation

through the processes of your organization.

Information of each element

The information to be presented must be planned in advance. For  each level  define  what  information

should be displayed and how it will be accessed by final users.

The  correct  implementation  of  this  step  will  facilitate  understanding  of  processes  within  your

organization and ensure proper communication between them.

2.  Create the Portal  
Once the general structure of processes  has  been  defined,  you  can  proceed  to  organize  it  in  Bizagi

Modeler.  The key is  to translate the structure previously defined into an interface that allows  users  to

easily navigate through the processes information.
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In the Documentation Portal each category is  represented by a  page  (or  tab).  On  each  page  you  can

define the information for display and the user interface. 

Create the Main page

The main page is  an overview of the processes  areas  within the  organization.  From  here  viewers  can

access company-related information and any of the pages in level 1.

Icons  to access  level 1 pages  are  included  as  reusable  sub-processes.  This  way  it  is  possible  to  link

each icon to the corresponding page. 

Additional information can be added by using Artifacts.  Aside from improving the look and feel of the

page these elements allow you including links to other sites, pictures and documents.  

Create category pages

Recall that a  level is  composed of categories,  where each category is  displayed by means  of  a  page;

consequently a level comprises as many as there are categories.

Each category page is  created in the same way as  the main  page,  apart  from  the  user  interface  and

information  it  displays.  Use  the  reusable  sub-process  to  represent  the  categories  and  incorporate

artifacts to include additional information and improve the look and feel.



255Copyright © 2002-2016 Bizagi. All rights reserved.

Information of elements 

Once the pages have been designed, it is  necessary to configure the information that each Artifact will

display upon selection.

To customize the  information,  make  use  of  Extended  attributes.  These  attributes  can  include  links  to

another sites, images and documents, to name a few.  

Link the menus

Once all the levels have been built, link the categories with their associated level.  Associate the diagram

(page) from the properties of the corresponding sub-process that represents the category..
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3. Publish the portal to Web format
Once the portal has  been built in Bizagi  Modeler,  the  final  step  is  to  publish  it.  Use  the  Web  Publish

option to define the diagrams and information to be published. 

Click here to see an example of a Documentation Portal

Creating a Documentation Portal (step by step)

Overview
In the following example we will build a documentation portal step by step. 

Let us suppose that the Agility Corp has diagrammed and documented the following processes:

Recruitment and selection

Expenses report

Help desk

Travel request

Access management

Vacation leave request

Accounts payable

Purchase request

In order for processes to communicate and share all their  related documentation, the Agility Corp has

opted to build a documentation portal. All business  processes  are diagrammed in Bizagi Modeler  and

stored in a single .bpm file.

http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html


257Copyright © 2002-2016 Bizagi. All rights reserved.

Click here to see the Web output of this Portal

Download here the complete Documentation portal in .bpm format

1. Defining the structure of processes

Classification and hierarchy of processes

Agility  Corp  concluded  that  the  easiest  and  most  convenient  way  to  classify  its  processes  would  be

according  to  the  area  in  which  they  are  performed.   Based  on  this,  the  following  classification  was

established:

Area Process

Human Resources Recruitment and selection

Travel Request

Vacation Leave Request

Financial Expenses report

Accounts payable

Purchases Purchase request

IT Help Desk

Access Management

Note  this  gives  a  two-level  classification;  the  first  denotes  the  functional  areas  and  the  second  the

business processes.

The first level comprise of has four categories (each area represents a category of level 1).  The second

level contains eight categories (each process represents a category of level 2).

Level 0 is used to represent the highest level of hierarchy, in this case, the global view of the company.

Information of each element

In this  step we  have  to  define  what  information  has  to  be  displayed  at  which  level.  The  Agility  Corp

wants different levels of information sharing:
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Level 0: Company Level

FAQ: Frequently asked questions about the company

Manuals:  Documentation on how to use the portal

Contact information: Details of the company contact person if required.

Help: Links to company resources.

Level 1: Areas Level

Area description: A brief overview of the area and its functions.

FAQ: Frequently asked questions about the area

Manuals: Documentation setting out the structure and responsibilities of the area.

Contact information: Details of the contact person for the area, if needed.

Help: Links to area resources.

Level 2: Processes Level

This level will only contain the information of processes.

2.  Creating the Portal in Bizagi Modeler 
Now that the Agility Corp  has  structured  its  processes,  we  can  proceed  to  build  the  Portal  in  Bizagi

Modeler.

Creating the main page

The first step is to create the page associated with the Level 0 global view (Main page).  On this  page,

the  Agility  Corp  wants  to  show the  different  functional  areas  and  some  general  information  on  the

organization:

Company logo

FAQ

Manuals

Contact information

Help

The main page should look like this:
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Follow the next steps to create the page:

1. Create a new diagram.

2. Remove the Pool shape and include the categories  of Level 1,  in this  case, four  sub-processes. Give

each the name of the area it represents.
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3.  Use  image  artifacts  to  insert  the  company  logo  and  add  icons  to  represent  the  FAQs,  Manuals,

Contact us and Help. 



261Copyright © 2002-2016 Bizagi. All rights reserved.

4. Customize the appearance of the page using the  different  options  and  elements  that  Bizagi  offers

such as modifying shapes colors, using making use of grouping, changing font types etc.

Creating category pages 

The next step is  to create the level’s  pages. In our  example, we have two levels.  As  the lowest level  is

composed of the processes  already diagrammed,  we  only  have  to  create  the  pages  associated  with

level 1.

As  level  1  is  comprises  four  categories,  we  create  four  pages,  one  for  each  category:  Human

Resources, Financial,  Purchases  and IT.  On each page the Agility Corp wants  to  display  the  processes

associated with the category (area) and the  following general information about the area:

Area description

Company logo

FAQ

Manuals

Contact information

Help
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In the section bellow we illustrate how to create the page related to the Human resources category. The

remaining three pages are built in the same way.

1. Create a new diagram and name it as the category. Human Resources. 

It may help to include numbers or codes to more easily identify to which level the diagram belongs. 

2. Right-click the diagram and open its properties. Enter a description of the area.
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3. Remove the Pool shape and include three sub-processes  to reflect categories  of Level 2.  Give each

the name of the process it represents.

4.  Use image artifacts  to insert the company logo and include icons  to  represent  the  FAQs,  Manuals,

Contact us and Help. 
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5. Add a Header  artifact to include information related to the area. Note the header  information is  the

included in the diagram properties.

6.  Customize the appearance of the menu using the different options  and  elements  that  Bizagi  offers

such as modifying shapes colors, using making use of grouping, changing font types etc.
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Information of elements 

Once the structure of the pages has been configured we can continue to define each page element will

displayed upon selection.

Since we used artifacts  (Faqs,  Manuals,  Contact  and  Help)  we  can  customize  the  properties  of  these

objects to show the information required.

For  instance, when viewers  select the  Manuals element in the main page, three different manuals  must

display. To do that we create a table type extended attribute. 

Do the following to customize the information displayed in this artifact:

1. Right-click the artifact and select properties.
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2. In the Extended tab click Add new extended attribute

3. Assign the attribute name and description and select Table as the type.
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4. Define the columns to be displayed in the table. Click the (...) icon in  the  columns  field  and  set  the

necessary ones.

5. Next add the information to be displayed, in this case, the instruction manuals.
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6. Repeat this procedure for all elements on all pages.

Linking the pages

Once all pages  have been created, the next step is  to link them taking into account their  interrelations

and  hierarchy.  As  we  saw,  categories  are  represented  by  sub-processes.  In  order  to  connect  them,

these sub-processes  have to be converted into reusable sub-processes. This  way we can easily  select

the related diagram (page) from the sub-process properties.

Bellow we will connect the Main page with the functional areas pages.

1. Right-click a category (in this example an area) and convert the shape into a reusable sub-process  as

shown below.

The shape borders will widen.
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2. Right-click the category again and open its  properties.  From the Process field select the diagram to

be linked.

In this way,  when users click the shape in the Work Portal the associated diagram will open.

Repeat this procedure to link all the diagrams to pages in the Portal.

3. Publish the portal to web format
Once built,  the Documentation Portal can be exported to the Web as  a  HTML file to  share  with  other

users within the organization.

To publish your Portal, do the following:
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1. On the Publish tab, in the Publish group, click Web.

2. Select the diagrams you wish to publish.

Select individually by using the   button or by double clicking them.

Select all by using the   button. 

When all the diagrams you wish to publish are selected, click the Next button.
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3. Choose the order in which you wish to publish your diagrams by using the ordering buttons on the

right-hand side. Once finished, click the Next button.
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4. For each diagram select the elements that you wish to publish in the documentation and click Next.
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5. Specify the appropriate folder  in which to publish your  process.  This  folder  should  have  Read  and

Write permissions.
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Once the process has been published on the Web, you will be able to view your Documentation Portal.

Click here to see the Web output of this Portal

Download here the complete Documentation portal in .bpm format

http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Web%20output/index.html
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
http://download.bizagi.com/docs/agile/en/Agility%20Corp%20process%20documentation.bpm
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Cloud Collaboration

Overview
Optimizing processes  is  a  team  effort.  And  the  most  successful  teams  are  those  who  can  contribute

effortlessly to their goals in a modern way – unrestricted by time or geography.  

Bizagi's new Cloud Collaboration Services gives your team the power to work together, smarter. 

This section is designed to provide everything you need to know to get started in Bizagi Cloud. 

How does this affect Bizagi Modeler? 
The short answer: it doesn’t:

Bizagi Modeler remains freeware with its own On premise collaboration features. 

Every Bizagi user is  automatically entitled to a cloud Personal  plan  and  can  save  models  in  Bizagi

Cloud, free, up to 10MB.

Should you want to take advantage of our teamworking features,  (sharing,  editing,  discussions)

then you will need to buy a subscription. Otherwise, everything remains free.

Benefits of Bizagi Cloud Collaboration Services:
With a subscription, you can:

Gain global access to all your models

You models  and  all  associated  documentation  are  stored  in  Bizagi  Cloud.  This  secured  cloud-based

central repository enables you to access and edit them anytime using Bizagi Modeler and all its power.

Work offline

Business Analysts are regularly on the go. Moving fast from costumer to customer, they need to model,

take notes, add attachments  and perform updates  in a  hurry.  But companies  don’t necessarily provide

Internet connection to outsiders.  That’s  why, in this  latest release, Bizagi lets  you work offline and then

synchronize the changes made to the collaborative design.

Models  can  be  edited  (i.e.  change  process  flow,  include  documentation)  exclusively  from  Bizagi

Modeler desktop.

Stay productive from any device

In Bizagi Cloud, you can work on your processes anytime, anywhere, any device - without the restriction

of location or time zone.

Work as a team and improve business collaboration

Capture  process  knowledge  by  sharing  your  processes  to  drive  out  inefficiencies,  improve  business

operations and improve communications.

Through our secure cloud process repository, multiple people in dispersed geographical locations  can

work on the same projects simultaneously without duplication of time or effort.

Obtain fast results

With powerful collaboration tools,  changes  are updated  dynamically  so  everyone  in  the  team  is  kept

up-to-date about the current status of any process model.

Post comments and share ideas

Real-time comment boxes  make it easy to review diagrams or  specific tasks  and  leave  comments  for
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others to action.

Lessen the learning curve

Bizagi Modeler  presents  a  user-friendly interface that makes  process  modeling easy to learn for  both

business and IT users.

Include attachments

Attachments  add  context  to  processes  and  can  give  explicit  examples.  In  Bizagi  Cloud,  you  simply

upload once and reuse attachments between processes.

How does it work

Sign  in  to  Bizagi  Cloud

and  start  managing

your models.

Cloud Basics.

Using  offline

capabilities,  you  can  

check  out  your  process

model,  make  changes,

and  sync  it  once  you’re

back online.

Offline  Cloud

Collaboration.

Add roles to users.

Editors have full access

to the process model,

Contributors can

navigate  and post

comments.

User roles.

Share  your  uploaded

models  with  your  team

members or clients.

Sharing a model.

Navigate your Bizagi

Cloud to view all models

stored in the repository.

Bizagi Cloud website

Add  attachments  to

your  diagrams  and

share  them  between

processes.

Attachments  in  the

Cloud
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Manage  your  process

models  any  time,  any

place,  any  device  in

Bizagi Cloud.

Managing Cloud

Models.

Take  a  look  at  our  

pricing  packages  to

decide  what’s  right  for

you.

Account,  Pricing  and

Billing Info

With  Editor  rights,  work

on  your  processes  as

you  usually  do  from

Bizagi Modeler desktop.

Editing Cloud models.

Cloud basics

Overview
Every Bizagi account automatically entitles  the user  to  a  Personal  plan.  Here,  users  can  securely  save

their models secure in Bizagi Cloud, for free, up to 10MB. To collaborate (share models with teammates

or clients) it is necessary to purchase a Subscription to our Cloud Collaboration services. 

When you store your models in Bizagi Cloud you can access them anytime, anywhere. 

Remember that once a model is uploaded, it will no longer be related to the model stored locally.

You can access  Bizagi Cloud from Bizagi  Modeler  desktop  application  or  from  Bizagi  Cloud  website.

Each one offers different possibilities to handle model uploaded to the Cloud. 

Bizagi Modeler is  the  exclusive  space  where  you  design  your  cloud  processes:  edit  process  flow,

add  documentation,  roles  and  simulate.  It  is  from  Modeler  that  you  can  upload  models  to  Bizagi

Cloud. 

Bizagi  Cloud  website  allows  you  to  browse  (process  flow  and  documentation)  and  comment  on

models,  diagrams and shapes. The Bizagi Cloud website is  the space to  purchase  and  manage  the

subscription to Bizagi Cloud Collaboration services.
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If you want to save your  models  in Bizagi Cloud you need  an  active  Bizagi  account.  To  learn  more

visit How to subscribe to Modeler in the Cloud.

Bizagi Cloud Features
The following table describes  what you can do from the Desktop  version  and  what  you  can  do  from

Bizagi Cloud website.

Feature Modeler

desktop

Bizagi Cloud

website

User  profile

management

Authentication

Edit user profile -

Sharing models Share a model

Manage access rights to models

Collaboration View,  add  and  reply  to  comments  in

models, diagrams and shapes

Lock diagrams for editing -

Release diagrams -

Real time notifications

Model Management Create a new cloud model -

Upload  an  existing  model  to  Bizagi

Cloud

-

Edit model properties

Review a diagram (process flow)

Review documentation  (diagram  shapes

and extended attributes)

Edit process flows in diagrams -

Edit documentation -

Search models -

Manage attachments from Cloud storage -

Delete shared model -

Learn how to

Upload and save a model in Bizagi Cloud
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Edit a model saved in the Cloud.

Delete a model saved in the Cloud

Sign in to Cloud
You can access Bizagi Cloud from Bizagi Modeler  desktop application (Bizagi Modeler) or  from Bizagi

Cloud website. To access Bizagi Cloud just sign in using your Bizagi credentials.

Signing in from Bizagi Modeler in your desktop
1. Open Bizagi Modeler. Enter your Bizagi credentials in the pop up window and click Login.

2. Your name will be shown where the Sign in link was located.
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Alternatively, select the Sign in link in the upper right corner of the screen:

Signing In from the cloud
1. Open the Bizagi Cloud Website

2. Sign in with your Bizagi credentials.

https://model.bizagi.com
https://model.bizagi.com
https://model.bizagi.com
https://model.bizagi.com
https://model.bizagi.com
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Uploading or saving models to Cloud

Overview
Every model stored in Bizagi Cloud needs  to be created using Bizagi  Modeler  and  then  uploaded  to

your account. You have two options to upload models: 

Upload a model that has been previously stored locally in your desktop

Save a new model directly in Bizagi Cloud

For more information about creating models click here,

Upload an existing model that is initially stored locally
In order  to upload to  your  account  an  existing  model  that  is  stored  in  your  local  machine  (or  a  file

server) follow the next steps:

1. Sign into Bizagi Cloud. 

2. Open your local model clicking File > Open > Computer. 

Use the Browse button if your desired model is not in the Recent models list.
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3. Select your desired model and click Open.
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4. Click Save as from the Bizagi Cloud ribbon. 

This will redirect you to the Save as option found in the File menu.

5. In the File menu select Save option within Bizagi Cloud section.
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6. Enter a name for the model and a description (Optional). 

If  the  model  was  saved  locally  Bizagi  gives  the  same  name.  You  can  keep  the  current  name  of  the

model or change it.

Upload the model by clicking Save.



286Copyright © 2002-2016 Bizagi. All rights reserved.

6. Wait for the model to be uploaded.

7. When the model is uploaded, a window will display. Select OK to continue.
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Bizagi uploads the model including its inner  diagrams, and the File type Extended Attributes, which are

uploaded as  Cloud Attachments,  Due to security requirements,  the following extension files  cannot  be

uploaded to Bizagi Cloud.

File

extensio

n

File type

File

extensi

on

File type

.ade Microsoft Access project extension .msc Microsoft Common Console document

.adp Microsoft Access project .msp Windows Installer update package file

.bat Batch file .mst Visual Test source files

.chm Compiled HTML Help file .pif Shortcut to MS-DOS program

.cmd Microsoft Windows NT command

script

.scr Screen saver

.com Microsoft MS-DOS program .sct Script file

.cpl Control Panel extension .shb Windows shortcut

.exe Executable file .sys System File

.hta HTML program .vb Microsoft Visual Basic Scripting Edition

(VBScript) file

.ins Internet Naming Service .vbe VBScript Encoded Script file

.isp Internet Communication settings .vbs VBScript file

.jar Java Archive file .vxd Virtual Device Driver file

.jse JScript Encoded script file .wsc Windows Script Component

.lib Physical File Library .wsf Windows Script file

.lnk Shortcut .wsh Windows Script Host settings file

If there is  a  file with any of the extensions  above, Bizagi will display a warning. Click on Yes to  upload

the model avoiding these files or No to cancel the whole uploading.



288Copyright © 2002-2016 Bizagi. All rights reserved.

The structure presented is Diagram > Task > File Name.

8. As soon as  your  model is  uploaded it will be shown in Read-only mode. This  is  because all models

stored  in  the  Cloud  are  ready  to  be  shared.  And  all  shared  models  have  a  check-in/check-out

functionality that allow editors to prevent users overwriting changes made by another user.
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If you want to edit your  model,  you must check it  out.  For  further  information  read  the  article  Editing

Cloud Models.

From now on, your model will be saved in the cloud.

Every change performed by anyone on your team will be displayed in the Notifications area. 

The local file you just uploaded won't be changed and you can keep it without any modification.

Editing Cloud Models

Overview
The  ability  to  edit  process  flow  and  documentation  (description,  Extended  attributes,  Resources)  is

exclusively  available  through  Bizagi  Modeler  desktop.  It  can  only  be  performed  by  those  with  Editor

permissions over the Model.

You can open a model stored in the Cloud using Bizagi Modeler and edit it as you always do.

You  can  view a  model  stored  in  the  Cloud  through  a  browser  with  your  Bizagi  Cloud  account,  and

launch Bizagi Modeler desktop to edit it.
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All models stored in the cloud use a Check-in / Check-out Diagram functionality that prevents users  from

overwriting changes in a single diagram. When a model is shared, all its diagrams are locked (checked-

in) for edition. 

To  change  a  process,  check-out  the  diagram  and  make  the  adjustments  (only  available  from  Bizagi

Modeler desktop). 

As  soon as  it is  checked-out it  will  automatically  be  unavailable  for  other  users  to  edit.  All  users  will

receive a notification that the diagram is checked out, plus the name of the user who checked it out. 

All users sharing the diagram can still view documentation and make comments, but will not be able to

change the flow or documentation. 

When changes are finished click Check In. This will release the diagram from any other user to edit it.  All

users will be notified that the diagram is available for editing.

If you have Editor's permissions over a model and you want to edit a diagram do one of the following:

Open the Model using Bizagi Modeler desktop.

Open the Model using Bizagi Cloud Website and launch Modeler desktop

Edit a diagram using Bizagi Modeler 
User with Editor access can open diagrams stored in Bizagi Cloud, and edit them as they require.

To edit a diagram:

1. Open Bizagi Modeler. Click in File tab.

2. Go to Open and select Bizagi Cloud. Then click on Browse.
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3. If you are not signed in, the Sing in window will display. Use your valid credentials  to Sign In to Bizagi

Cloud.

4. Once you log in, the Open Model window will be displayed.

5. Select the diagram that you want to edit. 

On selecting the diagram, a  warning will display. The diagram cannot be edited, because it is  in Read

only mode.
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6. In the Ribbon, click Check Out.  Once you click this  button, the diagram will be locked for  editing. No

users can now make changes.

This action can also be performed from the link displayed in the yellow bar under the Ribbon.

Your colleagues watching the diagram in Bizagi Cloud will automatically receive a notification to say that

the diagram has been checked out.

7. Edit your diagram.

8. Once you finish your  changes, simply release the diagram by clicking the Check In button. By  doing

this, the diagram will released to other Editors to perform changes.

Your colleagues watching the diagram in Bizagi Cloud will receive a notification to say that the diagram

has been checked in.
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Check Out Diagram and Check In Diagram buttons  will only Lock/Unlock the diagram itself,  not the

whole model.

Always check in your diagram once you're done so that others can make changes. If you don't,  the

diagrams will remain in Read Only mode.

On closing  Bizagi  Modeler,  you  will  receive  a  prompt,  asking  you  to  release  any  diagrams  that

you’ve checked out. Hit OK to automatically check them in. 

Edit a diagram from Bizagi Cloud Website
When a  user  views  a  model/diagram  via  browser  and  has  Editor  access,  he/she  is  able  to  edit  a

diagram through Bizagi Modeler.

1. To edit a Model, click Edit in Bizagi Modeler ( ) icon located in the bottom of the model you want to

edit. When you place the mouse over the icon it will be highlighted.

This button is also available in the workspace of your model at the right side of the toolbar.
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This button is  available in any diagram. In this  case, Bizagi Modeler  will open the directly the diagram

and you can skip step 3.

2. Once you click on the icon, Bizagi Cloud will prompt to have  Bizagi Modeler  installed in order  to edit

models. If you don't have Modeler installed, you can click the link to download it.

If you have Modeler installed click OK.
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3. Bizagi Modeler will launch. Select the diagram you wish to edit. 

When you chose the diagram to be edited, a  bar  over  the diagram will be displayed warning that this

diagram cannot be edited because it is in Read only mode.
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4. In the Ribbon, click Check Out. Once you click this  button, the diagram will be locked for  editing. No

users can now make changes.

This action can also be performed from the link displayed in the yellow bar under the Ribbon.

Your colleagues watching the Diagram in Bizagi Cloud will automatically receive a notification warn them

that the diagram has been checked out.

5. Edit your diagram. 

8. Once you finish your changes, release the diagram by clicking the Check In button. By doing this,  the

Diagram will released to other Editors to perform changes.

Your colleagues watching the Diagram in Bizagi Cloud will automatically receive a notification warn them

that the diagram has been checked in.
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Model properties
You can change the name and description of any model,  either  via  the Bizagi Cloud website or  Bizagi

Modeler. This properties can only be changed by Editors.

From Bizagi Cloud website
1. Locate the Properties button, this button can be found in the model box, or in the Model's toolbar.

2. The properties window will display. You can change the name and the description here.
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3. Click Save to apply changes, otherwise, click on Cancel.

From Bizagi Modeler
1. Follow steps 1 to 4 in Edit a diagram using Bizagi Modeler section. 

2. Locate the Model Properties button in the Ribbon, within the Bizagi Cloud section, and click on it.

3. The properties window is displayed. Change the name or the description here.
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4. Click on Save to apply changes, otherwise, click on Cancel.

Deleting a Cloud Model

Overview
You can delete models and diagrams stored in the Cloud anytime to organize your model's list or free

up your plan's quota.

This procedure cannot be undone. Therefore we strongly recommend that you save a local backup of

the model or diagram to be deleted.

Bear the following guidelines in mind when using the Delete facility:

Models can be deleted from the Cloud website exclusively.

A process model can only be deleted by its owner.

A model cannot be deleted when it has one or more locked diagrams (by any user).

Diagrams can be deleted from Bizagi Modeler exclusively

Editors and Owners can delete Diagrams of a Model from Bizagi Modeler.
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Deleting a Model
In Bizagi Cloud, model owners can delete their models using trash can icon.

1. Click the Delete ( ) icon located in the bottom of the modeler's box. When you hover  over  the icon it

will highlight.

2. Once you click on the icon, Bizagi Cloud will prompt a warning message. Click on Delete Model button.
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3. After clicking Delete Model,  your  model will no longer  be available to edit or  comment. If the model

was shared, neither Editors or Contributors will be able to access it.
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Deleting a diagram
Users with Editor access can delete diagrams of models shared through Bizagi Modeler:

1. Open the Model where the diagram to delete is located (using File > Open > Bizagi Cloud). 



303Copyright © 2002-2016 Bizagi. All rights reserved.

2. Select the diagram that you want to delete. 
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3. In the diagram's tab, right click on the tab and click Remove.

4. Once you click Remove, Bizagi Modeler will prompt a warning message. Click Yes.

Users  sharing the model will receive a notification  warning  that  you  delete  the  diagram.  They  will  no

longer be able to access it.
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Sharing and collaborating

Overview
Today’s dispersed and mobile teams want access to their processes 24/7. Bizagi Modeler gives you the

freedom to collaboratively manage your  processes  online, whenever  and wherever  you happen to be.

Start the collaboration process by sharing your  Models  with your  team members  or  clients.  Sharing a

model  allows  users  to  log  in  to  Bizagi  and  access  it  based  on  their  permission  level  -  Editor,  or

Contributor - at any time.

To share a model you need to purchase a subscription to our Cloud Collaboration Services, and buy as

many licenses as you need according to the access type you want for the invited users. When you share

a model you automatically become the owner. 

You can share a model if you have free licenses  in your  subscription. Once an invitation is  sent,  Bizagi

will allocate a license to the user invited.

Review who can access  any model,  and  their  permission  levels,  by  clicking  the  Sharing  icon.  You  can

remove a person from sharing, or change their permission level, at any time.

Share your model using Bizagi Cloud Website.

Share your model using Bizagi Modeler desktop.

Sharing a Model from Bizagi Cloud website
From Bizagi Cloud website you can add or remove users and edit their access rights. 
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1. Click the Sharing button. A new window to Share Model will display. 

2.  If the model is  currently shared, you'll see a list of users  with their  respective permissions,  and  can

add new users if desired.

Share a Model using Bizagi Modeler 
From Bizagi Modeler you can add or remove users and edit their access rights, for any Model stored in

Bizagi Cloud. The options for sharing a Model are located in the Share option. 

1. Open Bizagi Modeler.

Open the diagram you want to share (Click in File tab > Open > Bizagi Cloud, > Browse). 

2. Click in Share option located within Cloud Collaboration group in the Home tab of the Ribbon.

3. A new window to Share Model will display. 

If the model is currently shared, you'll see a list of users  with their  respective permissions, and can add
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new users if desired.

Share Model window displays two tabs: Invite Collaborators tab displays the list of the users that have

accepted the invitation to collaborate and the Pending Invitations tab displays a list of the users

invited that have not yet accepted.  

If  you  need  to  free-up  a  license  to  be  able  to  share  your  model  with  more  people,  consider

removing a user that has not accepted your invitation.

Adding users for sharing
1. In the Share Model window; type in the email address/es  of the people you want to share the model

with. You can include several emails at the same time to invite people with the same permission level.  If

your collaborators' list is not empty, you need to click on Add collaborators button in order  to add new

users.

2.  Select the access  type (permission level) in the drop-down list:  Editor  or  a  Contributor,  and  add  a

note if desired. Refer to Sharing Permission levels for more information.
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3.  Click  Invite.  Bizagi  Cloud  will  send  an  email  to  the  invited  users  to  start  to  collaborate.  When  the

invitation is sent, the user with his/her permission level will be added to the list displayed within Pending

Invitations tab.

4. Finally, click Close to go back to your Model.
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When the user accepts your  invitation to share, he/she will be added to the list displayed within Model

Users tab.

Changing users' Permission Level
The model's owner has the ability to remove others or change their permission levels. 

1. Click the Sharing icon. The Invite People to Model form appears, and will display the shared users list.

Locate the user that you would like to change and expand Access drop-down list.

2. Select a new permission level from the drop-down list. 

Click Close. The access right for the selected user is changed.

Removing users for sharing
The model owner has the ability to remove others or change their permission levels. 

Removing users from a specific model
This is useful when you want to remove a user for sharing in a specific model.

1.  Click the Sharing icon on the model.  The  Share Model window appears,  and  will  display  the  shared

users list.

Locate the user that you'd like to remove.

2. Click the Delete icon. The user will be removed from the model and will no longer be able to open it.
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Removing users from collaborators' menu
Collaborators menu lists  the users  with whom you have  shared  models  to  collaborate;  per  each  user,

you can see the models shared as Editor and as Contributor.

This is useful when you want to revoke the access to all the models of a  user,  removing one by one the

models of the selected user.

1. Click on your Name (or email) and then, click Collaborators.
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2. Locate the user that you'd like to revoke user privileges from model(s). Then click on the Revoke icon. 
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Sharing permission levels
Every  Bizagi  account  automatically  entitles  access  to  a  Personal  plan  where  they  can  securely  save

models in Bizagi Cloud, for free, for up to 10MB. 

To collaborate (share models with teammates or clients) it is  necessary purchase a Subscription to our

Collaboration Cloud services. 

Bizagi Cloud has three types of permission levels that determine the features  available to any individual

within a particular Model.

A subscription is required for Editors and Contributors.

The permission levels available in Bizagi Cloud are:

o Personal:  Each  member  of  Bizagi  Community  can  use  Bizagi  Cloud  for  Free.  This  level  has  no

collaboration features and a 10MB of storage limit.

o Editor:  An  Editor  has  full  access  rights  to  a  model,  except  for  granting  access  rights  and  for
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deleting models. Editors can change the process  flow, change the Model's  properties  and include

documentation, using Bizagi Modeler application for desktop.

The  owner  of  the  Model:  is  also  an  Editor.  The  owner  is  the  manager  of  a  Workgroup  that

administers  all  shared  models  and  the  subscription  of  all  invitees.  The  Owner  needs  an  Editor

subscription for him/herself to be able to share. Owners  have full access  control over  their  shared

models,  including allocating access  rights  (sharing, un-sharing to users) and deletion  through  the

Cloud website

o Contributor:  A Contributor  is  able  to  navigate  through  diagrams  and  review documentations  as

well as comment on any diagram or model, using a browser and a device of his/her choice. 

User role Plan View Edit Comment Delete Share
Manage

users

Storag

e (Mb)

Editor
Personal - - 10

Workgroup - - - 100

Editor (being the

owner)

Workgroup
100

Contributor Workgroup - - - - -

To share a model, you need to purchase a Workgroup plan for yourself and for  those you want to

share  with.  Add  the  appropriate  subscriptions  for  the  people  you  want  to  collaborate  with,

according to the access  you want for  each  one.  Remember  you  need  an  Editor  subscription  for

yourself.

Even if you are the owner of a Workgroup plan, when other users invite you to collaborate on their

models, they can assign either an Editor or Contributor subscription for you on their models.

Unless  you purchase a Workgroup plan,  you  will  be  in  a  Personal  plan  for  yourself.  Even  if  you

have Editor  subscriptions  assigned to you in other  Workgroups,  you  won’t  be  able  to  share  the

models created by you, and your quota will be 10MB.

If you want to share models of your own, you need to purchase an Editor  subscription for  yourself

and the appropriate subscriptions  for  the people you want to  collaborate  with,  according  to  the

access you want for them.

For  every Editor  subscription you purchase for  your  plan, you will gain 100MB of storage for  the

Workgroup. 

If you are in Personal plan and only need additional storage than the 10MB offered for  free, you

can purchase  an  Editor  subscription  for  yourself  and  gain  100MB,  even  if  you  don't  share  your

models.

TRIAL

During  our  30  days  free  Trial  plan  period,  you  can  have  up  to  99  users  with  role  Editor  or

Contributor.
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Comments on models
Comments allow you to easily interact with your colleagues and help you to send and receive feedback

about a Model's diagrams design and its documentation. 

Bizagi allows yo to comment in several parts of a  model in order  to contribute to a better  design, in a

collaborative way.  Every  comment  entered  can  be  seen  by  all  members  of  the  Workgroup.  You  can

comment:

From the diagrams view. 

Within each diagram. 

Within a specific shape. 

Comments  on  Models  can  be  made  either  from  Bizagi  Modeler  (for  Editors)  or  from  Bizagi  Cloud

Website (for Editors and Contributors). 

In order to make comments over a  Model,  its  diagrams and its  elements,  open the Model from Bizagi

Modeler (Click in File tab > Open > Bizagi Cloud,  > Browse) or  Sign In to the website using your  Bizagi

credentials.

Comments  are  made  from  the  Comments  panel  and  are  available  when  the  Model's  owner  has  a

Workgroup plan.

In Bizagi Cloud, open the panel by clicking the Show Comments icon ( ). 

In Bizagi Modeler click the Comments icon found in the Diagram section of the Ribbon. 

Type your  comments  and press  Enter  to save them. Each comment will  generate  a  notification  for  all

the team members.
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Comments panel from 
Bizagi Modeler

Comments panel from 
Bizagi Cloud Website

You can perform the following actions over the comments:

Action

Icon

DescriptionBizagi

Modeler

Bizagi

Cloud

Website

Reply
Allows  you  to  Reply  to  a  comment.  Users  cannot  reply  to  the

comments' responses.

Delete
Allows  you  to  delete  a  comment  or  a  comment  response.  You

can delete comments made by you.

Collaboration example

Overview
Let's use the following example to illustrate how collaboration works in a real-life process scenario.
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Assume that Andrea works in the administrative department of her  company. She has  been working on

the Travel Request process, which involves employee activities to manage a request for  a  flight ticket,  a

currency advance and a hotel reservation. 

She  needs  to  share  her  model  to  collaborate  with  team  member  Mark,  allowing  him  to  review  the

model and suggest any improvements.  

1.  To  share  her  model,  she  needs  to  have  purchased  one  Editor  subscription  for  herself  as  a

Workgroup owner, and at least one Editor subscription for Mark. Andrea shares her model for Mark.

2. Andrea and Mark can now both open the model in Bizagi Modeler and work concurrently on it.  They

can communicate with each other by entering messages in the Comments window found on the right of

the screen. 

Messages  are displayed in real-time; hence, as  soon  as  either  party  types  a  comment  and  clicks  the

Enter button, the comment will be. instantaneously displayed.

Messages are displayed both on Bizagi Cloud Website and in Bizagi Modeler.

Comments in Bizagi Modeler work very similarly to Twitter. 

Comments in Bizagi Cloud website are loaded in real time when the Comments panel is opened. 
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3.  Andrea asks  Mark to help her  with the Expenses  report  diagram.  They  can  both  view the  Expense

report diagram simultaneously and thereafter discuss it. 

Mark reviews the diagram. He comments, at Diagram level,  that all the  activities  of  the  Administrative

Manager are missing and stipulates that he will make the changes. 

4.  The  diagrams  can  only  be  edited  through  Bizagi  Modeler,  thus,  Mark  clicks  on  the  Edit  in  Bizagi

Modeler button. This button will launch Bizagi Modeler application.

By default all diagrams are read-only.  To change or  update  a  diagram  it  is  necessary  to  click  Check
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Out, located in the Bizagi Cloud group on the Home tab. 

In the given example, this  feature enables  Mark to perform any changes  on the diagram; however,  for

Andrea and other users the diagram will be locked.  

5.  Once Mark has  completed his  changes  he clicks  on the Check In button, located in the  Bizagi  Cloud

group on the Home tab.  
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6. Andrea receives a notification informing there has been a change in the Expense report diagram.

7.  Andrea  reviews  the  model  and  notes  the  last  activity  should  have  some  additional  changes.

Consequently,  she adds  a comment in the Policies ok?  gateway and clicks  on  the  gateway  in  order  to

open the comments panel for this shape.

8.  Mark  reviews  Andrea's  latest  comment.  Either  Mark  or  Andrea  can  make  the  change  in  Bizagi
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Modeler. Whoever makes the change will lock the diagram, using the Check In feature. 

Collaboration levels
Collaboration comments  can be made at three different levels:  model,  diagram  and element,  so that

team members can comment on the context in each level.

Model comments:  comments  posted  in  the  Model  level  apply  to  all  the  diagrams,  i.e.  are  visible

from any diagram in the model. These comments are found in the Diagrams tab. 
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.

Diagram comments: comments posted within a diagram only apply to that particular diagram. 

 

Element comments: comments posted within a selected diagram element only apply to that element

present in a diagram.  

Bizagi Cloud website

Overview
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Bizagi  Cloud  presents  a  website  where  the  models  stored  in  Bizagi  Cloud  and  are  displayed  for

Owners, Editors and Contributors. To access the site a browser is required, as well as a Bizagi account.

In Bizagi Cloud, all users with access to a model can include comments and view their  process  flow and

documentation. 

To access the Bizagi Cloud website, open a browser and type https://model.bizagi.com/. 

We recommend using the latest Google Chrome for best user experience.

If you are working on Bizagi Modeler  and want to access  Bizagi's  Cloud  website,  you  can  open  it  by

clicking the bizagi.com button located in the Home tab in the Ribbon.

Bizagi Cloud Website Interface
Bizagi Cloud is  composed of four  main screens  that will help you  to  access,  view,  comment,  or  open

your Processes. The available menus depend on the permission levels a user has over a model. 

The screens are:

Workspace page.

Model page.

Current Diagram page.

Workspace page

Overview
The  workspace  displays  all  the  Models  owned  and  shared.  Each  model  displays  some  options

according to the permission levels assigned to the user.

https://model.bizagi.com/
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Models  can be displayed in List or  Grid View by clicking  on  the  corresponding  button  in  the  toolbar.

The default view is List.

When the List view is selected, the screen

looks as follow

When the Grid view is selected, the screen

looks as follow

1. Model name

Displays a part of the name given to the

current model. When the full name is  not

displayed,  hover  over  the  name  to

display it.

2. Model description

Displays  a  part  of  the  description  given

to  the  current  model.  When  the  full

description is  not  displayed,  hover  over

its name to display it.

3. Edit in Bizagi Modeler

This  option  launches  Bizagi  Modeler  to

edit  the  model.  It  is  available  when  the

user  is  an  Owner  or  Editor.  Refer  to

Editing  Cloud  Models  for  more

information.  

4. Properties

Enables the edition of the Model's  name

and description.  This  option  is  available

when  the  user  is  an  Owner  or  Editor.

Refer  to  Editing  Model  Properties  for

more information. 
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5. Invite People to Model

This option displays  the window to invite

other  people  to  collaborate.  It  is

available  when  the  user  is  an  Owner.

Refer  to  Sharing  and  collaborating  for

more information.

6. Delete

This  option is  available when the  user  is

an Owner.

Refer  to  Deleting  a  Cloud  Model  for

more information.

                                                                                                                     

Model page
The Model page displays all the diagrams within a shared Model.  The options  on the bar  apply to the

entire Model, and are displayed according to the permission level assigned to the user.

1. Diagram preview

Displays  a  preview  of  the

modeled diagram.

2. Diagram name

Displays  a  part  of  the  name

given to  the  diagram.  When  the

full name is  not displayed, hover

over the name to display it.
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3. Locked 

Displays  a  Lock  icon  when  the

Diagram  is  checked  out  by  any

user.  Hover  the  icon  to  display

who has  locked the  diagram  for

edition.  If  the  icon  is  not

displayed,  the  Diagram  is  not

locked for editing.

The following is the toolbar displayed on the top of the Model page.

It always presents the path of the Model selected on the left. On the right, the available options:

ACTION ICON DESCRIPTION

Edit en Bizagi Modeler

This  option  launches  Bizagi  Modeler  to  edit  the  diagram.  This

option is  available when the user  is  an  Owner  or  Editor.  Refer  to

Editing Cloud Models for more information.  

Properties

Enables  the  edition  of  the  Model's  name  and  description.  This

option is  available when the user  is  an  Owner  or  Editor.  Refer  to

Editing Model Properties for more information. 

Invite People to Model

This  option  displays  the  window  to  invite  other  people  to

collaborate.  It  is  available  when  the  user  is  an  Owner.  Refer  to

Sharing and collaborating for more information.

Show Comments
Displays  the  comments  panel  to  collaborate  with  team  members.

Refer to Comments for more information. 

List View Displays the diagrams in List view. 

Grid View Displays the diagrams in Grid view. 

List and Grid View
Diagrams can be displayed in List or  Grid View by clicking on the corresponding button in the toolbar,

The default view is Grid.
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When the List view is selected, the screen

looks as follow

When the Grid view is selected, the screen

looks as follow

Current Diagram page
The Current Diagram page displays  a  diagram belonging to a shared model.  The options  on  the  bar

are displayed according to the permission level assigned to the user.

After you select a Diagram in the Model page, the browser  will display the diagram modeled in Bizagi

Modeler.

The following is the toolbar displayed on the top of the Current diagram page.

It always presents the path of the Diagram selected on the left. On the right, the available options:
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ACTION ICON DESCRIPTION

Edit en Bizagi Modeler

This  option  launches  Bizagi  Modeler  to  edit  the  diagram.  It  is

available  when  the  user  is  an  Owner  or  Editor.  Refer  to  Editing

Cloud Models for more information. 

Invite People to Model

This  option  displays  the  window  to  invite  other  people  to

collaborate.  It  is  available  when  the  user  is  an  Owner.  Refer  to

Sharing and collaborating for more information.

Show Comments
Displays  the  comments  panel.  Refer  to  Comments  for  more

information. 

Diagram area
The diagram area is where the Diagram is displayed for users  of the Workgroup. When the diagram is

not fully displayed, move around the diagram by dragging it,  or  use the Zoom buttons  located on the

bottom right corner.

To zoom in the diagram, use the button .

To zoom out the diagram, use the button .

To reset zoom, use the button .

Elements above shapes
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The following elements can be displayed above the shapes within the diagram

ACTION ICON DESCRIPTION

Show Comments
Displays  the  comments  panel  and  the  comments  made  in  the

shape. Refer to Comments for more information. 

Open Subprocess

This  element  is  only  displayed  when  the  shape  represents  a

Reusable  subprocess.  It  opens  the  process  referenced  in  a  new

browser's tab. 

In some browsers,  you may require to allow pop-ups  from  Bizagi

Cloud Website.

Offline Cloud Collaboration

Overview
We all recognize  the  power  of  cloud  and  its  unbeatable  benefits  –  many  covered  here.  Yet  the  fact

remains: sometimes, you will experience connectivity problems. Whether that “somewhere” is  the plane,

or a client’s site, Bizagi’s collaboration features mean your productivity will not suffer.

Offline working is available for each diagram individually. Just select the diagrams you want to work on

when you can’t find an internet connection. Immediately,  Bizagi  saves  the  designated  diagrams  to  be

available locally and locks them so other users will not be able to edit them.

Going Offline
To start working  offline  just  open  your  Cloud  model  in  Bizagi  Modeler  and  click  Work  Offline  in  the

ribbon.



329Copyright © 2002-2016 Bizagi. All rights reserved.

A new window will  display  for  you  to  select  the  diagrams  you  need  available  offline.  These  will  be

stored  locally  in  your  machine.  All  chosen  diagrams  will  be  automatically  checked-out  to  you.

Remember that when a diagram is offline, and thus checked out, all the users  sharing the model will be

restricted from editing their flow and documentation.
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All  chosen  diagrams  will  be  available  offline,  and  the  diagrams  that  were  NOT  chosen  will  not  be

available offline. Make sure the work offline button is disabled to confirm the offline features activation.

The diagrams chosen to be available offline will be displayed as  locked for  your  team  members  until

you check them in again. However all diagrams are available from the Cloud website for  reviewing and

comments.

Going online after working offline
As soon as your internet connection is back, press Work Online.  This  will synchronize your  work without
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checking in it, so your team members can stay up to date with your modifications.

In case you have finished your modifications, remember to click Check in in order  to release the control

of the model to the cloud.

In case you have more than one diagram, to check them all in,  just close  Bizagi  Modeler.  You  will  be

prompted asking to check in all diagrams automatically at the same time.

Attachments in the Cloud

Overview
Attachments  are  files  added  to  your  diagrams  to  achieve  a  very  complete  documentation,  such  as

images  or  documents.  As  a  Model owner, you have access  to 100 MB of storage in the cloud to add

attachments. Furthermore, you gain 100 MB extra per Editor subscription your purchase.

All your  attachments  are stored in Bizagi Cloud's  secure servers  and can be reused as  many times  as

you want within your models.

Managing attachments
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In order to manage the files attached to your Models, you need to open the Cloud Attachment window:

1. Open Bizagi Modeler and log in to Bizagi Cloud.

Open the diagram where you want to manage attachments by clicking File tab > Open > Bizagi Cloud,  >

Browse. 

2. Click the Cloud Attachments option located within Tool group in the Tools tab of the Ribbon.

3. Once you click in this option, the Cloud Attachment window will be displayed. 
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In this window you can add attachments without restrictions, as long as you have available space quota.

You can rename your files and delete them in order to free up space.

The Cloud Attachment window is described below:
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1. Storage bar: displays the storage used out of the total storage, according to your  subscription and

the number of editor licenses purchased. The storage is displayed in Megabytes (MB).

2. Search field: allows you to search any file uploaded to the cloud by its name or part of it.

3. Upload button:  allows you to add attachments  to your  models,  for  more information refer  to Add

attachments.

4. Amount of files: displays the total number of files you uploaded in Bizagi Cloud or  the total of files

that meets the search criteria (when searching).

5. Files: displays a table with the uploaded files. This table contains the following columns:

o File actions: refer to file actions for more information.

o Name: displays the file name including its extension.

o Size: displays the size of the file in KB or MB when this size exceeds 1024 KB.

o Modified by: displays the user name of the last person who performed a change in the file.  When
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you hover over this column, you will be able to see when this file was modified.

This table is sorted by file name and has 5 records per page.

Add attachments
You  can  add  attachments  to  your  models  and  also  link  them  to  any  of  your  diagrams  using  the

extended attributes.

There are some file types that you cannot upload to Bizagi Cloud Server.  If you try to use one of them,

Bizagi will dis[play a warning message showing that the file cannot be uploaded.

The following list displays file types that are not allowed:

File

extensio

n

File type

File

extensi

on

File type

.ade Microsoft Access project extension .msc Microsoft Common Console document

.adp Microsoft Access project .msp Windows Installer update package file

.bat Batch file .mst Visual Test source files

.chm Compiled HTML Help file .pif Shortcut to MS-DOS program

.cmd Microsoft Windows NT command

script

.scr Screen saver

.com Microsoft MS-DOS program .sct Script file

.cpl Control Panel extension .shb Windows shortcut

.exe Executable file .sys System File

.hta HTML program .vb Microsoft Visual Basic Scripting Edition

(VBScript) file

.ins Internet Naming Service .vbe VBScript Encoded Script file

.isp Internet Communication settings .vbs VBScript file

.jar Java Archive file .vxd Virtual Device Driver file

.jse JScript Encoded script file .wsc Windows Script Component

.lib Physical File Library .wsf Windows Script file

.lnk Shortcut .wsh Windows Script Host settings file

1. Open the Cloud Attachment window as we mentioned before.

2. Click on the Upload button. 
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3. The button will display the file upload dialog. Select the file and click Open.

4. Once you click Open, the file will appear in the list and will affect the consumed storage in the Storage

bar.  In  the  example  presented,  the  file  appears  on  the  top  of  the  list,  because  the  list  is  ordered

alphabetically.
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File actions
The first column of the files table display the actions available per each one:

Action Icon Description

Download

file

Allows you to save the uploaded file in your local machine.

Rename file
Allows  you  change  the  name  of  the  selected  file  keeping  the  original

extension. Any change you make in the name will record your  user  name  as

the last editor in the Modified by column.

Remove file

Deletes the selected file from Bizagi Cloud. This action cannot be undone and

helps  you  to  free  up  space  from  your  purchased  storage.  The  file  will  be

removed from the list right away.

WARNING:  If  a  file  is  linked  to  a  task  and  it  is  deleted,  the  task  may  still

display  the  link  and  when  clicked,  it  will  display  an  error  message.  We

recommend unlinking the file you want to delete from all tasks, to avoid error
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messages. 

Link Cloud files to models
Once  you  have  uploaded  your  files  to  our  Bizagi  Cloud,  you  can  link  them  in  any  diagram  of  your

model. Follow the steps below in order to link files:

1. Open the model from Bizagi Cloud. You need to be the owner of the model or an Editor.

2. Open the diagram where you want to link the files hosted in Bizagi Cloud and lock it for editing.

3. Select any element of the process diagram and open the extended attributes.

4. Select or create an attribute where you can load files (File). Then, click on Link file from Cloud button.
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5.  The  Select  Attachment  window will  be  opened.  In  the  files  table,  select  Link  file  action  in  the  first

column.

6. The file name will appear  in the box of the Extended attribute. Finally,  once you finish your  changes

release the diagram by clicking the Check In Diagram button. 

Account, Pricing and Billing Info

Overview
Bizagi  Cloud  Collaboration  Services  offer  a  host  of  features  to  help  you  work  more  productively,

whenever and wherever you happen to be. Take a look at our  pricing packages  to decide what’s  right
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for you.

Bizagi Cloud Plans
Bizagi offers two Plans, choose one according to your needs:

Personal plan

Workgroup plan (you can activate a 30 day Trial plan)

Personal

$ 0

Workgroup *

$ 50 USD per Editor

$10 USD per Contributor

Owner (monthly fee) Free $50/month

 Editors N.A. $50/month

Contributors N.A. $10/month

Editors + Contributors 1 editor (the owner) unlimited

Models unlimited unlimited

Diagrams unlimited unlimited

Storage 10MB 100MB per Editor

Attachments - cloud stored

Simulation

Import/Export

Mobile access in website

Documentation in website

Modeling

Collaboration -

Comments on models -

Comments on diagrams -

Comments on shapes -

Real time notifications -

Models activity feed -

* Bizagi offers a free 30-day trial enabling you to try and test the features  before deciding whether  our

Cloud Collaboration Services will be a good fit for  you. By default,  the free trial gives  you access  to all

features  available  in  the  Workgroup  plan.  By  the  end  of  the  trial,  you  can  choose  to  purchase  a
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subscription or let the trial expire (no billing information is collected) - and return to the Personal Plan.

During the 30-day free trial, you can invite up to 99 users. 

Pricing and Billing Info
When you want to purchase a subscription for Bizagi Cloud Collaboration Services, the payment is done

through a valid PayPal account.

Paypal will charge you a monthly subscription to the registered payment type, according to the selected

subscriptions.

When  you  upgrade  your  plan  to  Workgroup  from  a  Personal  plan  you  must  purchase  an  Editor

subscription for  yourself,  as  Workgroup  owner.  For  example,  if  you  want  to  share  your  models  with

four  coworkers,  two  (2)  Editors  subscriptions   ($50  USD  per  subscription)  and  two  (2)  Contributor

subscriptions ($10 USD per subscription), the price for this transaction will be $170 USD,  the additional

$50 USD corresponds to your owner's subscription. 

If you are purchasing from a country who is part of the European Economic Community,  you have to

provide your VAT ID along with their billing information to avoid being charged VAT.

To view the status of your current plan, just Log in to Bizagi Cloud and click on the link of your  display

Name. Then click Plan and Billing.
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The right panel will expand. This panel will display the following information:

1.  Plan:  describes  your  current  plan.  The  possible

values are Workgroup or Workgroup (Trial).

2.  Models owned:  displays  the amount  of  models

that a user owns.

3.  Licensed  users:  displays  the  number  of

subscriptions  available  and  in  use  for  Editors  and

Contributors.

4.  Total  storage:  displays  the available storage  of

the  Workgroup  (in  Megabytes)  and  the  used

storage.

5. Need more storage?:  displays  the Purchase now

button  in  order  to  open  the  Plan  Management

option.

6. Plan rate: displays the total monthly payment for
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the purchased subscriptions.

7.  View Invoices &  History:  displays  a  list  of  the

invoices  generated  with  your  purchases  and

monthly payments.

Personal plan

Overview
Every free Bizagi account automatically entitles the user to a Personal plan where you can securely save

models in Bizagi Cloud, for free, for up to 10MB.

This account type is perfect for individuals working on a project, with no need to share models.

As a user  in Personal plan, log into Bizagi Cloud. A bar  will indicate that you are in  the  Personal  plan

and display a button to easily Upgrade to Workgroup plan..

Plan information is  also  displayed  in  the  top  right  corner  of  Bizagi  Modeler  when  you  click  on  your

name.

Upgrade to Workgroup plan
Switch on Bizagi Cloud Collaboration Services and enjoy a host of new benefits:

Collaborate

View,  review,  share  and  collaborate  on  process  models  any  time,  any  place,  any  device.  Enjoy

interacting with your team members from the devices  they love: whether  tablet,  mobile,  their  PC or

Mac desktop.



344Copyright © 2002-2016 Bizagi. All rights reserved.

Greater Productivity

A great tool set enables  you and  your  team  to  truly  work  together,  whenever  and  wherever  you

happen to be. Make comments on any part of the process  diagram, navigate through the process

flow and make contributions. All you need is a browser.

One 360 View

Get full visibility of each process model and its editorial status. See who checked it out,  get notified

each time a change is  made, and get alerts  when the diagram is  all yours  to work on again. With

Bizagi Cloud Collaboration services, there’s no duplication of time or effort.

Purchase the Workgroup plan and enjoy great team collaboration features. You can also sign up to the

Workgroup 30-day trial and enjoy team collaboration features free for 30 days.

Workgroup Plan

Overview
Switch on Bizagi Cloud Collaboration Services and enjoy a host of new benefits cost-effectively.

Collaborate

View,  review,  share  and  collaborate  on  process  models  any  time,  any  place,  any  device.  Enjoy

interacting with your team members from the devices  they love: whether  tablet,  mobile,  their  PC or

Mac desktop.

Greater Productivity

A great tool set enables  you and  your  team  to  truly  work  together,  whenever  and  wherever  you

happen to be. Make comments on any part of the process  diagram, navigate through the process

flow and make contributions. All you need is a browser.

One 360 View

Get full visibility of each process model and its editorial status. See who checked it out,  get notified

each time a change is  made, and get alerts  when the diagram is  all yours  to work on again. With

Bizagi Cloud Collaboration services, there’s no duplication of time or effort.

Purchase Workgroup plan
Subscriptions  can  be  added  and  purchased  from  Bizagi  Cloud  Website.  Follow  the  steps  below  to

purchase subscriptions.

1. Log in to Bizagi Cloud Website.

2. Click on your Name (or email) and then, click Plan Management.
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3. A right panel will expand. This  will display the Licenses  section; increase or  decrease the number  of

subscriptions and then click the Purchase button.
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Editor  and  Contributor  licenses  are  independent,  If  a  user  is  an  Editor  and  a  Contributor  in  two

models, the Owner must pay for both subscriptions.

4.  The Billing information window is  opened, review or  update the data displayed  and  then  click  Next.

Bizagi Cloud will redirect you to a PayPal transactional page.
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5.  PayPal  will  display  your  order  summary.  Review  that  the  price  corresponds  to  the  number  of

subscriptions to be purchased and log in using a valid PayPal account.
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6. PayPal will display the user information. Click Agree and Continue to perform the payment.
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By  agreeing,  PayPal  will  create  an  Automatic  payment  to  automatically  debit  monthly  from  your

Paypal account the value purchased. In our example, PayPal will discount US$ 290 monthly.

To  stop  this  automatic  payment,  log  in  https://www.paypal.com/?cmd=_manage-paylist  using  your

PayPal account and cancel your Bizagi subscription.

7. Once you accept the terms, PayPal  will  apply  the  payment.  You  will  be  redirected  to  Bizagi  Cloud

website  where  the  Welcome  to  Workgroup  Plan  window  will  display  the  number  of  subscriptions

purchased (Editors and Contributors) and the date where PayPal will charge the next payment. Click Ok

to close this window.

https://www.paypal.com/?cmd=_manage-paylist
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8.  Bizagi  Cloud  website  will  display  the  confirmation  of  the  transaction.  Click  in  Download  invoice  to

download a copy of your invoice in PDF format.
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Workgroup Trial

Overview
Bizagi offers  a  free 30-day trial which enables  you to test out the features  of our  Cloud Collaboration

Services  before purchasing. By  default,  the  free  trial  gives  you  access  to  all  features  available  in  the

Workgroup  plan.  By  the  end  of  the  trial,  you  can  choose  to  purchase  a  subscription  or  let  the  trial

expire (no billing information is collected) - and go back to Personal Plan.

During the 30-day free trial, you can invite up to 99 users. 

With the trial you obtain:

100 MB of additional Storage per Editor.

Ability share your process models with teammates.

Collaboration tools (comments, etc).

Add up to 99 users shared between Editors and Contributors.

Activating your Trial
The Trial can be activated from Bizagi Cloud website.  You can  active  it  once.  If  your  trial  expires  you

need to purchase a Workgroup subscription to continue enjoying the benefits of the Service.

1. To activate your trial, click on the Upgrade your plan located under the link of your display Name.

2. The Change Your plan window will display. Click on Start free trial!.



353Copyright © 2002-2016 Bizagi. All rights reserved.

3. Another window will ask you to accept our term and conditions, click on this  checkbox and then click

on Start.
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A confirmation message will be displayed.

When  your  trial  is  activated,  Bizagi  will  give  two  (2)  Editor  subscriptions  and  two  (2)  Contributor

subscriptions by default, which means that you start your trial with 300MB of available storage.

The  bar  will  indicate  that  the  logged  account  is  in  Trial,  and  a  button  to  Upgrade  easily.  The  days

remaining before expiration are displayed when there are 25 remaining days or less.

The information above is also displayed in the upper  right corner  of Bizagi Modeler  when you click on

your name after logging in.
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When your  trial expires,  all the Models  in your  Workspace will still be available to  you  from  both  the

Bizagi  Cloud  Website  and  Bizagi  Modeler.  Nonetheless,  Bizagi  will  leave  your  Models  in  read  only

model.  This  means  that neither  you nor  your  collaborators  will not be able to add models,  diagrams,

attachments or make comments  until the amount of available space in Bizagi cloud drops  to less  than

10 MB.

For example, if you have used 80 MB of storage and the trial period expires,  you and your  colleagues

need to upgrade to a Workgroup plan with at least one Editor in order to continue collaborating in the

cloud.

Adding or removing subscriptions
In your Trial plan, you can add or remove subscriptions. Add up to 99 editors and contributors for free.

Subscriptions  can  be  added  from  Bizagi  Cloud  Website,  follow the  steps  above  in  order  to  add  or

remove subscriptions.

1. Log in to Bizagi Cloud Website.

2. Click on the link of your Name and then click Plan management.
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3. The right panel will be expanded. In Licenses  increase or  decrease the number  of subscriptions  and

then click the Update Licenses button.



PartVII
Importing diagrams
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Importing diagrams

Overview
Bizagi Modeler allows you to import diagrams from:

Microsoft Office Visio or 

XPDL format files. 

Importing existing models will enhance agility and continuous process improvement efforts. 

You can also import the Extended Attributes that you created in a previous  model and use then in your

current model. 

We highly recommend using the same Extended Attributes  within  all  your  models.  This  allows  you  to

maintain a uniform standard for all your documented processes. 

Click here for more information about Extended Attributes

Click here for more information about Importing Extended Attributes

Why do you need to import?
Process diagramming requires  a  lot of dedication. Organizations  often devote a significant amount of

time and resources to it, and may use several diagramming tools. 

If  this  is  the  case  and  you  have  existing  diagrammed  Processes,  all  that  valuable  work  will  not  be

wasted.  You  can  import  your  diagrams  to  the  Bizagi  Process  Model  and  seamlessly  continue  to

diagram and document.

Import diagram from Visio
Microsoft Office Visio is a very common tool for diagramming processes. Bizagi Modeler  allows you to

import such processes to enable editing and manipulation.

To import diagrams from Visio, follow the steps below:

1. On the Export/Import tab, in the Import group, click Visio.
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2. Select the stencil used in Visio to diagram the process. 

If you click on the Mapping option, you will see the similarity between each of the elements  used in the

Visio Stencil and those of Bizagi Modeler.
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3. Click the OK button and upload the Visio file to be imported.
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4. You will be able to modify the process in Bizagi Modeler after import.

Supported Stencils
The stencils that are currently supported are those shown below:

For each stencil, you may review which elements are supported and how are they mapped in Bizagi:
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You  will  need  to  ensure  that  your  Visio  model  uses  one  of  this  stencils  instead  of  “EPC  Diagram

shapes”.
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Import diagram from XPDL
The XML Process  Definition Language (XPDL) is  a  format standardized  by  the  Workflow management

Coalition (WfMC) to interchange business process definitions between different workflow products.  The

XPDL format can store all aspects  of a  BPMN diagram, such as  attributes,  resources,  etc.  Also,  some

graphical information is held, for example position coordinates of the elements.

Using XPDL in Bizagi offers  the possibility to share your  diagrams with other  modeling  tools  that  use

BPMN notation. You can import your diagrams to XPDL using the BPMN 2.0 notation shapes. 

For more information about the currently supported XPDL version, refer to Supported standards.

To import your diagrams follow the steps below.  

1. On the Export/Import tab, in the Import group, click XPDL.
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2. Browse and select the XPDL file and click the Open button.
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3. The XPDL file load and you can edit it in Bizagi Modeler.  It will appear as if the diagram was  created

directly in Bizagi Modeler.
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Import diagram from BPMN
Bizagi  Modeler  allows  importing  diagrams  created  with  other  modeling  tools  that  comply  with  the

BPMN 2.0 xml format, to Bizagi Modeler.

For more information about the currently supported BPMN version, refer to Supported standards.

To import your diagrams follow the steps below.  

1. On the Export/Import tab, in the Import group, click BPMN.
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2. Browse and select the .bpmn file and click the Open button.
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3. The BPMN file load and you will be able to edit the diagram in Bizagi Modeler.   It will appear  as  if

the diagram was created directly in Bizagi Modeler.
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PartVIII
Simulation
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Simulation

Simulation is a tool to evaluate the performance of a model,  under  different  configurations  and  over  long

periods  of  real  time,  to  reduce  the  chances  of  failure  to  meet  specifications,  to  eliminate  unforeseen

bottlenecks, to prevent under or over-utilization of resources (including people and money),  and to optimize

system performance. 1

Simulation requires a clear objective to get maximum value for  effort.  This  objective strongly influences

the level of detail in the required data.

Bizagi  Simulation  follows  BPSim  (Business  Process  Simulation)  standard  that  allows  enhancement  of

business process models captured in BPMN to support rigorous methods of analysis.

1. Introduction to modeling and simulation. State University of New York at Binghamton.

What is simulation

Experiment definition
Randomness is simulated by the use of probabilities for sequence flows and token routing and also by

using statistical distributions to reflect variability in process  times  of activities  etc.  To make sure results

are  valid,  the  simulation  needs  be  run  for  long  enough  to  yield  random  behavior  without  chance

(consider the scenario of tossing a coin or  rolling a dice multiple times).  Provision should be made to

compare  results  from  the  same  scenario,  but  different  run  lengths  or  replications.The  required  run

length to yield usable outcomes depends on the process model structure, amount of variability and the

objective; consequently, a single recommended run length cannot be provided. A replication shares  the

same  scenario  configuration  and  runs  for  the  same  length  of  time,  but  uses  an  alternative  random

stream.

Comparison
Simulation is well known for  providing what-if analysis  capabilities;  a  single simulation run can provide

valuable insight on the performance of a  particular  scenario. The simulation of multiple scenarios  and

the possibility to compare key outcomes, adds further value and support to decision makers.

Simulation in Bizagi

Overview
Bizagi  Modeler  allows  simulation  your  business  processes  under  the  BPSim  (Business  Process

Simulation) to support decision making and boost theit continuous improvement.

To start using simulation in Bizagi all you need is  a  complete Process  model.  otherwise,  it  will  not  be

able to be simulated.

For a complete simulation analysis we recomment using four levels:

Level 1 -Process Validation

Level 2- Time Analysis

Level 3 - Resources Analysis

Level 4 - Calendars Analysis

http://bpsim.org/
http://bpsim.org/
http://bpsim.org/
http://bpsim.org/
http://bpsim.org/
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Each  subsequent  level  incorporates  additional  information  that  adds  more  complexity,  providing  a

coherent analysis  of your  processes. Levels  are not interdependent,  you  may  start  at  any  level  if  you

hold the required process data . 

By default the Simulation mode will start at Level one, the first time a Simulation is  run for  the process

model. It is best practice to start simulation at level one, and progress one level at a time. However. it is

possible to move between levels at any time. 

Certain options will be available in the context menu of the ribbon according to the level selected. For

more information about these options, please refer to examples for each level.

For each simulation level follow these steps:

Collect process data for the simulation.

Add the data to the relevant shapes in the diagram.

Interpret and present the outcomes.

How to create and run simulation models?
1. To simulate your process model, click the Simulation View button on the ribbon. If your  diagram does

not have any errors your process will display in read-only simulation mode.

If your process model is stored in Bizagi Cloud,  and you want to run a simulation, your  Model must

be locked for edition (checked-out). Refer to Editing Cloud Models for more information.
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2.   The shapes that require information will be highlighted according to the simulation level in scope.

Note Bizagi will  retain  the  level  you  are  currently  running  once  you  save  the  model  returning  to  the

Process Model view.

3. Select each highlighted shape in turn and enter the information.

4. Once all the data has been added, click Run to launch the Process Simulation window.
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5. Click Start  to  run  the  simulation.  When  you  run  a  simulation,  it  will  show an  animated  view of  the

process in execution and the the flow of tokens between the activities.

You may click the Stop button at any time to end the simulation.
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6. Once the simulation has run, the outcomes will display.

Click Results to view the outcomes.

7. Click the Export to Excel button, located at the bottom left, to transfer the Results chart to Excel.
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8. Process to the next level of simulation and repeat step 2-8.

9. To return to the Process Model view, click Close Simulation View.

Save your model for Bizagi to retain the current simulation level, returning to the Process Model view. 

For information about how to manage scenarios, please refer to Scenarios

Considerations
Before creating a simulation model take into account the following considerations:

The following BPMN elements are not supported by the simulation engine:

o Multiple events: Start, Intermediate and End.

o Complex gateways.

o Event based gateways followed by none intermediate events or tasks.

o Multiple instance tasks. 

o Multiple instance Sub-processes.
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The following diagrams are not supported by the simulation engine:

o BPMN Choreography diagrams.

o BPMN Conversation diagrams.

o Transactional process.

o Ad Hoc process.

Elements  contained  in  Reusable  Sub-processes  are  not  simulated.  If  you  include  a  Resuable  Sub-

process  in your  model you will have to set a  overall processing  time  for  the  shape.  If  you  want  to

simulate the logic included within a Sub-process, use Embedded Sub-processes.

Tokens have not data associated, this affects the mapping of message, signal and link events:

o Message events require message flows to map tokens. Download an example.

o Links and Signal events are mapped based on their names. Make sure that throw and catch events

share the same name.

Simulation levels
Bizagi Simulation comprises  of four  levels.  Each  subsequent  level  incorporates  additional  information

exhibiting  more  complexity  than  the  preceding  one,  thereby  providing  a  detailed  analysis  of  your

processes. Levels are not interdependent, , you may start at any level if you hold the required process

data . 

Level 1 - Process Validation: The first and most basic simulation level to evaluate the

structure of the process diagram.

Data: It requires  estimated percentage splits  of sequence flows to provide a basis  for  routing.  It also

needs the value of the trigger counter contained in the Start Event shape. 

Results:  The  outcomes  show all  paths  activated  during  the  execution  and  whether  all  tokens  actually

finished. Additionally,  it evaluates  how many tokens  passed through  each  Sequence  Flow,  Activity  and

End Event. 

Level 2 – Time Analysis: Second level of simulation to measure the end-to-end process

time.

Data: Apart from the data entered in Process Validation, estimated timings (service times) of each activity

and the interval time between token generation is required. This data can either be constant or  samples

from statistical distributions1. 

Results: The results show process throughput times for tokens, presented as minimum, maximum, mean

and sum (total of all processing times). Similar results can be presented for individual key activities.

http://download.bizagi.com/docs/Simulation_example_with_collaboration.bpm
http://download.bizagi.com/docs/Simulation_example_with_collaboration.bpm
http://download.bizagi.com/docs/Simulation_example_with_collaboration.bpm
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Level 3 –  Resource Analysis:  Predicts  how the  process  will  perform  with  different

levels of resources. This  level of detail provides  a reliable estimate of how the process  will perform in

operation.

Data:  In addition to the data entered  in  Time  Analysis,  this  level  includes  the  definition  of  resources

(and/or roles): how many are available and where they are used. Due to the inclusion of resources, the

activity times  should be adjusted to represent the actual work time; delay due to unavailability of staff

will be explicitly indicated.

Results: The structure of the results is similar to  Time Analysis. Also, the time spent, the time spent busy

or idle for each type of resource is presented.

This level assume an unlimited number of resources.

Level 4 – Calendar Analysis:  Includes  calendar  information  that  reflects  the  process

performance over dynamic periods of time, such as shifts, days schedules or weeks. 

By default Bizagi includes  a  chosen  calendar  that  works  24/7.  If  no  calendars  are  defined,  Bizagi  will

assume that the defined Resources will always be available.

Data:  Apart from the data entered in Resource Analysis, it includes the definition of resource calendars.

Results: The structure of the results is similar to Resource Analysis.

EXAMPLE
To better illustrate each of the simulation levels let us  consider  an Emergency attendance process.  In this

process  a  call center  receives  a  report of an  emergency.  Upon  receiving  the  call,  a  call  center  agent

enters  details  on the person affected,  the  symptoms  and  the  physical  address  where  the  emergency

occurred. 

On receipt of the report, a qualified nurse classifies the emergency according to its severity.

Green: Low severity. The patient can be easily stabilized.

Yellow: Medium severity. The patient requires  special attention but can be stabilized at the place of

emergency.

Red: High severity. The patient must be collected and taken to the nearest hospital.

According to the priority assigned, the Emergency  attendance  department  presents  a  different  level  of

response. 

Green:  This  triage is  assisted by a quick response vehicle (i.e.  a  motorcycle) carrying two people:  a

paramedic and a doctor. 

Yellow:  This  triage  is  assisted  by  a  basic  ambulance  having  a  doctor,  nurse  and  a  paramedic  on

board.
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Red:  This  triage  is  assisted  by  a  fully  equipped  ambulance  holding  two  doctors,  a  nurse  and  a

paramedic.

If the emergency is  green or  yellow, the process  finishes  once the response team arrives  at the at the

place of emergency.

If  the  emergency  is  red,  the  fully  equipped  ambulance  transfers  the  patient  to  the  nearest  hospital.

During the transfer a nurse carries out the necessary paperwork to ensure quick admittance.

When the patient arrives  at the hospital with the necessary paperwork, the receptionist will be able to

admit the patient quickly and provide medical assistance immediately.

This process must be carefully analyzed in order to reduce the time between receiving the request and

providing  medical  assistance  (at  the  place  of  emergency  or  the  hospital).  Here,  time  is  life.  Bizagi

Simulation will help  us  to  make  clear  decisions  to  best  design  the  business  process  and  reduce  the

emergency wait time. 

1. Refer to BPSim specification to review statistical distributions supported and their explanation.

Level 1 - Process Validation

Overview
The first level of the simulation validates  the Process  Model,  making sure the process  passes  through

all the sequence flows, and behaves as expected.

Resources, processing times  and costs  are not included in this  level.  Such parameters  will be included

later in subsequent levels.

When validating a Process Model the simulation results will show if:

Gateways are synchronized.

Messages are synchronized.

http://bpsim.org/
http://bpsim.org/
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Decisions probabilities are correctly assigned.

Routing behaves as expected.

All tokens have ended.

Bizagi offers real-time animation of simulations to easily identify problems. The Results  report will show

the behavior during execution

Defining the input data required for this level
In the Process Validation level you will note that only Start Events  and Gateways  are enabled for  editing.

For this level you need to define:

Max.arrival count: Define the number of token instances the process will generate (or trigger).  We

recommend  defining  a  large  enough number  (at  least  1000)  to  allow the  execution  to  stabilize  and

present reliable outcomes.

Select the Start Event of the process and click the Gear icon on the pie menu. Enter the Max.arrival count

in the pop-up window.

The simulation  will  finish  when  one  of  these  options  happens  first:  scenario's  duration  is  reached,

max arrival count is reached.

When you define a scenario duration, (in the scenario's  configuration) the simulation will finish once

this duration is reached, disregarding the Max arrival count. 

The same applies  the other  way  around:  once  the  max  arrival  count  is  reached  the  simulation  will
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finish disregarding the scenario's duration.

Gateways routing: Inclusive and exclusive Gateways have activation probabilities.  Probabilities  are

values between 0 and 100%. 

Select the Gateway and click the scroll arrow icons ( ) to set the probabilities.

If you do not define probabilities for the paths, they will be equally distributed.

Running the simulation
Once the required data for this level have been defined, click the Run button to execute the simulation.
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In the new window, click Start to run the simulation.

When running a simulation, the following analysis data will display:
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Number of completed tokens.

Number of token instances created.

Number of instances that activate each shape.

Number of finished instances.

Results
When the simulation is finished, view the results by selecting the Results option.

For this first level, the results of the simulated outcome will contain the following information:
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Name: Identifies the specific BPM shape for which the results are displayed.

Type: Identifies the element type of the BPM shape. 

Tokens completed:  Indicates  how many tokens  were processed (instances) during the  execution  of

the simulation.

You can transfer the results report to Excel by clicking the Export to Excel button.

Example: Validating the Emergency  attendance process
We wish to validate the process flow of the Emergency attendance process:
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Define the required input data for  this  level,  namely the max.arrival count and the probabilities  for  all

decision Gateways

1. In this  example we will generate 1000 token instances. Click the Start Event and then  the  Gear  icon.

Set the control's value to a 1000.
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2. Define the probabilities  for  all outgoing paths  of the Gateway. Suppose the emergency department

has estimated, based on historical data, that the probabilities for the different sequence flows are:

Green: 20%

Yellow: 30%

Red: 50%

Define each probability for the Gateway named Triage type.
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3.  Parallel Gateways always activate all outgoing sequence flows; therefore, it is not necessary to define

probabilities for this Gateway.

4. Click the Run button.

Now,  click  Start  to  run  the  simulation.  Note  how the  number  of  completed  events  are  displayed  in

execution. 

When the simulation is complete, select Results.
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Analyzing the results  
The results obtained are:

Analyzing the results we conclude that something is wrong. The number of tokens  (1000) created at the

Start Event of the process differs to the sum of tokens completed at the End Events (1006+311+186).
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Can you identify what is wrong in the flow?

If you watch the diagram carefully,  you will see there is  no point of convergence, that is,  no shape has

been defined to synchronize the paths that exit the Parallel Gateway. 

It is  necessary to merge the outgoing flows into a single flow before  the  token  continues  to  the  next

activity. To do this, include a Parallel Gateway (as a convergence element) to synchronize them.

Once the change is  done, Run the simulation again. Looking at the  new results  we  can  see  that  all  is

working as  expected: The number  of tokens  created (1000) is  equal  to  the  sum  of  tokens  completed

(483+315+202).   In addition, each  token  is  passed  correctly  to  the  triage  based  on  the  probabilities

defined.
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Level 2 - Throughput time analysis

Overview
The second level of the simulation is useful in measuring end-to-end process time.

Here, resources  are  not  included;  Bizagi  assumes  an  infinite  capacity  to  avoid  delays  in  the  process

flow. This is the best case scenario under the given flow and processing times.

Defining the input data required for this level
In  addition  to  the  information  specified  in  the  previous  level,  the  following  must  be  defined  in  the

throughput Time Analysis:

Arrival interval time: Defines the time interval between token instances generation. Instances will

be created  until  the  max.arrival  count  is  reached.  This  applies  to  Start  Events,  Activities  that  start

processes or Timer Events.

Select the Start Event  of  the  process  and  click  the  Gear  icon  on  the  pie  menu.  Set  the  value  for  the

control.



391Copyright © 2002-2016 Bizagi. All rights reserved.

One option is to define the arrival interval time as  a  constant by entering a value. The time units  for

this value are defined in the scenario´s configuration.

In the following image tokens instances are generated every 5 minutes.

Alternatively, define a statistical distribution.  Click the advanced icon alongside the field to view and

select a distribution.
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Once selected, you will be able to set the parameters of the distribution.

In the following image the time between generation of tokens instances is  exponentially distributed with

mean equals to 5 minutes. Tokens will be generated until 100 are reached.

Processing times: Defines the amount of time an Activity or  Event needs  to process  a  token. That

is,  it defines  a service time period from the  moment  a  token  arrives  at  an  Activity  or  Event  until  it  is

executed. 
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Click the Activity or Event.  Select the Clock on the pie menu, and enter  a  processing period in the Time

Control.

You  have  the  option  of  defining  the  processing  time  as  a  constant  by  entering  values  in  the

corresponding units.

Alternatively, define a statistical distribution.  Click the advanced icon alongside the field to view and

select a distribution.
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Once selected, you will be able to set the parameters of the distribution.

In the following image the processing time of a  token in a  specific activity is  normally distributed  with

mean 5 minutes and standard deviation of 3 minutes.

Running the simulation
Once the required data for this level have been defined, click the Run button to execute the simulation.
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In the new window, click Start to run the simulation.

When running a simulation, the following analysis data will display. 
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Number of tokens completed.

Average time per activity.

Total processing time per activity

Results
When the simulation is complete, select Results to view the outcome.

For the Time Analysis level, the results of the simulated outcome will contain the following information:

Name: Identifies the specific BPM shape for which the results are displayed.

Type: Identifies the element type of the BPM shape. 

Tokens completed: Indicates how many tokens were processed (instances).

Tokens started: Indicates how many tokens arrived at the shape.
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Minimum time: Indicates the minimum processing time of the shape.

Maximum time:  Indicates the maximum processing time of the shape.

Average time: Indicates the average processing time of the shape.

Total time: Indicates the total time employed to process the shape.

You can transfer the results report to Excel by clicking the Export to Excel button.

Example:  Performing  a  time  analysis  for  the  Emergency

attendance process
In order  to provide a general insight into processing times, the emergency response  department  has

decided to perform a time analysis.

For this analysis the following assumptions have been made:

Necessary resources to perform activities have infinite capacity.

The expected time between reports is 5 minutes.

The simulation will evaluate a period of 1 week.

The estimated processing times for each of the activities are fixed as shown in the next table:

Activity Processing time (min)

Receive emergency report 4

Classify Triage 5

Manage patient entry 11

Pick up patient 20

Arrive at patient place QAV 7
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Arrive at patient place BA 10

Authorize entry 4

1. Define trigger times. To do so, click the Start Event and then the Gear icon on the pie menu.

For this example, the expected time between reports is 5 minutes, so set the time to this value. Note the

value entered is in minutes. 

For more information about units please refer to Scenarios.

2. Define the Activities' processing times. 

Click the Activity, select Clock on the pie menu and set a value for the Time control.

In the following image the processing time for the first activity is set to 4 minutes.
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3. Once all the processing times have been defined, run the simulation. Click the Run button.

Note the simulation shows analysis findings for each shape in real time as  it executes, such as  average

time, total processing time and the number of completed tokens.

4. When the simulation is finished, select Results to view the outcome.
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Analyzing the results
As we mentioned before, the results  on this  level give  us  a  general  insight  into  the  cycle  time  of  the

process. For this specific case we are able to identify the expected time a person has  to wait from the

moment the emergency is reported until medical attention is received.

Based on the results, we can conclude:
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A patient waits at least 16 minutes before receiving medical attention.

A patient waits no more than 33 minutes for medical attention.

The expected time a patient waits to receive medical attention is 25,06 minutes.

Level 3 - Resource analysis

Overview
This  analysis  shows the  potential  effect  of  resource  constrains  on  process  performance.   Remember

that a  Resource is  defined as  a  person, equipment, or  space necessary for  the execution  of  a  specific

task.  

In the previous level, Time Analysis,  we assumed infinite resource capacity,  that is,  activities  are able to

process  infinite quantity of tokens  at the same time. However  this  assumption is  not practical at all.  In

real terms there are always resources constraints.

The most common issue arising from introducing resources  constraints  is  that tokens  need to  wait  to

be  processed  at  a  given  moment.  This  results  in  bottlenecks  and  increase  in  cycle  time,  thereby

reducing the capacity of the process.

Money  is  another  resource  directly  or  indirectly  involved  in  a  process.  Consequently,  this  level  also

allows you to analyze your business operation in terms of costs. 

The purpose of this analysis is to identify and minimize the impact of these constraints  in terms of cycle

time and costs.   

The resource analysis results will allow you to evaluate the following performance measures:

Sub- or over-utilization of resources.

Total resources costs.

Total activity costs.

Delays (time an activity waits for a resource).

A more accurate expected cycle time.

Defining the input Data required for this level
By  default  the  Performers  defined  in  the  process  documentation  are  defined  as  resources.  In  the

Resources Analysis level you need to define the following parameters:

Resources: Remember that a resource is  a  person, equipment or  space necessary for  the execution

of a specific task.  

To define a Resource click the Resources option found in the ribbon. 
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A new window will display the available resources. 

To add a new resource, click Add resource.

Select Add performer.
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Enter the name, description and type of the new resource. Click OK.

Availability and costs of resources:
To  define  availability  and  costs  of  resources,  select  the  Resources  option  found  in  the  Ribbon.  The

availability of Resources determines how many resources of a given type you have as a whole (not for a

particular activity).
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A new window  will  display  the  available  resources.  In  the  Availability  tab,  enter  the  value  for  each

Resources available. 

To define the costs of Resources, proceed to the Costs tab. 

You can define the fixed and per hour costs for each Resource. 

Fixed cost: This cost is generated each time a resource processes a token.

Per hour cost: This cost is generated for each hour a resource employs processing a token.

The cost units are defined in the scenario's configuration.
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Resources requirements: Tasks  require resources  to be performed.  Once you have defined the

process' resources, you have to define how many are required in order to perform a task.

To define the Resources  requirements  for  a  task, click the task and select the Resource icon in the  pie

menu. 
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Select the desired resources from the list available in the Resource window.

You can select one or more resources. The AND/OR selection mode is available in order  to define if all

the selected resources are required by the task at the same time or only one at a time.

For each resource selected you must define how many of them are used in the task.

Activity costs: The cost of performing an activity, that is, how much an activity costs once executed.

To define the cost of performing an activity, select the Activity and click Cost on the pie menu.
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Set a fixed cost amount.  The cost units are defined in the scenario's configuration..

Running the simulation
Once the required data has been entered, click the Run button to execute the simulation.
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In the new window, click Start to run the simulation.
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When running a simulation, the following analysis data will display. 

Resource usage status.

Number of tokens completed.

Average time per activity.

Total processing time per activity

Average waiting time per activity.
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Results
When the simulation is complete, select Results to view the outcome.

For the Resource Analysis level, the results of the simulated outcome will contain the following

information for Process and Resources:

For Process and activities
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Name: Identifies the specific BPM shape for which the results are displayed.

Type: Identifies the element type of the BPM shape. 

Tokens completed: Indicates how many tokens were processed for each specific BPM shape.

Tokens started: Indicates how many tokens arrived at the shape.

Minimum time: Indicates the minimum processing time at the shape.

Maximum time:  Indicates the maximum processing time at the shape.

Average time: Indicates the average processing time at the shape.

Minimum time waiting resource: Indicates the minimum time a task had to wait for a resource.

Maximum time waiting resource: Indicates the maximum time a task had to wait for a resource.

Average time waiting resource: Indicates the average time a task had to wait for a resource.

Standard deviation:  Indicates  the standard deviation of the average  time  a  task  had  to  wait  for  a

resource.

Total fixed cost: Indicates the total cost of performing a task during execution of the simulation.

For Resources 
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Usage: Indicates the percentage of time the resource was busy.

Total fixed cost: Indicates the fixed component cost of using the resource.

Total unit cost: Indicates the variable component cost of using the resource.

Example: Performing a resource analysis for the Emergency

attendance process
In  order  to  analyze  the  impact  of  resources  constraints  in  the  Emergency  attendance  process,  the

emergency department has decided to perform a resource analysis.

For this analysis the following assumptions have been made:

The expected time between reports is 5 minutes.

The simulation will evaluate a period of 1 week.

Resources can be shared between activities.

The following tables respectively show:

The resources involved in this process, the current available quantity and the related costs.

Resource Quantity Fixed Cost (US) Unit Cost (US)

Call center agent 2 3 0

Nurse 2 5 0

Fully equipped

ambulance

4 30 0,4

Basic ambulance 2 25 0,3
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Quick attention vehicle 2 18 0,22

Receptionist 2 3 0

The necessary quantity of resources for each activity.

Activity Resource Quantity

Receive emergency report Call center agent 1

Classify Triage Nurse 1

Manage patient entry Nurse 1

Pick up patient Fully equipped ambulance 1

Arrive at patient place QAV Basic ambulance 1

Arrive at patient place BA Quick attention vehicle 1

Authorize entry Receptionist 1

The cost associated with the performance of each activity.

Activity Cost (US dollars)

Receive emergency report 2

Classify Triage 1

Manage patient entry 1

Pick up patient 0

Arrive at patient place QAV 0

Arrive at patient place BA 0

Authorize entry 1

The estimated processing times for each of the activities

Activity Processing time (min)

Receive emergency report 4

Classify Triage 5

Manage patient entry 11

Pick up patient 20

Arrive at patient place QAV 7
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Arrive at patient place BA 10

Authorize entry 4

Define the required input data for this level: Resources, requirements and costs.

1.  Define the  resources  involved  in  the  process.  Create  the  necessary  resources  from  the  Resources

option.

2. For each resource define the available quantity, fixed cost and unit cost.

3.  Define the resources  requirements  for  each activity.  Click the activities  and then the Resources icon. 

Set the resource and number of instances to perform the activity.

For example, here we are defining that the second activity requires a nurse in order to be performed.
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4.  Finally,  define  the  cost  of  performing  each  activity.  Click  the  activity,  select  Cost  and  enter  the

corresponding cost.

Here we are defining the the cost of performing the Manage patient entry activity is  1 dollar.  This  cost

is related to paperwork and calls.
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5.  Click  Run,  then  select  Start  in  the  new  window  to  execute  the  simulation.  Note  the  number  of

completed Events are displayed. When the simulation is finished, select Results to view the outcome.
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Analyzing the results
As we mentioned before, the results of a resource analysis  give us  a  general insight into the cycle time

of the process. Consequently, we can identify how the cycle time is affected.

First we analyze the process results.
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Compared  with  the  best  case  scenario  achieved  in  the  previous  level,  the  inclusion  of  resources

constraints has significantly increased the cycle times. 

The minimum time remains  at 16 minutes  but the maximum increased  to  657  minutes  and  now the

average is 204,91 minutes. The previous results only had an average waiting time of 25,06 minutes.

As  is  evident,  the  processing  times  for  each  activity  have  changed.  Now,  they  reflects  delays.  The

highest average processing times  are  recorded  at  Classify  triage  and  Manage  patient.  The  average

waiting times confirm there is a problem in those activities.  Possibly,  resources  used in them are not

enough.

Now lets analyze the resources results.

The usage of the resources indicates some sub and over-utilization.

For this case we confirm our hypothesis about a possible problem of resources capacity. 

The nurse who performs the Classify triage and Manage patient reception has  a  usage of 99,91%. This

means  she  is  utilized  at  full  capacity  and  tokens  have  to  wait  until  she  becomes  available.  The

emergency  department  should  consider  increasing  the  number  of  triage  nurses  to  reduce  service

and waiting times, and thereby reducing the cycle time.

We'll see if the situation gets  better  including a new nurse  in  the  available  resources.  Now we  would

have three nurses.

Click Run to simulate the new scenario.

Analyze the new results:
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Introducing another resource brings us closer  to the best case scenario with no process  delays.  The

minimum time remains at 16 minutes, the maximum now becomes 35 minutes and the average 25,26

The results also show waiting times close to 0 in the activities  where they exist.  The current resources

are sufficient to avoid critical delays.

The above can be confirmed from the resources results. 

Usages are acceptable. Nurses now have a utilization of 69,88%. 

From the resources cost perspective, there was a total cost of 84.163 US. The new cost of 86.986 US

includes  the additional nurse. The increase of 2.823  US  offsets  the  benefit  in  reducing  the  average

waiting time to 179,5 minutes.  

There may be other ways to reduce the cost even further and to improve resource utilization, but for

now we can accept the state of affairs.
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Level 4 - Calendar analysis

Overview
In  addition  to  the  resources  constrains  discussed  in  the  previous  level,  we  should  also  consider  the

effect of resources availability over time to obtain a better understanding of true process performance.

In real scenarios,  processes  are subjected to ever  changing conditions  in the availability of  resources.

Holidays, weekends, shifts and breaks restrict and define the true performance of a process.

This  level  predicts  how a  process  will  perform  during  dynamic  periods  of  time,  such  as  shifts,  days

schedules or weeks. 

At the end of this level you will obtain more accurate information on:

Sub- or over-utilization of resources.

Total resources costs.

Total activity costs.

Delays (time an activity waits for a resource).

Expected cycle time.

Defining the input data required for this level
Additional  to  the  information  required  in  the  previous  level,  the  following  must  be  defined  in  the

Calendar Analysis:

Calendars:  A Calendar defines resource capacity over certain periods of times.  They define the

schedules, shifts, holidays and other time constraints to reflect the process in real life.

To create a Calendar click the Calendars option.  Click Add calendar. 
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Defining a Calendar is done in the same way as  Outlook. Thus, you can configure time shifts  or  longer

periods of time.

In the Calendar configuration you find the following options:
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Name: Defines the name of the calendar. It should be short and clear in order to allow identifying the

period of time it represents. For example night shift, coffee break, lunch hour etc.

Start Time: Defines the starting time of the calendar.

Duration: Defines the total duration of the calendar.

Recurrence Pattern:  Defines  the frequency with which a  Calendar  will  be  repeated.  It  can  be  daily,

weekly, monthly or yearly.

Range of recurrence: Defines the period of time for which the calendar applies.

Start of recurrence: Defines start date of the period of time for which the calendar applies.

End of recurrence Defines  the end date of the period of time in which  the  calendar  applies.  It  can

also be defined in terms of number of recurrences.

Click OK to save the changes.

Calendars assignment:
Additionally in this level, you have to define the availability of resources for each defined calendar.

To define the calendars assignment click the Resources option

For each Resource (row) you must define the availability for each calendar (column). 

Keep in mind that if you leave a Calendar blank, Bizagi will assume the availability value of a  resource is

the one defined in the Default Calendar.

This calendar includes the same resources availability defined in Level 3 (Resources Analysis). 



423Copyright © 2002-2016 Bizagi. All rights reserved.

Running the simulation
Once the required data for this level have been defined, click the Run button to execute the simulation.

In the new window, click Start to run the simulation.
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When running a simulation, the following analysis data will display. 

Status of resource usage

Number of tokens completed

Average time per activity

Total processing time for each activity

Average waiting time for each activity

Results
When the  simulation  is  complete,  select  Results  to  view the  outcome.  For  a  calendar  analysis  ,  the

results of the simulated outcome will contain the following information:

Resources (All resources)

Tab for each Resource

Name: Identifies the specific BPM shape for which the results are displayed.

Type: Identifies the element type of the BPM shape. 

Tokens completed: Indicates how many tokens were processed (instances).

Tokens started: Indicates how many tokens arrived at the shape.

Minimum time: Indicates the minimum processing time of the shape.

Maximum time:  Indicates the maximum processing time of the shape.

Average time: Indicates the average processing time of the shape.

Total time: Indicates the total time employed to process the shape.

Min. time waiting: Indicates the minimum waiting time for the shape. 
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Max. time waiting: Indicates the maximum waiting time for the shape.

Avg. time waiting: Indicates the average waiting time for the shape.

Standard deviation waiting: Indicates the standard deviation of the waiting time for the shape.

Total time waiting: Indicates the total waiting time for the shape. 

Total fixed cost: Indicates the total fixed cost for the shape. 

Example: Performing a calendar analysis for the Emergency

attendance process
In  order  to  analyze  the  impact  of  calendars  in  the  Emergency  attendance  process,  the  Emergency  

department has decided to perform a Calendar analysis.

The shifts for the process will be as follow:

Resource Morning shift (6:00 am - 2:00 pm) Day shift (2:00

pm - 10:00 pm)

Night shift

(10:00 pm - 6:00

am)

Call center agent 2 2 1

Nurse 3 3 3

Fully equipped ambulance 4 4 4

Basic ambulance 2 1 2

Quick attention vehicle 1 2 1

Receptionist 2 1 1

1. Create the three calendars (working shifts). 

Click the Calendars and add a new Calendar.

We  are  going  to  create  the  Night  shift.  In  the  Calendar  configuration  options  enter  the  following

information:

Name: Type Night Shift

Start Time: This calendar starts at 10:00 pm (see table above) so this is the start time

Duration:  This  calendar  starts  at  10:00  pm  and  finishes  at  6:00  am  so  the  calendar  duration  is  8

hours.

Recurrence Pattern:  This  calendar  is  repeated everyday so select Daily and type 1 in the alongside

field.

Start of recurrence:   This  calendar  applies  always  so  the  start  date  is  the  same  start  date  of  the

simulation.

End of recurrence This calendar applies always so it has no end date.
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Repeat the procedure for the morning and day shift calendars.

2. Through the Resources option, set the availability of resource for each calendar created previously.

 

3. Click the Run button. When the simulation is finished, select Results to view the outcome.
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Analyzing the results
Recall  that  incorporating  ever  changing  conditions  in  the  resource  availability  gives  us  a  better

understanding of true process performance.

The results of the calender analysis will reflect this change. Let us analyze them.

First we examine the process results:

The average time a patient waits for assistance suffered a little increase from 25,06 minutes  to 25,48

minutes. This is not significant.

The increase from 35 to 39 minutes  in the maximum  time  can  be  explained  by  the  existing  waiting

times in some of the activities of the process that were not present in the previous level. 

The Arrive at patient place BA task has  a  maximum waiting time  of  20  min.  It  could  be  critical  for  a

patient, however the average waiting time is 0,74 min. It is clear that high waiting times in this task are
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rare. 

Despite the presence of waiting times, they are not regarded critical.

The resources usage results will highlight any critical capacity problems.

The  highest  usage  is  for  the  Nurse.  Remember  that  this  resource  performs  two  activities  in  the

process: Classify triage and Manage patient entry. 

From the Process  results  we can conclude that the usage of  nurses  is  not  at  full  capacity  since  the

waiting times of the associated activities are not significant.

Assigning  shifts  and  resources  did  not  overtly  affect  the  process  in  general;  therefore,  we  can

conclude that the allocation is adequate for our purpose.

Configure Simulation
In order to configure scenarios to be more realistic, some parameters can be configured.

With the Simulation view opened, click the Properties button in the ribbon to configure the scenario.
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For each scenario provide the following information:

Name:  The name of the scenario. It should be clear  and descriptive to easily identify the simulation

conditions.

Description: A detailed description of the new assumptions and changes made to the process.

Author: The person or group that created the scenario.

Version: The version number of the scenario.

Start: Date on which the simulation starts.

Duration: Period of time during which the process will be simulated. 

Base Time units: The units in which time metrics and results will be displayed.

Base currency unit: The units in which cost metrics and results will be displayed.

Replication: Number of simulations for the given scenario. 

Seed: Value of the seed used to generate random numbers.

We recommend using 30 replications to make sure the simulation reaches a stable state.

For  the  replications  to  take  place,  keep  in  mind  that  you  should  run  the  What-If  analysis  which

provides  direct results  (instead of using  the  graphical  simulation  with  Real-time  display  at  the  Run

option). Notice that you may select only 1 scenario, to run the 30 replications.

The simulation will execute according to the duration defined disregarding the max arrival count.
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If the max arrival count  is  reached  and  the  duration  is  not,  the  resources  will  remain  idle  and  the

results may not reflect the reality.

If no duration is defined, the default duration is 30 days.

Scenarios
Bizagi Simulation allows you to create multiple scenarios  for  your  process  model,  to  analyze  different

combinations  of  data  input  and  observe  many  possible  outcomes.  Scenarios  are  completely

independent from one another,  from the definition of the scenario itself  to  the  data  included  in  each

shape of the model. 

When  you  are  in  Simulation  View,  the  model  will  display  a  default  scenario  created  by  Bizagi.  All

information  entered  belongs  to  that  specific  scenario.   The  name  of  the  process  scenario  being

simulated is displayed above the model:

Click the Properties button in the ribbon to manage the scenario.
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For each scenario provide the following information:

Name:  The name of the scenario. It should be clear  and descriptive to easily identify the simulation

conditions.

Description: A detailed description of the new assumptions and changes made to the process.

Author: The person or group that created the scenario.

Version: The version number of the scenario.

Start: Date on which the simulation starts.

Duration: Period of time during which the process will be simulated. 

Base Time units: The units in which time metrics and results will be displayed.

Base currency unit: The units in which cost metrics and results will be displayed.

Replication: Number of simulations for the given scenario. 

Seed: Value of the seed used to generate random numbers.

We recommend using 30 replications to make sure the simulation reaches a stable state.

For  the  replications  to  take  place,  keep  in  mind  that  you  should  run  the  What-If  analysis  which

provides  direct results  (instead of using  the  graphical  simulation  with  Real-time  display  at  the  Run

option). Notice that you may select only 1 scenario, to run the 30 replications.

The simulation will execute according to the duration defined disregarding the max arrival count.
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If the max arrival count  is  reached  and  the  duration  is  not,  the  resources  will  remain  idle  and  the

results may not reflect the reality.

If no duration is defined, the default duration is 30 days.

Create scenarios
To  create  a  new what-if  scenario,  select  the  What  if  option  (found  in  the  Simulation  group  on  the

ribbon) and select Manage scenarios.  

Click New. Two actions are available:

Duplicate  selected  scenario:  Creates  a  copy  of  the  current  scenario  with  the  same  parameters

configurations (number of resources, processing time, calendars etc).

Blank scenario: Creates a scenario with blank simulation parameters.
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Edit the new scenario to add specific information to your activities.

What If analysis
What if analysis is a powerful tool for improvement that evaluates  how strategic,  tactical or  operational

changes may impact the business . Through different scenarios you will be able to perform a true-to-life

analysis of your processes without putting your business operation at risk.

Bizagi allows you to  easily  carry  out  what-if  analysis  on  your  processes  to  evaluate,  understand  and

predict the effects  of your  decisions  over  given  performance  measures.  You  will  be  able  to  perform
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What if   analysis in any of the simulation levels.

You will be able to answer questions like:

How would the processing time of a case decrease if the number of available resources is doubled? 

What would be the cost/benefit rate of reducing the process time in a specified activity?

What  would  be  the  effect  of  altering  the  working  shift  configuration  in  the  operational  cost  and

service level?

The reports generated in What if  analysis will display the results of all scenarios to be easily compared.

We recommend using 30 replications to make sure the simulation reaches a stable state.

For  the  replications  to  take  place,  keep  in  mind  that  you  should  run  the  What-If  analysis  which

provides  direct results  (instead of using  the  graphical  simulation  with  Real-time  display  at  the  Run

option). Notice that you may select only 1 scenario, and in this example we used 100 replications.

Using What if analysis
To perform a what-if analysis,  first create the desired scenarios  and then run the simulation,  selecting

the scenarios for comparison.

Compare scenarios
When each scenario with its  relevant data has  been created, click What if   and mark the scenarios  you

wish to compare. Thereafter, run the simulation to generate the reports. 
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The  Report  will  compare  the  scenarios,  including  all  information  for  the  selected  analysis  level.  For

readability, disparities are highlighted in color.

We recommend  comparing  two  scenarios  at  a  time;  with  many  scenarios  the  results  evaluation  may

become too complex.

What if analysis example
Based on the calender analysis example, we will reduce the number of resources for all shifts  and see if

the processing times are affected.

To do this, we will create an additional scenario by duplicating the original one:
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In Scenario 1 the resources availability is:

Resource Morning shift (6:00 am - 2:00 pm) Day shift (2:00

pm - 10:00 pm)

Night shift

(10:00 pm - 6:00

am)

Call center agent 2 2 1

Nurse 3 3 3

Fully equipped ambulance 4 4 4

Basic ambulance 2 1 2

Quick attention vehicle 1 2 1

Receptionist 2 1 1

In Scenario 2 the resources availability will be altered as follows: 

We reduced Nurse,  Fully  equipped  ambulance  and  Receptionist.  We  increased  basic  ambulance  and
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quick attention vehicle.

Resource Morning shift (6:00 am - 2:00 pm) Day shift (2:00

pm - 10:00 pm)

Night shift

(10:00 pm - 6:00

am)

Call center agent 2 2 1

Nurse 2 2 2

Fully equipped ambulance 2 2 2

Basic ambulance 2 2 2

Quick attention vehicle 2 2 2

Receptionist 1 1 1

We run the what-if analysis including both scenarios.

Mark the scenarios and click Start.
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As soon as the analysis is complete, the Results will display.

Color is used to emphasis differences between scenarios. Values that differ are highlighted in red.

The resources results show that the usage of resources  increased, especially for  the Nurse, now at full

capacity.  This  gives  us  an idea that there will be delays  and patients  will be held waiting.  The  positive

result is that costs are reduced.
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Analyzing the outcomes we note that:

The completed tokens  have been reduced.  This  means  we  are  tending  to  less  patients  with  this  new

resources distribution.

Waiting time has increased in several activities:
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In the whole, this new scenario is not beneficial. The hospital cannot afford such high waiting times since

it offers a health care service.

We recommend reverting the resources  availability for  Nurse and  Ambulance  to  their  original  values,

and changing the availability of other activities. Run the simulation again and examine the results.



PartIX
Process Execution
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Process Execution

Bizagi offers three complementary products:  Bizagi Modeler, Bizagi Studio and Bizagi Engine. 

To model and automate your processes you need Bizagi Modeler and Bizagi Studio on your  Computer

or laptop. 

Use the free Modeler to diagram and document your process. Once your  process  is  complete you can

then press the Run button to export the process to Bizagi Studio, where a wizard will guide you through

all the necessary steps to automate the process, and turn it into an executable application (workflow).

Manage the complete process life cycle:

Bizagi Modeler: Diagram and documentation module available as Freeware

Bizagi Studio: Construction module available in the Bizagi BPM Suite

Bizagi Engine: Execution and control module available in the Bizagi BPM Suite

With Bizagi Modeler you start mapping and documenting the process flowchart.

Use our Bizagi Studio to enter all the necessary information for process execution: standard time, costs,

user interfaces, business rules, etc. This model is  stored in a  database and used for  process  execution

by the Bizagi Engine. 

Bizagi BPM Suite allows you to enter all the necessary information for process execution: standard time,

costs, user interfaces, business rules, etc. This information is stored as a model in a  database and used

at runtime for process execution through a work portal for end users.

Click here for more information about process automation

To start your process automation, follow the steps below:

1.  Download  Bizagi  BPM  Suite  from  http://www.bizagi.com/en/bpm-suite/bpm-products/studio  and

follow the instructions to install it.

http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite
http://www.bizagi.com/en/bpm-suite/bpm-products/studio
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2. Open your process in Bizagi Modeler and select Run Workflow on the Home tab.
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3. Mark the diagrams to export and click the Next button. 

4. Edit the diagram's name, if necessary, and click the Next button.



445Copyright © 2002-2016 Bizagi. All rights reserved.

5. Choose the New option in the project list and click the Next button.

If you already have a project in Bizagi Studio, you can opt to create this new process there. 
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6.  Enter  the project name and click the Next  button. The project will be created and are able to  start

the automation in Bizagi Suite.
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7. In Bizagi Studio a wizard will guide you step by step through the automation process  and will have

your processes up and running in no time.
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Guidance for automation

Overview
Bizagi Studio is  the construction environment that transforms processes  designed with Bizagi Modeler

into applications without the need for programming. 

Bizagi offers a set of tools that enables you to graphically define the model associated with a business

process  (flowchart,  business  rules,  user  interface,  etc.).  This  model  is  stored  into  a  database,  then  is

interpreted and executed in production by Bizagi BPM Server  without having to use intermediate code.

Bizagi Studio is available for free download from our site www.bizagi.com. 

To model processes that are executable in Bizagi Studio, you need to consider the following. 

Activities
Activities  represent  work  or  tasks  carried  out  by  members  of  the  organization.  Bizagi  Studio  only

supports some of the types of activities.  You can define your  tasks  as  User  Task, Service Task, Receive

Task, Send Task, Script Task or Manual Task. 

Events

Start Events
The start event indicates the start of the process. Bizagi Studio supports several start events:

Start Event (it does not have any particular behavior)

Message Start Event

Timer Start Event

Signal Start Event

http://www.bizagi.com
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Intermediate Events
Intermediate events indicate where something happens somewhere between the start and the end of a

Process. Bizagi Studio allows you to include five types of intermediate event in your processes. 

Intermediate Event 

Message Intermediate Event

Timer Intermediate Event

Link Intermediate Event

Signal Intermediate Event

When you include a message or  a  signal event in the diagrams, you must indicate if the event is  used
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to Throw or to Catch. 

Click here for more information about how to communicate between processes. 

End Events
End events indicate when a process ends. Bizagi Studio supports the following end events. 

Message End Event

Error End Event

Cancel End Event

Signal End Event
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Gateways 
Gateways  indicates  a  variation  in  process  flow whether  depending  on  an  expression  or  intending  to

create parallel flows. 

Event Based Gateway

Inclusive Gateway

Complex Gateway

Parallel Gateway
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Multiple Pools and Lanes 
Multiple pools are not supported by the Bizagi BPM Suite. The processes that can be executed in Bizagi

Studio must contain only one pool. 

You can include several lanes to define and differentiate elements in the process: for example roles  and

departments. 
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Connectors 

To  execute  your  model,  you  can  use  Sequence  Flow Connectors      to  connect  the  different

elements in the process.

You can also include the association connector  to link artifacts to an element. 

Sub-process 
Bizagi Studio supports four types of sub-processes, each sub-process has a special behavior: 

Embedded: When you define a Sub-process as Embedded, which is the default Sub-process, it will be

dependent on the parent Process and consequently have visibility of the parent’s global data. 

Reusable:  A  Reusable  Sub-process  is  defined  when  an  activity  within  a  Process  calls  another

predefined Process. The Process that is called is not dependent on the parent. 

Multiple:  A multiple Sub-process  is  instantiated several times.  It  could  be  executed  in  Parallel  or  in

Sequence.

Transactional:  The  transactional  Process  is  a  Sub-process  which  behavior  is  controlled  through  a

transaction protocol. 

Click here for more information about transactional sub processes. 

Execution

Once you have completed the process modeling you can run it on the Bizagi BPM Suite. 
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Video: Bizagi BPM Quicktour

Watch a 5 minutes quicktour and learn about Bizagi BPM Suite - Process execution

https://www.youtube.com/watch?v=vt8FrlGgWjE


PartX
Advanced topics
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Advanced topics

Interaction between processes

Overview
More  than  one  pool  in  a  diagram  represents  interaction  between  separated  business  entities  or

performers. 

Many  business  processes  require  interaction  between  each  other  to  be  correctly  performed  and

accomplished.  In  BPMN  these  interactions  are  defined  as  a  sequence  of  activities  that  represent

message exchange patterns between the entities involved. 

In BPMN this behavior is know as Collaboration.

Understanding interaction between processes
BPMN defines  Pools  as  Process  performers  (Entity or  Role) that contain  the  Sequence  Flows  between

activities. 

There is always at least one Pool for each diagram even if it is not diagrammed.

More  than  one  pool  in  a  diagram  represents  interaction  between  separate  business  entities  or

performers.

As  the  activities  within  Pools  are  considered  auto-contained  processes,  the  sequence  flow  must  not

cross  the  pools'  boundaries.  The  interaction  between  Pools  is  shown  through  Message  Flows,



457Copyright © 2002-2016 Bizagi. All rights reserved.

represented as dotted lines.

 

Modeling Collaborative processes
Collaboration  enables  communication  between  two  or  more  processes  by  sending  and  receiving

messages  containing actionable information. In Bizagi,  collaboration  is  carried  out  through  the  throw

and catch shapes  which are configured in each process.  The shapes  that allow Collaboration in Bizagi

are: 

ELEMENT DESCRIPTION NOTATION



458Copyright © 2002-2016 Bizagi. All rights reserved.

Message  Start

Event

Used when a message arrives  from a participant and triggers

the start of the process.

Message event

Indicates that a message can be sent or received. 

If  a  Process  is  waiting  for  a  message  and  it  is  caught  the

Process will continue its flow. 

A catch Message Event waits for a message to arrive and once

the message has  been received, the Process  will continue. The

Event marker in this instance will be filled.

A  throw  Message  Event  sends  a  message  to  an  external

participant. The unfilled Event marker  is  allocated to the throw

message.

Message end Indicates that a message is sent when the process is ended. 

Signal Start Event 

The start of the Process  is  triggered by the arrival of a  signal

that has been broadcast from another Process. 

Note that the signal is  not a  message; messages  have specific

targets, signals do not.

Signal event

These  Events  are  used  to  send  or  receive  signals  within  or

across  the Process.  A signal is  similar  to  a  signal  flare  that  is

shot into the sky for anyone who might be interested to notice

and then react. 

If the Event is used to catch the signal,  the signal Event marker

will  be  filled.   Alternatively,  the  unfilled  Event  marker  is

allocated to the throw message.

Signal end It indicates that a signal is sent when the process is complete.

When you drag and drop an Intermediate Event into a process,  you can convert it to another  type  of

event.

For example to convert an Intermediate Event to a Message Event, follow these two steps: 

1. Convert the event type from Intermediate Event into Message. Right-click on it, select Event  Type and

choose Message.
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2. If you have a catch message (the event marker that is NOT filled) and you need a throw message (the

event marker that IS filled).

Right-click on the shape and select Is Throw, in order to convert the message into a throw message. 

In the collaboration diagram, the messages will appear as follows:   
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Example: Interaction between processes
In  this  example  a  company  decided  to  diagram  the  Purchase  Process  interacting  with  the  process

performed by your suppliers. 

The two processes are independent but information flows constantly via messages  (phone calls,  emails,

etc.). 

Each company needs information from the other to successfully complete the process. 

The following is the diagram shows the Purchase Process example.
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The Purchase department sends a Purchase Order to the Supplier.

Then, when the products are delivered, an invoice is sent to the purchase department by the Supplier. 

Those interactions between processes can be represented with messages. To inset a  message, click on

the Message line option in the Connectors palette.
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By doing the same for the send and receive invoice activities, the diagram showing collaboration will be

finished.

Message Flow connection rules
The  following  table  has  been  extracted  from  the  BPMN  2.0  standard  where  the  rules  to  connect

objects through message flows is defined.

"The arrow symbol indicates  that  the  object  listed  in  the  row can  connect  to  the  object  listed  in  the

column. (...)  Only those objects  that can have incoming and/or  outgoing Message Flows are  shown in

the table. Thus, Lane, Gateway, Data Object, Group, and Text Annotation are not listed in the table." 

Business Process Model and Notation, v2.0 page 44
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Alignment features between processes

Overview
When modeling interaction between Processes, Bizagi provides  smart-align  options  for  both  the  new

Pools and Message Flows between them.

New Pools alignment
Recall that as soon as you open the Modeler a Pool will be ready for you to start diagramming.

When including a new Pool into a diagram, using smart alignment will line up the Pools to each other

(left vertically alignment).

To use this feature, make sure you drag the new Pool to the existing Pool's left start point (vertically

near).

Bizagi will highlight both Pools to indicate that you may drop the new one at this location and allow

auto-alignment. 
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Message Flows alignment
When using Message Flows to model the interaction between Processes, smart alignment will show

flows emanating from a straight line parallel or vertical to the element.

To use this feature, ensure your Task or Event being connected to the Message Flow is placed close

enough to allow for a straight line.
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In this way, Bizagi will automatically align the Task or Event. 
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Note that this feature applies  for  Message Flows connected to Tasks  or  Events,  and at least to one of

their  two  endpoints  (e.g  Message  Flows  with  the  following  related  elements:  Task-Task,  Event-Event,

Task-Event, Pool-Task, Pool-Event).
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On-premise Collaboration

Overview
Team Collaboration is  a  feature that allows  teams  to  participate  simultaneously  in  the  definition  of  a

process, aiding innovation and delivering efficiency across organizations. 

Multiple users  work simultaneously on a model during the  process's  design  phase,  achieving  greater

participation  of  team  members  and,  ensuring  the  best  quality  in  a  process's  definition.  Bizagi's

collaboration features allow users to change and improve a process's flow, run online team discussions

and enter comments in real time, visible to all participants.

You must decide whether to use Collaboration On-premise or

in the Cloud.
If you collaborate On-Premise you are responsible for the files storage and their availability. 

If  you  collaborate  in  the  Cloud  you  can  work  without  barriers:  you  can  work  on  your  processes

anytime, anywhere you have an internet connection – without restrictions of location or time zone.

Collaborative process modeling

Overview
Collaborative process modeling requires a Model to be stored in a location where you, and your  team,

can access  it.  This  means  you  need  a  network  connection  in  order  to  be  able  to  access  the  shared
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model.

You can save your  collaboration  process  models  on  your  computer,  in  a  file  server  or  using  third-

party cloud (online) storage storage service. 

Bizagi  offers  Cloud  Collaboration  services  which  are  free  for  a  Personal  Plan.  Bizagi  Cloud  is

available wherever, whenever.

On premise collaboration is  completely free, whilst  collaboration  services  in  Bizagi  Cloud  have  a

price.  

To enable collaboration, select File > Save As > Local Models > Save as Collaboration File.

Then, select your process location to start sharing On-premise.
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Once the model is saved Bizagi Modeler creates a file with a .bpmc extension, along with a new folder.

The  folder  contains  special  files  to  make  collaboration  work,  PLEASE  DO  NOT  MANIPULATE  THIS

FOLDER.

Allocate appropriate permissions  to your  team,  so  that  they  can  access  the  new folder  and  the  files

within. Anyone with access to the location, where the collaboration model is  saved (the .bpmc file),  can

access the Model.

Sharing a model in a File Server
Your  collaboration models  can be saved  on  your  company's  file  server.   After  sharing  a  model  give

your team the permissions to the file and folder through Windows' Sharing options. 

Right-click the folder and the .bpmc file and click the arrow next to Share with. Select Specific  people to

add the necessary people. The invitees will have access to the model.
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Sharing a model in a Online Storage Service
If  you  have  Internet  access  at  your  company,  you  can  also  share  your  models  via  Online  Storage

Services such as Dropbox, Sugarsync or Sky drive.  

To share a model in an Online Storage Service, follow the steps below:

1. Download and install the Online Storage Service software on your  computer,  in this  example we will

use Dropbox.

Since  a  shared  model  relies  on  both  a  .bpmc  file  and  an  annex  folder,  it  is  strictly  important  to

ensure that you open a model when having both the file and the folder  in the same path (by  using

the desktop software that synchronizes files from your online storage service).

2. A Dropbox folder will be created on your computer. Any files placed in this folder can be shared with

other users of Dropbox.

3. Login to Dropbox.  Create an account if you do not already have one.
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4.  Save your  new folder,  containing your  Share Model,  and all the  files  within  to  the  Dropbox  folder.

Right-click on the folder where you stored the collaboration file and select the option Invite to folder.

A window will be displayed. Enter the email addresses  of the people you wish to share the model with

and click on Share folder. This will allow your team access to the model.

Sharing a model in your computer
If you do not have company access to a File Server or Internet, you can share your models on your  own

computer. As soon as you share a model, give your team the permissions to the file and folder  through

Windows' Sharing options. 



472Copyright © 2002-2016 Bizagi. All rights reserved.

Right-click the folder and the .bpmc file and select the arrow next to Share with.  Select Specific  people

to add the necessary people. The team members added will have access to the model.

Example of collaboration

Overview

Bizagi  offers  Cloud  Collaboration  services  which  are  free  for  a  Personal  Plan.  Bizagi  Cloud  is

available wherever, whenever.

On premise collaboration is  completely free, whilst  collaboration  services  in  Bizagi  Cloud  have  a

price.  

To illustrate how to perform collaboration within a process we will use the following example:

Assume that Andrea works in the administrative department of her  company. She has  been working on

the Travel Request process, which involves employee activities to manage a request for  a  flight ticket,  a

currency advance and a hotel reservation. 

She needs to share her model to collaborate with Mark on her  team, allowing him to review the model

and suggest any improvements.  

1. To share her model, she clicks on File > Save As > Local Models > Save as  Collaboration Model File.

She saves the model in a shared location (using the wizard), where Mark can access it. 
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Upon her  sharing  the  model,  Bizagi  creates  a  new  model  with  a  .bpmc  extension,  the  ‘c’  denotes

collaboration. 

Click here for more information about Bizagi Modeler extensions.

2. She grants Mark privileges to access the location where the model is shared.

Once Mark is given permission, he opens the .bpmc file. 

3. Andrea and Mark can now both open the model and work concurrently on it.  They can communicate

with each other by entering messages in the Comments window found on the right of the screen. 

Messages  are displayed in real-time; hence, as  soon  as  either  party  types  a  comment  and  clicks  the

Enter button, the comment will be instantaneously displayed.
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They can also leave their  comments  for  later  review by  team  members.  Comments  in  Bizagi  Modeler

work very similarly to Twitter. 

4.  Andrea asks  Mark to help her  with the Expenses  report  diagram.  They  can  both  view the  Expense

report diagram simultaneously and thereafter discuss it. 

Mark  reviews  the  diagram.  He  comments,  at  the  Diagram  level,  that  all  the  activities  of  the

Administrative Manager are missing and stipulates that he will make the changes. 
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5. By default all diagrams are read-only.  To change or  update a diagram it is  necessary to click Lock

Diagram, located in the Team Collaboration group on the Home tab. 

In the given example, this  feature enables  Mark to perform any changes  on the diagram; however,  for

Andrea and other users the diagram will be locked.  

6. Once Mark has completed his changes  he clicks  on the Unlock Diagram  button, located in the  Team

Collaboration group on the Home tab.  
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7. Andrea receives a notification informing her there has been a change in the Expense report diagram.

8.  Andrea  reviews  the  model  and  note  the  last  activity  should  have  some  additional  changes.

Consequently, she adds an Element comment for Mark's perusal.
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9. Mark reviews Andrea's latest comment. Either Mark or Andrea can make the change. Whoever  makes

the change will lock the diagram, using the Lock Diagram feature. 

There is an Info button available for  everyone to track the editing history. The History  window displays

the date-time and user details of each addition.
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Collaboration levels
Collaboration comments  can be made at three different levels:  model,  diagram  and element,  so that

team members can comment on the context in each level.

Bizagi  offers  Cloud  Collaboration  services  which  are  free  for  a  Personal  Plan.  Bizagi  Cloud  is

available wherever, whenever.

On premise collaboration is  completely free, whilst  collaboration  services  in  Bizagi  Cloud  have  a

price.  

Model comments: comments posted within the Model apply to all the diagrams, i.e.  are visible from

any diagram. These comments are found in the Diagrams tab. 
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Diagram comments: comments posted within a diagram only apply to that diagram. 

 

Element comments: comments posted within a selected diagram element only apply to that element

within a diagram.  
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Offline collaboration
You,  or  your  team,  can  also  work  offline  within  a  collaboration  model.  Offline  collaboration  allows

modification even if there is  no access  to a network connection. Offline  collaboration  is  only  possible

when  the  collaboration  model  files  (.bpmc  file  and  folder)  are  available  in  offline  mode  through  an

Online Storage Service or if your network folder is always available offline.

Bizagi  offers  Cloud  Collaboration  services  which  are  free  for  a  Personal  Plan.  Bizagi  Cloud  is

available wherever, whenever.

On premise collaboration is  completely free, whilst  collaboration  services  in  Bizagi  Cloud  have  a

price.  

You can lock the process for  editing before or  after  you log off the network. However  we recommend

that  you  lock  the  diagram  for  edit  BEFORE  you  disconnect  or  log  off  from  the  network  to  avoid

conflicts.

Click here to learn more about Conflicts resolution.

An example of an offline collaboration being needed is  where you may be on a business  trip and plan

to work whilst on the airplane. 

1. Before you leave your  office click the Lock Diagram  button, in the Team Collaboration group on the

Home tab, to lock the diagram for editing.

(Since the diagram is in edit mode you alone are able to make the changes, which can be done whilst
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on the plane.)

2.  Once the changes  are made, click the  Unlock  diagram  button,  in  the  Team  Collaboration  group  on

the Home tab.  The diagram will automatically synchronize when next you connect to the network. Once

synchronized your team will be able to view all changes.
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In order for offline collaboration to work you need to use:

An  Online  Storage  Service,  for  example:  Dropbox  which  creates  local  copies  of  all  files  on  your

computer; or If you are using a file server, the shared folder must be made available offline.



483Copyright © 2002-2016 Bizagi. All rights reserved.

Conflicts resolution

Overview
Collaboration allows multiple users  to work together  on a  model  which  is  saved  in  a  shared  folder.  

Team  members  can  perform  changes  to  a  model  at  the  same  time,  some  being  online  and  others

being  offline.  When  offline  users  come  back  online,  and  diagrams  are  synchronized,  conflicts  in  the

changes  can occur.  Conflicts  will occur  if changes  are made by more than one person to  the  process

flow or to the documentation of any element in the same diagram. 

The following example illustrates how conflicts can occur:

You have shared a model thought Dropbox with another  team member  but you need to travel abroad

whilst they work  on  the  model.  During  the  flight  you  decide  to  work  on  a  diagram  and  make  some

changes  offline. However  at the same time your  team member  is  also  working  on  the  same  diagram

whilst being online. 

When you next connect to the network your  model will automatically synchronize.  Consequently,  your

changes will now conflict with your colleague's. 

Bizagi has a tool that allows you to resolve these conflicts.

Process flow conflicts
Let us assume that you and your team member work in the Administrative department of your  company

and  you  are  collaborating  via  Dropbox  on  the  Purchase  Request  process.  You  changed  a  diagram

offline and your team member, whilst being online, also made some changes to the model.

As you come back online and synchronize the model, a new window will be displayed to warn that there

is a conflict. 

There will be two diagrams, one in blue and one in red. The blue one will be your  diagram i.e.;  being

the person who synchronized.
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The left pane shows the conflicting versions.  You can  switch  between  the  diagrams  to  analyze  which

version to keep, just as in Word or Excel. 

The person synchronizing (you in this case) must decide how to handle the conflict.

You  can  revert  to  your  colleague’s  online  version  or  retain  your  own offline  version.  Note,  you  can

always create a copy of the diagram that was  not kept,  by selecting the option Save a copy.  Doing so

will allow you you to implement the changes in the discarded version.
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Attribute conflicts
Again, let us  assume that you and your  team member  work in  the  Administrative  department  of  your

company and you are collaborating via Dropbox on the Purchase Request process.   As  in the previous

example  you  both  made  changes  offline  and  online  respectively,  but  this  time  to  the  attribute

information  for  the  same  diagram  element.   For  example,  the  description  of  the  Create  Purchase

Request task. 
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When you are next able to connect to the network and synchronize your  model,  a  message will display

to warn that there is a conflict. 

Two  diagrams  will  be  displayed:  one  with  your  changes  and  another  with  your  team  member's

conflicting version. As the person synchronizing, you need to decide whether to retain your  own, offline,

version or revert to your colleague’s online version.
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Using Categories

Overview
Categories  classify  comments,  that  have  been  made  in  the  Comments  Window,  according  to  their

priority, relevance or topic. For example you can classify your  comments  to distinguish between urgent

changes, issues to evaluate, etc. 

Defining and assigning categories enables you to filter  comments  and so focus  on the most important

information. 

To define categories follow the steps below:

Create and assign filters to comments 
1. Select Filter by in the Comments Window.
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2. Select Edit Categories.

3.  Select  the  category  you  wish  to  define  and  then  click  the  Rename  button.  Name  it  and  click  OK

button.
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4.  Click  the  category  icon  located  on  the  right  hand  side  of  the  comment  and  select  the  desired

category.

Filter comments by category
Comments  can  be  filtered  if  you  associate  the  relevant  comments  to  category  tags.  To  tag  your

comment, click the Filter by option and select the category.
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Remove filters and clear categories
To remove a filter click the red button located on the right-hand side of the category.

To  clear  an  associate  category  tag  select  the  category  icon,  located  on  the  right-hand  side  of  the

comment; thereafter, select the Clear option from the drop-down list.
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User profiles

Overview
When a model is in collaboration mode, the user  profile identifies  the team member.  Your  profile can

be configured to include a personalized user name (nickname) and a picture.

User  profiles  are defined locally to each computer.   A local user  profile is  created and  stored  on  the

first computer  the user  logs  into.  If  you  use  Bizagi  Modeler  on  multiple  computers  you  will  need  to

define a user profile on each one. 

You can customize your user profile by following the steps below:

1. On the Tools tab, in the Tools group, click User Profile.
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2.  The User Profile window will be displayed. Click the Change Image button to load an image for  the

display picture.

3. Enter your Nickname and Name and click the OK button.
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4. After updating your user profile all your comments will show your picture and nickname.

Saving as non-collaborative file

Overview
Collaborative  process  models  are  saved  with  a  .bpmc  extension  (the  ‘c’  denotes  collaboration),  in

comparison to non-collaborating models  that use a .bpm  extension.  Click  here  for  more  information

about Bizagi Modeler extensions.

When you have finished collaborating, that is, your process design is finished, you can save your  model

as a .bpm file again in the location where all your processes are stored.  

1. Click Save As on the File tab.
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2. Select Computer and select Save.

3. Specify the save location and select Bizagi Diagram Model (*.bpm) from the Save as type drop-down
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list.

Force unlock

Overview
By default all diagrams are read-only.  To  change  or  update  a  diagram  it  is  necessary  to  click   Lock

Diagram  on  the  Home  tab.  This  will  enable  you  to  perform  any  changes  on  the  diagram,  and  for

everyone else, the diagram will be locked.  

Doing  so  avoid  inconsistencies,  as  single-user  editing  prohibits  conflicting  updates  on  shared  data,

which is important to maintain integrity.  However, you may override this feature by forcing an unlock at

which point Bizagi Modeler will warn you that conflicts may occur. 

A locked diagram is evident by a display message stating that the model is read only. 

Click the More info link.
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A window will display showing the users currently editing the model.

If you click the Unlock diagram button the following warning message will be shown. 
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Click the Yes button. This will unlock the diagram and you will be able to make the necessary changes.

Long lasting transactions

Overview
Bizagi Modeler is a powerful tool that allows you to model your  business  process  from the simplest to

the most complex process. 

A transactional process is an example of a complex model that can be modeled by Bizagi Modeler. 

Transactional  processes  are  used  to  coordinate  multiple  activities  that  need  to  be  completed

successfully. If any of them are not successful it is necessary to return to the initial state (a  state before

the  activities  where  ever  performed).  BPMN  uses  the  following  diagram  element  to  represent  a

Transactional Sub-process:

The long lasting transactional BPMN models have three possible outcomes:

The  first  outcome  is  when  all  activities  in  the  process  are  successfully  performed,  the  process

continues with the normal flow. 

The second outcome is  when a failure occurs,  and  it  is  necessary  to  reverse  all  activities  that  have

already been completed within the process.  This  is  achieved through the execution of compensation

activities.  Each  activity  that  needs  compensation  has  one  task  associated  to  it.  Compensation  is

executed when it is necessary to return to the initial state of something and is  only performed when

an activity has successfully ended. 

The  last  outcome  occurs  when  an  unexpected  error  is  presented,  the  transactional  sub  process

activities  are interrupted without any compensation and the process  continues  with the intermediate

error event.

To  model  a  transactional  process  it  is  necessary  to  attach  the  Error  and  Cancel  events  to  the  sub
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process. In any of these two events occur the process will have a flow to continue:

Transactional example
To demonstrate this type of process we are going to use the a travel request. 

When a travel request is made, it is necessary to make reservations  for  travel,  hotel and car  hire.  If any

one of them cannot be successfully completed, then the whole trip is not possible. The reservations  that

were made successfully, must be compensated.

The following images illustrate these three possible outcomes:
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The complete process looks like this.



501Copyright © 2002-2016 Bizagi. All rights reserved.

To Model the activities  of the  Sub-Process  include  the  required  activities.  In  this  case  we  will  include

three activities, Book Car, Book Hotel and Book Flight.    

Include a compensation event for each activity. This way, if any activity fails,  the completed activities  can

be compensated.
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Now your  Process  is  complete:  The  parent  Process  contains  the  sequence  flows  that  will  allow  the

Process  to  take  action  if  the  Sub-process  fails  to  complete  successfully.   The  Sub-process  contains

actions that will compensate any reservation that has already been performed correctly.



PartXI
FAQ
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FAQ

General FAQs
What is the price of Bizagi Modeler?

Is Bizagi Modeler open source?

How do I install Bizagi Modeler on my Mac?

Can I install Bizagi Modeler on a multi-user setup?

What kind of files does the Modeler handle? 

What is the BPMN version supported by Bizagi Modeler?

 How do I know if my diagram has modeling errors?

Diagramming and documenting FAQs
Can I work on diagrams that were not designed in Bizagi Modeler?

Can I import and export extended attributes using XPDL language?

My model includes several sub-processes. How can I import all the diagrams in a new model?

How can I diagram the communication between processes?

How can I diagram a large process?

Can I remove or change the Bizagi logo from my diagrams?

How should I manage fonts in my documentation?

How can I include special characters to support my language?

How can I disable the message that shows up when changing element types?

Sharing documentation FAQs
Can I use the Modeler with several people to work simultaneously on the same diagram?

How can I share my process diagrams and documentation with colleagues?

How can I present my processes in a business meeting?

Why is my sub-processes' information not being included when I publish?

Troubleshooting FAQs
Why can’t I use pools, lanes and milestones in a sub-process?

Why can't I see all the figures in the palette?

Why is the Modeler included in the BPM Suite different from Bizagi Modeler?

Why do I get an activation message of ActiveX every time I export my models to web?

I  get  the  error  Exception  from  HRESULT:  0x80010001  (RPC_E_CALL_REJECTED)  when  exporting  to

Word

Why can’t I open my .bpm models shared in SharePoint directly with Bizagi Modeler?

After publishing the web output to SharePoint 2010, the default page will not open. What can I do?

Why can't I publish to my MediaWiki?

General FAQs
What is the price of Bizagi Modeler?
Bizagi Modeler is available at no cost as a free download. It is not a  trial version or  community edition,

the entire product is available for free.
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Is Bizagi Modeler open source?
No, Bizagi Modeler is a freeware, but not open source.  We do not have a developer version.

How do I install Bizagi Modeler on my Mac?
Mac OS is not currently supported. However you can execute our Bizagi  through a Virtual  Machine
in Azure services.
Notice  that in Azure marketplace, you will  find a Bizagi  virtual  machine  template  which  you  can
install without any cost.
Please refer to this article for more information and instructions.
http://help.bizagi.com/bpmsuite/en/index.html?how_to_bizagi_azure.htm

Can I install Bizagi Modeler on a multi-user setup?
Bizagi Modeler can be installed in a  Server  (as  per  the requisites) in order  to be accessed by multiple

users.

For  this  setup,  there  are  third-party  technologies  which  will  allow  them  access,  such  as  Terminal

Services.

What kind of files does the Modeler handle? 
Bizagi Modeler has two main file types, differentiated by the file extension:

.bpm, the file format used to save a Bizagi Modeler file.

.bpmc, the file format used to save diagrams for Team Collaboration Mode. 

Team Collaboration is used to provide collaboration within your  work team for  the definition of your

process diagrams and documentation.  

Click this link Team Collaboration for further information. 

The .bpm in the 1.6 version is used to save a model that will be imported to our Bizagi BPM Suite to

be automated and turned into a running application (workflow). 

If  you  want  to  have  interoperability  (import,  export)  with  other  BPM  tools,  then  you  should  use  the

standard XPDL language or Microsoft Visio.

For more information please refer to Exporting and Importing.

What is the BPMN version supported by Bizagi Modeler?
Bizagi Modeler supports the current version, BPMN 2.0. 

For more information about BPMN 2.0, see http://www.omg.org/spec/BPMN/2.0 

http://help.bizagi.com/bpmsuite/en/index.html?how_to_bizagi_azure.htm
http://www.omg.org/spec/BPMN/2.0
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 How do I know if my diagram has modeling errors?
Bizagi includes a button that validates the element's location. and connections. On the Home tab, in the

Model group, click on Validate to start error checking.

Select the error description in the Diagram Validation add-on window in order to correct it.

Bizagi Modeler  does  not validate the notation and the logic used in your  diagram.  However  we  offer

several types  of support to help you through your  process  modeling  and  documentation.   For  more

information please refer to Training and Support.

Best practices in modeling
The BPMN (Business Process Modeling Notation) standard provides organizations with the capability of

understanding their internal business processes  in a  graphical notation and the ability to communicate

their procedures in a standard manner. However, the use of the standard do not ensure that processes
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are modeled in a clear and effective way; the way modelers interpret business conditions, and how they

define its structure, is crucial to ensuring they are understood correctly.

This  article provides  process  modelers  some guidelines  to build clear  and effective models  compliant

with the BPMN standard.

BPMN modeling principles

When defining process diagrams you should take into account the following basic principles:

1. Keep a logical and clear sequence

2. Use the BPMN standard

3. Use strict labeling

4. Simplify diagrams

Below you will find useful tips  to follow these principles  and  aid  the  correct  processes  definition  and

communication.

1. Keep a logical and clear sequence 

This  seems to be obvious  but is  one of the most common errors  in process  modeling. Diagrams  can

become unreadable and very confusing when the process  logic is  not explicit and clear.  The following

techniques will help you to maintain a logical and clear sequence in your models. 

Define a clear beginning and end: 
In BPMN, start and end events  are optional.  However,  processes  with implicit start and end events  are

undesirable and could lead to misinterpretations.

Use start and end events in each process and sub-process  to represent its beginning and completion.

Follow a consistent direction of flow
Make  the  process  logic  visible  in  the  diagram.  Avoid  crossed  lines  (connectors),  maintain  a  time

sequence  and  keep  a  consistent  direction  of  flow.  The  diagram  reading  will  be  easier  and  its

communication efficient. 
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Keep primary scenario clear
The "happy path" should be easily identified when reading a diagram. Diagram the happy path first and

then the alternative flows.

Keep alternative scenarios clear
BPMN offers  the necessary tools  to represent exception handling logic explicitly in the diagram. Once

the primary scenario is diagrammed, make use of the following elements  to model alternative flows as

required:

Use events attached to tasks

If an Event is attached to the boundary of an activity, it will change the normal flow into an exception

flow when something happens (a message is received, a condition is met, a time is reached, etc).  For

further information see Attached events

Use transactional processes 

Transactional  processes  allow  business  scenarios  with  transactions.   A  set  of  activities  must  be

successfully  accomplished,  otherwise  compensation  or  cancellation  flows  are  followed.  For  further

information see Sub-processes types

Distinguish success and failure end states

Use separate end events to identify when a process finished successfully and when it did not.
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Keep a format standard
Keep  a  unique  format  along  your  diagrams  and  focus  on  a  clean  and  friendly  look  and  feel.  Using

different  font  sizes,  colors,  boxes  sizes  or  overlapping  labels  might  make  the  diagrams  reading  a

challenge. 

2. Use the BPMN standard 
The BPMN standard defines the standards used to diagram business processes. However, following the

BPMN  guidelines  is  completely  in  your  hands.  Make  sure  your  models  comply  with  the  standard  to

ensure its correct understanding. 

Once the process  logic has  been  defined,  validate  your  diagrams  making  sure  you  properly  use  the

different BPMN elements. The following aspect should be checked for each BMPN element:

What to check in Pools

Diagram processes completely within a Pool. Never diagram flows across Pool boundaries. 



510Copyright © 2002-2016 Bizagi. All rights reserved.

Define as many pools as processes.  There must be always at least one Pool.

What to check in Lanes

Create a lane only if at least one task or intermediate event is performed in it.

Do not create lanes to represent the area or entity that carries out automatic tasks or gateways.

Do not diagram tasks, gateways or events at the middle of two lanes.
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What to check in Activities

Do not diagram multiple instances  of the same task to represent multiple performers.  Just diagram

one task in one area. Define the multiple performers as Allocation Conditions in the documentation.

Do not branch flows using tasks. Always use gateways to do so.

What to check in Gateways

Do not use gateways to join and split at the same time. 
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Balance gateways. Splits must be joined equivalently. 

Always use the same type of Gateway used as for splitting to join the flow.

What to check in Events

Always use start and end events.

Use terminate events  only when this  is  strictly  necessary.  They  are  used  to  model  situations  where
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several alternative paths are enabled and the entire process have to be finished when one of them is

completed. 

What to check in Connectors

Use sequence flows to connect  all  the  activities,  events  and  gateways.  Never  use  message  flow to

connect activities within the same pool or leave shapes unconnected.

Never  use sequence flows to connect elements  of different pools.  Use  message  flows  to  represent

information exchanging between processes.

What to check in Milestones

Always  identify  and  define  phases;  these  represents  a  period  of  time  goal  or  transition  in  the

process.
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Avoid come back or looping back across a milestone.

3. Use strict labeling
Correct  labeling  of  the  different  elements  of  the  diagrams  is  fundamental  for  an  easy  and  correct

understanding of processes. Here are some recommendations to help you do so:

Labeling Processes
Processes  labels  should clearly describe their  main purpose. Ensure that you do not use short  names

or abbreviations.

Labeling Activities
Give activities a label composed of one verb, and one object.  This  way readers  can clearly understand

the objective of a task. Also, ensure that you do not use short names or abbreviations.

Labeling Events 
Do not label start and end events  when only one instance of them is  used. It is  very common to label
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them as "Process start" and "Process end" but this is redundant and not necessary.

Use  labeling  when  multiple  start  and  end  events  are  used.  Label  them  according  to  what  they

represent using a noun. Do not repeat names.

Labeling Milestones
Milestones should be labeled with a noun making reference to a period of time (summer, maturity) or

what happens in a period of time (creation,approval, delivery).

Labeling Gateways
Divergence gateways should have a clear name indicating the decision or condition evaluated when it

applies.  Use a name composed of one verb, one object, and a question mark to identify what is being

evaluated. You can even use questions to clarify the decision involved.
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If names do not apply for any gateway use abbreviations or numbers to differentiate them.

Name transitions indicating the condition related 

4. Simplify diagrams 
Large diagrams do not allow giving an end-to-end  perspective  to  readers.  They  are  difficult  to  read

and clearly communicate the purpose of the process. 

Defining the correct scope of tasks  and level  of  detail  of  processes  is  key  to  reduce  the  overage  of

information.  The following tips will help: 

Reduce the number of redundant tasks
The level of detail in a process is sometimes a true challenge. In many cases you may face difficulties  to

define the scope of a single task. Take into account that:

When diagramming it is  useful to imagine that you are a final user.  If a  set  of  consecutive  activities

can be performed by the same person, at the same time then these activities could be integrated into

a single activity.
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A set  of  consecutive  activities  in  the  same  lane  may  indicate  missing  participant  details,  too  much

detail,  or  a  misalignment  in  scope.  Review  these  patterns  to  identify  opportunities  for  activity

integration.

Group activities
Use sub-processes to group activities with the same purpose. You can expand the sub-processes  later

to expose details of lower  levels  of hierarchy.  A process  will contain multiple pages, but internally the

integrity of a single model is maintained.

Use embedded sub-processes when:  

A set of consecutive activities  has  an owner  different from the main  process  owner  (e.g  a  Purchase

request process is performed by the Purchasing area and the Accounts payable process  is  performed

by the Financial area). 

A set of consecutive activities has an different goal from the main process one (e.g a Credit request is

focused on managing all the activities to approve a credit request and the Verify applicant information

is focused on checking if the applicant is in the black list as well as the information submitted). 

Use reusable sub-processes when:

The  sub-process  needs  to  be  invoked  from  different  processes  (e.g  a  Verify  applicant  information

sub-process can be invoked from a credit request process or from a Insurance request process). 

Apply process patterns
Do  not  reinvent  the  wheel.  BPMN  experts  have  worked  on  defining  modeling  patterns  to  different

business  situations.  Use  them  to   model  the  required  business  conditions  while  simplifying  your

diagrams.

For further information about modeling patterns please check the  BPMN Workflow patterns document

Document minor details
Leave details to documentation. Do not include all the information on diagrams. Additional information

should be documented as shape properties not as objects or text in the diagram.

Diagramming and documenting FAQs
Can I work on diagrams that were not designed in Bizagi Modeler?
Yes. Bizagi Modeler  allows you to import diagrams from Microsoft Office Visio or  XPDL format files.  

Importing existing models will enhance agility and allow for continuous process improvement efforts. 

For more information please refer to Exporting to XPDL or Exporting to Visio

http://www.bizagi.com/docs/Workflow%20Patterns%20using%20BizAgi%20Process%20Modeler.pdf
http://www.bizagi.com/docs/Workflow%20Patterns%20using%20BizAgi%20Process%20Modeler.pdf
http://www.bizagi.com/docs/Workflow%20Patterns%20using%20BizAgi%20Process%20Modeler.pdf
http://www.bizagi.com/docs/Workflow%20Patterns%20using%20BizAgi%20Process%20Modeler.pdf
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Can I import and export extended attributes using XPDL language?
Yes, it is possible to import and export the extended attributes using XPDL. 

Keep in mind that you can import/export paired-up attributes  (i.e.,  name, value).  Hence, tables  are not

imported or exported. 

It is not possible to import or export milestones, artifacts (include data objects) and embedded files  as

these elements are not defined by XPDL language. 

In  addition,  presentation  actions  are  not  exported  because  they  are  an  unique  feature  of  Bizagi

Modeler.

My model includes several Sub-processes. How can I import all the diagrams in

a new model?
It is  possible to import as  many diagrams  as  you  want.  However,  if  you  are  importing  the  diagrams

from  XPDL  format  you  must  import  them  one  by  one  (XDPL  files  only  save  information  about  one

process). 

If  any  Process  includes  a  reusable  Sub-process,  you  must  include  both  diagrams  and  create  the

relationship  between  them.  However,  if  the  Sub-process  is  embedded,  the  parent  process  will

automatically import it.  

If you use Visio, all Processes  and Sub-processes, within a Visio file,  are imported to Bizagi in a  single

step.

How can I diagram the communication between processes?
In BPMN the communication between Processes  is  defined as  a  sequence of  activities  that  represents

message exchange.  

These  messages  flows  are  represented  by  a  dotted  arrow called  Message  flow  connector.   As  the

connections  are made between pools,  it is  incorrect to connect a  message flow to an activity  within  a

process. 

A Pool has many connection points, you can locate the points  by dragging the start or  end connection

along the border. Whenever a connection is available it will highlight to a green point. 
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How can I diagram a large process?
The maximum space to model processes with Bizagi Modeler is calculated as follows:

Width by Height must not be over 36.000 pixels.

The maximum width size is 10.000 pixels.

 

If  your  diagram  is  bigger  than  this  allocated  size,  we  recommend  dividing  the  diagram  into  sub-

processes.  This allows for a large and complex  model to be more readable and easily understood.

Can I remove or change the Bizagi logo from my diagrams?
Due to popular demand from the Bizagi user community, we now offer  the option to replace the Bizagi

logo with your own company logo.

For more information please refer to Company Logo

How should I manage fonts in my documentation? 
Since the 2.4 release, Bizagi supports  rich-text formatting in Descriptions  and  any  extended  attributes

information contained in Text boxes or Text areas.

We recommend to keep in mind the following considerations on how Bizagi uses formatting options for

both the application and documentation:

1. Bizagi Modeler in its application, uses Segoe UI with size 8 as the default font. 

Even though you may change font, font size and font style for  information where rich-text formatting is

available (text in description, Text box and Text area extended attributes),  you may not change this  for

other information such as the one in Name, Start quantity, etc.

2. There is  no option to customize the font  used  for  the  actual  labels  and  captions  such  as  "Name",



520Copyright © 2002-2016 Bizagi. All rights reserved.

"Description", "Performers".

3.  You  may  change  the  default  font  and  font  size  for  the  visual  labels  in  BPMN  elements  (when

modeling the Process). This is a whole different setting which is configured in the general options of the

application.

When  changing  this  setting,  it  will  apply  for  brand  new elements  from  that  moment  on.  It  does  not

currently provide an option to apply the change for  existing elements,  due to the fact  that  this  would

most likely not adjust to the position of elements already modeled.

Keep in mind that the default font setting is stored per User  (it will apply for  the given user's  work in a

particular installation), and therefore you may want to review that existing models continue to work with

the previous font and font size.

4.  When  launching  the  Presentation  mode,  the  same  default  setting  applies  in  labels  and  captions

(Segoe UI size 8).  This  will be off course overridden by any other  explicit  format  entered  for  the  text

inside  descriptions  and  Text  box  or  Text  area  extended  attributes.  A  similar  concept  applies  when

publishing to Web, MediaWiki or PDF.

5. When publishing to Word, you may use a custom template of your  choice. If you  do,  this  template

will contain implicitly the font  and  styles  to  be  used  for  the  Word  output.  Yet  again,  this  applies  for

information  other  than  that  contained  inside  descriptions,  and  text  or  textarea  extended  attributes

(given that the text with defined rich-text format will override it).

How can I include special characters to support my language?
You can include special characters or  alter  the descriptive text using the ALT keys  directly in the Name

Attribute (or other Attributes) on the Basic tab of the Element properties add-on window.
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How can I disable the message that shows up when changing element types?
When you change an element type, any extended attributes  information entered will be lost if it hasn't

been shared.

That is why Bizagi Modeler warns you before changing types.

You can turn on or  off this  warning by marking either  the Don't  show this  message again checkbox or

Warn element type changes checkbox (located at the application general Options). 

Please click for further information about sharing extended attributes 
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Sharing documentation FAQs
Can I use the Modeler with several people to work simultaneously on the same

diagram?
Yes. The Team Collaboration functionality allows teams to collaborate by working simultaneously on a

model  during  the  process  design  phase.  This  achieves  greater  participation  of  team  members  and

helps ensure the best quality in process definition.  

For more information please refer to Team Collaboration

How can I share my process diagrams and documentation with colleagues?
You can share your models in different ways depending on your needs:

1.  Share  you  models  among  team  members  and  work  together  simultaneously  during  the  process

design phase with the Team Collaboration feature. 

For more information please refer to Team Collaboration

2.  You  can  generate  and  publish  your  completed  process  documentation  to  Word,  PDF,  SharePoint,

Web and MediaWiki. 

For more information please refer to Generating Documentation

3. You can share processes  and export to  either  Visio  or  XPDL.   Your  business  process  can  also  be

exported as images to PNG, bpm, SVG or JPG format files. 

For more information please refer to Publish or Export

4. Display the process  in  presentation  mode  with  a  full  read-only  screen  view.  For  more  information

please refer to Presentation Mode.

How can I present my processes in a business meeting?
Bizagi  allows  you  to  display  your  models  in  Presentation  Mode  where  a  full  display  view,  read-only

mode, is used (similar to the Full screen view in Microsoft products).

In Presentation Mode you can access  the main features  of your  processes  and the documentation you

have included.  Additionally,  you  can  define  Presentation  Actions  to  allow for  a  more  interactive  and

understandable presentation.

For more information please refer to Presentation Mode

Why is my sub-processes' information not being included when I publish?
By default sub-processes are created as embedded. When you publish your documentation, embedded

sub-processes are shown as tasks belonging to the parent process.

Therefore to include your  sub-processes  to you published documentation you would need to  go  into

the second configuration window in the Publish wizard,  where you can include each BPMN element per

process.

In the following image, we illustrate how you can include the sub-process and its BPMN elements.
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Troubleshooting FAQs
Why can't I use pools, lanes and milestones in a Sub-process?
Embedded Sub-processes  are an Inline block, that group process  elements  used in a  certain  point  in

the process  within a Sub-process. According to BPMN, a Sub-process  should not have pools  or  lanes

as  they are dependent on the  parent  process  and  subsequently  have  visibility  to  the  parent's  global

data. 

In order to make use of pools,  lanes  and milestones  diagram elements  in a  Sub-process, change your

default Sub-process  to a reusable Sub-process.  Reusable Sub-processes  allow all of  these  elements.

Note, in BPMN reusable sub-processes are called "Call Activities".

For more information please refer to Converting to reusable sub-process

Why can't I see all the figures in the palette?
The Palette includes  two views: a  Core view that displays  basic BPMN element;  and  an  Extended  view

that displays the complete element list.
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Note, the Extended Palette has a drop-down arrow next to each item.
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Why is the Modeler included in the BPM Suite different from Bizagi Modeler?
Bizagi offers two complementary products: Bizagi Modeler and Bizagi BPM Suite.

Each one has a specific objective. Bizagi Modeler is used to diagram and document processes, and the

BPM Suite is focused on taking the next step in automating/executing the models.

Bizagi  Modeler's  purpose  is  oriented  towards  complete  documentation  of  models  in  a  .bpm  file.  

Whereas  the  BPM  Suite  will  present  ways  to  achieve  effective  implementation,  through  an  assisted

process wizard, with the minimum amount of programming.

Why do I get an activation message of ActiveX every time I export my models

to web?
Internet  Explorer  validates  the  execution  of  ActiveX  for  security  purposes.  However  you  can  enable

ActiveX to run the active content in the files,  both for  a  model published in a  local intranet location or

on your local computer.

To adjust Internet Explorer's security settings for ActiveX control behavior, follow the next steps:

1. Select Internet Options on the Tools tab of your browser. 

2. Select the Advanced tab. In the Security options, select the option Allow active content  to run in files
on My Computer.
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3. Click the Custom level button. Check the Enable radio buttons  for  all Active X control and plug-ins  in

Settings.

If the site is on your local intranet or from a trusted source you can make this change permanently. 

Internet Explorer includes  five predefined zones: Internet,  Local Intranet,  Trusted Sites,  Restricted Sites,

and My Computer.   You  can  set  the  security  options  that  you  want  for  each  zone,  and  then  add  or

remove Web sites from the zones, depending on your level of trust in a Web site. 



527Copyright © 2002-2016 Bizagi. All rights reserved.

I  get  the  error  Exception  from  HRESULT:  0x80010001  (RPC_E_CALL_REJECTED)

when exporting to Word
If you are getting this error when exporting to Word we recommend to check the following:

1. Check if your  current Word installation has  any issues  by going to your  control panel and repairing

the installation.

2. Review if Word has add-ins, which may be affecting word instances being opened by a remote call.

This means that you can check in your Word options, in the Add-ins  tab, if un-marking your  COM add-

ins solves this problem.
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Why can't I open my .bpm models shared in SharePoint direcly with Bizagi

Modeler?
To avoid this situation you need to create a MIME type for the the .bpm file extension in the SharePoint

IIS Manager.

1. Log into your server through Remote Desktop Connection

2. Click Start, Programs, Administrative Tools, and select Internet Information Services (IIS) Manager 

3.  Under  the IIS header,  there is  an icon MIME Types. Double-click the MIME Types  icon  to  open  the

feature 
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After publishing the web output to SharePoint 2010, the  default  page  will  not

open. What can I do?
When  you  publish  a  web  output  to  SharePoint,  sometimes  the  default  file  will  not  open  the  web

browser, but instead it prompts to choose a program.

If  this  is  your  case  there  is  a  configuration  error.  We  suggest  following  this  guided  article  for  your

SharePoint 2010 web application settings:

http://www.myriadtech.com.au/blog/James/Lists/Posts/Post.aspx?ID=49.

For further information on how to configure SharePoint 2010 settings please review Microsoft's  articles,

such as:

http://technet.microsoft.com/en-us/library/cc262107.aspx

Why can't I publish to my MediaWiki?
1. Ensure you have MediaWiki installed in the server where you are publishing,

2. Please review the supported MediaWiki and PHP combinations

3. Check the upload directory has permission set for for creating and editing pages.

4.  The  LocalSettings.php  contains  the  configuration  settings  of  your  wiki.  Assign  permission  to

LocalSettings.php as follows:

$wgGroupPermissions['user']['upload'] = true;

$wgFileExtensions  =  array('png','gif','jpg','jpeg','doc','xls','mpp','pdf','ppt','tiff','bmp','docx',  'xlsx',

'pptx','ps','odt','ods','odp','odg');

http://www.myriadtech.com.au/blog/James/Lists/Posts/Post.aspx?ID=49
http://technet.microsoft.com/en-us/library/cc262107.aspx
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PartXII
Process Xchange
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Process Xchange

The  following  process  templates  are  common  processes  used  in  many  companies.  Feel  free  to

customize them to your  particular needs.

20-F  SOX

Management
About  to  enter  the

stock  market  or

already  part  of  it?

This  neat  process

app  significantly

reduces  the  time

and  effort  needed

to  comply  with  the

Sarbanes-Oxley Act.

Click  here  to

download  this

process template

Access

Management ITIL

based
This process app helps

control  user  privileges

based  on  the  roles  &

responsibilities  of

individual  users  in-line

with  the  principles  of

ITIL.

Click here to download

this process template

Accounts

Payable
Incorrect  payments

hit  your  bottom  line

hard.  Gain  better

control and accuracy

over  the  complete

invoice  receipt

process  with  the

Bizagi  Accounts

Payable  process

app.

Click  here  to

download  this

process template

Ad-Hoc process
Do  you  have

processes  that  fall

outside  predefined

patterns?  Not  a

problem. Bizagi  makes

it  easy  to  assign,

schedule  and  resolve

tasks on the fly.

Click here to download

this process template

http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/b46ad7b7-921f-4b76-b607-14cd0aeff0cb/docs/Form%2020F%20Management.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/e249a73d-55f2-474d-9051-81c3678d0122/docs/Access%20Management%20BPM.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/a492d863-2d50-4170-a4d9-3e28e062ff16/docs/Accounts%20Payable.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
http://www.bizagi.com/processcentral/Documents/1fa71816-4180-433e-9251-11082dd0c394/docs/Ad%20Hoc.bpm
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Change

Management

ITIL based
Introduce,  manage,

evaluate and analyze

the  impact  of  your

technological

changes  with

Bizagi's  ITIL-based

Change

Management

process app.

Click  here  to

download  this

process template

Help Desk
The  Bizagi  Help  Desk

app  embeds  a  formal

yet  flexible  flow

enabling  all  your

internal  IT  request

cases  to  be  effectively

qualified,  managed

and solved.

Click here to download

this process template

Non

Conformity

Management  

ISO 9000
Easily  spot,  manage

and  correct  those

anomalies  that,

when  left  untreated,

threaten  your

budget,  customer

base  and  industry

credentials.

Click  here  to

download  this

process template

Onboarding
Put an end to first day

frustrations with the

Bizagi Onboarding

process app - a simple

workflow to ensure

new employees have

what they need from

day one.

Click here to download

this process template

Offboarding
Ensure  your

offboarding process

is  as  tight  as  your

onboarding  one.

Get  complete

control  over  all  the

necessary  tasks  to

ensure a satisfactory

experience  for  both

Personal  Loans

Request
Streamline  the

complete  credit

request  cycle  of  your

most complex financial

products,  from

approval  and

evaluation  right

http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/42ab0200-0df5-4cae-8954-dd0d40a6cc0d/docs/Change.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/86e1a388-1d55-48e4-99dc-5c24cb9eb880/docs/Internal%20Help%20Desk.bpm
http://www.bizagi.com/processcentral/Documents/40176e74-a20d-4293-b9c3-80f1d99e1b96/docs/Nonconformity.bpm
http://www.bizagi.com/processcentral/Documents/40176e74-a20d-4293-b9c3-80f1d99e1b96/docs/Nonconformity.bpm
http://www.bizagi.com/processcentral/Documents/40176e74-a20d-4293-b9c3-80f1d99e1b96/docs/Nonconformity.bpm
http://www.bizagi.com/processcentral/Documents/40176e74-a20d-4293-b9c3-80f1d99e1b96/docs/Nonconformity.bpm
http://www.bizagi.com/processcentral/Documents/40176e74-a20d-4293-b9c3-80f1d99e1b96/docs/Nonconformity.bpm
http://www.bizagi.com/processcentral/Documents/40176e74-a20d-4293-b9c3-80f1d99e1b96/docs/Nonconformity.bpm
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HR and employee.

Click  here  to

download  this

process template

through  to  final

delivery.

Click here to download

this process template

Petitions

Claims  and

Complaints
Claims,  Complaints

and  Suggestions

getting out of hand?

This  process  app

gives  you  total

clarity  to  identify,

resolve and improve

all  company

interactions.

Click  here  to

download  this

process template

Purchase Request
The  purchase  lifecycle

made  easy.  Automate

every  stage  and  enjoy

better  buying  power

within  your  supply

chain.

Click here to download

this process template

Recruitment

and Selection 
Struggling to  assess

applicants'

information?

Interviews  proving

difficult to schedule?

Streamline  your

selection  process

with  Bizagi's

Recruitment app.

Click  here  to

download  this

process template

Sales

Opportunity

Management
Convert more business

leads  into  closed

deals.  Analyze  your

sales  performance.

Improve  your  service

levels.  All  made

simpler with Bizagi.

Click here to download

this process template
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Transactional

process
Coordinate  multiple

activities  without

returning  to  the

initial  state.  From

small  and  simple  to

large  and  complex,

handle  every

process outcome.

Click  here  to

download  this

process template

Travel  Request

and  Expenses

Report
A  simple  yet  effective

process  app  to

provide  tight  control

over  travel  and

expenses  requests,

complete with reports.

Click here to download

this process template

Six Sigma
Perform  your

projects  more

effectively  in  line

with  leading  Six

Sigma  /  DMAIC

methodology.

Click  here  to

download  this

process template

Vacations

Request
Easily  submit  leave.

Gain  control  &

visibility.  Reduce

manual updates across

your  company.  This

app  does  it  all,  in  line

with  your  company

handbook  and

approval procedures.

Click here to download

this process template

Vehicle

Insurance

Policy

Underwriting
This  process  app

provides

underwriters  with

control  and  visibility

of  the  vehicles

required  to  insure,

reducing  paperwork

and  unnecessary

duplication.

Click  here  to
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download  this

process template

Download the process used in the Webinar "Creating a process documentation portal with Bizagi"

This  is  the example file for  you to use as  a  reference to  model  your  processes  and  create  your  own

documentation portal.

"Criando um portal de documentação com o Bizagi"

Arquivo de exemplo utilizado no Webinar: Criando um portal de documentação com o Bizagi
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